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ABSTRACT 

Skeletal muscle regeneration represents a complex process mediated by non-myogenic cell 

types. These cells, such as macrophages and fibroblasts, display a range of interactions with 

muscle stem cells (myoblasts) during myogenesis (the differentiation and fusion of myoblasts 

into muscle fibres). Our knowledge of these interactions has been elucidated using in vivo and 

in vitro skeletal muscle models. Although in vivo models are more physiologically relevant, in 

vitro models, such as co-culture, offer a simpler and cost-effective means to study muscle 

regeneration. We therefore developed a novel and inexpensive co-culture method using three 

different cells types, which closely resembled the in vivo microenvironment by permitting a 

range of cellular interactions. Once this method was established, cellular behaviour in 

response to various experimental conditions could be evaluated. A second challenge we 

encountered was that the strategies available to us for assessing myogenesis in vitro were 

suboptimal in terms of speed and accuracy. We therefore sought to optimize image processing 

methods to rapidly and accurately quantify cellular numbers (proliferation), wound area 

(migration) and orientation (alignment) in our co-culture model. We then used these methods 

to evaluate the roles of macrophages and/or fibroblasts during the early (proliferation and 

migration) and late (alignment and fusion) stages of myogenesis. 

 

We observed a significant increase in myoblast proliferation and migration in response to co-

culture with either unstimulated macrophages or fibroblasts. In triple co-culture, macrophages 

continued to promote myoblast proliferation in the presence of fibroblasts. However, the 

presence of macrophages abrogated the positive effect of fibroblasts on myoblast migration; 

qualitative analysis also suggested a decrease in fibroblast number. Following analysis of later 

differentiation, we found that macrophages significantly promoted alignment, but prevented 

fusion, in a cell density-dependent manner. Fibroblasts, on the other hand, had no significant 

effect on myoblast alignment, but either promoted (at low fibroblast numbers) or inhibited (at 

higher fibroblast numbers) fusion. In triple co-culture, the effect of macrophages on myoblast 

alignment and fusion was unaltered by the additional presence of fibroblasts.  

 

In order to determine whether pro-macrophages have a direct quantitative effect on fibroblast 

number, M1 macrophages were generated following incubation with LPS and then co-

cultured with a fibroblast population. The latter population was characterised as containing 

both fibroblasts and their differentiated counterpart, myofibroblasts. A significant decrease in 
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the size of this population (potentially as a result of cell death) was observed in response to 

M1 macrophages; this decrease was prevented by the addition of LY294002, a 

phosphoinositide 3-kinase (PI3K) inhibitor. Subsequent analysis demonstrated that LY294002 

decreases macrophage numbers, suggesting a potential mechanism for the rescue of the 

fibroblast population by this inhibitor. Dexamethasone, on the other hand, caused the 

fibroblast population to acquire a rounder myofibroblast morphology, but the implications of 

this morphological change requires further investigation. 

 

In this thesis, we presented optimized and novel methods which were used to study skeletal 

muscle regeneration in vitro. The findings provided new insights into the temporal regulation 

of myogenesis by non-myogenic cells. During the early stages of myogenesis, macrophages 

need to increase in number to promote myoblast proliferation, but subsequently resolve with 

an increase in fibroblast numbers to promote myoblast migration into the wound. During the 

later stages of myogenesis, macrophage and fibroblast numbers need to subside to promote 

myoblast alignment and fusion, respectively. The communication between these non-

myogenic cells and the phenotypes they acquire can also indirectly influence myogenesis. The 

fibroblast population is important for promoting myoblast fusion, but macrophages with an 

M1 phenotype resulted in death of myofibroblasts. This makes it imperative that the 

population of M1 macrophages timeously subsides. However, M1 macrophage-mediated 

death of myofibroblasts was prevented by inhibition of the PI3K pathway which resulted in 

macrophage, but not myofibroblast, death. This suggests a potential therapeutic target for the 

treatment of muscle diseases, such as myositis, caused by the dysregulated presence of 

macrophages.  
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CHAPTER 1: INTRODUCTION 

Rationale for the Research 

Skeletal muscle tissue is responsible for all voluntary movement in the body, but the 

contractile functionality is periodically impaired by damage as a result of injury and disease 

[1,2]. Regeneration occurs to restore the wounded tissue; this represents a complex process 

involving a myriad of cellular and molecular events in the muscle microenvironment, but the 

precise mechanisms require elucidation [3]. Gaining a comprehensive understanding of these 

mechanisms is essential for developing therapeutic strategies, such as regenerative medicine 

and tissue engineering, to effectively mediate muscle wound repair and treat muscle disease 

[4,5].  

 

Successful regeneration is dependent on the coordinated interactions between non-myogenic 

and myogenic cells via an array of interactions [6]. Non-myogenic cells, such macrophages 

and fibroblasts, have been shown to be essential for wound repair, but it is unclear exactly 

how these cells affect and mediate muscle cell behaviour during regeneration [7,8]. Several in 

vitro methods have been developed and used to model in vivo muscle regeneration; these 

methods largely differ in the range of interactions, such as cell-cell, cell-soluble factor and 

cell-matrix factor, which they permit. However, since in vitro models aim to mimic the in vivo 

microenvironment as closely as possible, it is important to establish in vitro models which 

permit the range of interactions observed in vivo.   

 

During normal wound repair, macrophages and fibroblasts typically acquire regulated 

phenotypical changes which exhibit different effects on muscle cells. Macrophages initially 

acquire a pro-inflammatory (M1) phenotype which promotes myoblast proliferation and 

inhibits apoptosis, but later acquire an anti-inflammatory (M2) phenotype to promote 

myoblast differentiation and fusion [9,10]. Fibroblasts are initially present as quiescent cells 

which become activated by M2 macrophages to differentiate into myofibroblasts that reform 

the extracellular matrix (ECM) surrounding myofibers and promote myoblast fusion [11]. In 

muscle diseases, however, aberrant communication results in dysregulated phenotypes. 

Pathophysiological fibrosis, for example, is a consequence of a sustained presence of M2 

macrophages upregulating the deposition of matrix factors by myofibroblasts [11,12]. Other 

diseases, such as myositis, are characterized by an upregulated presence of pro-inflammatory 
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cells and impaired muscle regeneration, but the effect on the fibroblast population remains 

unclear [13,14].   

Aims and Objectives 

Skeletal muscle regeneration is mediated by an array of non-myogenic cells, such as 

macrophages and fibroblasts, which interact with myogenic cells during muscle regeneration 

[6]. In the current study, we first aimed to evaluate the effect of macrophages and/or 

fibroblasts on the behaviour of myoblasts in vitro. Within this aim, our first objective was to 

optimize methods to rapidly and accurately quantify cell numbers and wound area. The 

second objective was to develop a novel in vitro co-culture assay that closely mimicked the in 

vivo microenvironment by permitting cell-cell contact and signalling via soluble factors. The 

third objective was to optimize a method to rapidly quantify myoblast/myotube alignment. 

The final objective was to determine the effects of macrophages and/or fibroblasts on 

myoblast proliferation, migration, alignment and fusion.  

 

Incorrect communication between non-myogenic cells, such as macrophages and fibroblasts, 

often results in muscle disease [12]. The effect of a pro-inflammatory microenvironment on 

the population fibroblasts in muscle disease, such as myositis, is less understood compared to 

anti-inflammatory conditions. Therefore, our second aim was to evaluate the effect of pro-

inflammatory (M1) macrophages on the population of fibroblasts/myofibroblasts in a muscle 

regenerative in vitro microenvironment. Here, the first objective was to phenotypically 

characterize the population of fibroblasts and macrophages under standardized culture 

conditions. The second objective was then to evaluate the effect of M1 macrophages on 

fibroblast/myofibroblast numbers. The final objective was to determine the mechanism of 

action of M1 macrophage-mediated cell death on this fibroblast population.  

Outline of Thesis Structure 

Chapter 2 is a review which focuses on known interactions between non-myogenic cells, 

particularly macrophages and fibroblasts, and myogenic cells. This chapter also focuses on 

the available methods to generate in vitro muscle models using various mono-culture and co-

culture systems as wells as methods to study cellular behaviours and signalling during 

myogenesis.  
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Chapter 3 is a benchmark paper that addresses the first objective of the first aim. This paper 

describes optimized methods we have developed to rapidly and accurately quantify cell 

numbers and wound area using ImageJ. 

 

Chapter 4 is a research article that addresses the second and fourth objective of the first aim. 

This paper describes a novel in vitro co-culture method that we used to evaluate the effect of 

macrophages and/or fibroblasts on myoblast proliferation and migration. 

 

Chapter 5 is a research article that addresses the third and fourth aim. This paper describes an 

optimized method to determine myoblast/myotube orientation to quantify alignment which we 

used, in conjunction with our novel co-culture method, to evaluate the effect of macrophages 

and/or fibroblasts on myoblast alignment and fusion. 

 

Chapter 6 address the objectives in the second aim. This chapter focuses on the 

characterization of macrophages and (myo)fibroblasts, the effect of M1 macrophages on 

proto-myofibroblasts, and the mechanism of M1 macrophage-mediated proto-myofibroblast 

cell death.  

 

Chapter 7 provides concluding remarks and recommendations for future work.  
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Abstract 

Following severe muscle injury, muscle stem cells (myoblasts) are stimulated to repair the 

damaged tissue. This process, known as myogenesis, is regulated by non-myogenic cells, such 

as macrophages and fibroblasts, which initially promote the proliferation and migration of 

myoblasts into the wound and subsequently promote the alignment and fusion of these muscle 

cells into regenerated muscle fibres. Regulation of myogenesis has previously been evaluated 

using various in vivo and in vitro experimental models. While in vivo models are more 

physiologically relevant, in vitro models have been useful to understand the precise regulatory 

mechanisms of non-myogenic cells on myogenesis. In this review, we describe the methods 

used to model the cellular interactions in vitro as well as the methods used to assess cellular 

behaviours and mechanisms during myogenesis. 

 

Keywords: myogenesis, myoblasts, non-myogenic cells, in vitro models 
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Introduction 

Skeletal muscle wound repair is a well-coordinated process regulated by non-myogenic cells, 

such as macrophages and fibroblasts, which modulate the behaviour of muscle cells [1]. 

Macrophages are crucial during wound repair as they secrete factors which mediate the 

myogenic process in muscle precursor cells. Fibroblasts also regulate satellite cell behaviour, 

but additionally form and maintain the surrounding connective tissue which supports muscle 

contraction and regenerating muscle fibres [1,2]. It is necessary to better understand the 

communication between non-myogenic and myogenic cells in order to improve wound repair 

strategies following muscle injury [2].  

 

Much of our understanding of these relationships is derived from in vivo experimental models 

[3,4]. In vivo studies typically use small animal models to emulate disease, injury and repair 

processes observed in humans in order to study cellular interactions [5,6]. The crucial role of 

specific cells in muscle wound repair is commonly demonstrated using depletion methods. 

For instance, the ablation of satellite cells leads to a complete loss in regenerative capability 

of skeletal muscle following injury, while the depletion of macrophages or fibroblasts impairs 

regeneration in this tissue [7-10]. Transplantation of satellite cells in vivo has, despite poor 

survival and migration, been shown to promote regeneration when injected in dystrophic 

muscle [11-13]. This regenerative capacity is further enhanced when co-transplanted with 

macrophages which may be related to their promotion of myoblast survival, expansion and 

migration [14,15]. The interaction of satellite cells, macrophages and fibroblasts is therefore 

essential for effective skeletal muscle wound repair; however, the mechanism of intercellular 

communication is unclear.  

 

In vivo models have also provided significant insight and offer an accurate and a relevant 

means to study the interactions between cell types, but they are often subject to ethical 

constraints, complex methodology and multi-parameter variables [16,17]. In vitro systems 

overcome the challenges of in vivo models by offering a simpler, cost-effective and high-

throughput approach to not only mimic the in vivo environment, but also to pinpoint precise 

interactions between cell types, free from the complexity associated with in vivo 

experimentation [4,16]. Although in vitro models risk over-simplification by examining a 

limited scope of interactions and less accurately representing the in vivo environment, their 

advantages mean that they are extensively used [16].  
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Numerous in vitro systems have previously been developed to represent an isolated model to 

study the physiology, pathology and regeneration of skeletal muscle. Here, we review these 

systems used to model myogenesis and describe commonly used techniques to study the 

interaction of non-myogenic cells (such as macrophages and fibroblasts) with myogenic 

progenitor cells during key regenerative processes. 

Skeletal Muscle Wound Repair  

Skeletal muscle wound repair represents a complex process involving the sequential and 

overlapping stages of degeneration, inflammation and regeneration, and includes multiple cell 

types (Figure 1) [18,19]. Upon severe muscle injury, degeneration occurs as proteases, 

released by damaged cells into the wound, necrotize the surrounding tissue; this stimulates an 

inflammatory response [18]. During inflammation, cells such as neutrophils, monocytes and 

macrophages initially remove cellular debris by phagocytosis [20]. Macrophages then become 

activated to acquire a pro-inflammatory (M1) phenotype, via T-helper (Th) 1 cells, to promote 

the activation of quiescent satellite cells to myoblasts and the subsequent expansion of these 

muscle stem cells [21-23]. As wound repair progresses to regeneration, the Th2 cells stimulate 

M1 macrophages to acquire an anti-inflammatory (M2) phenotype; the M2 macrophages 

stimulate the migration, alignment and subsequent fusion of myoblasts into multinucleated 

myofibres [23,24]. Anti-inflammatory macrophages also stimulate the differentiation of 

fibroblasts into proliferative myofibroblasts which deposit and remodel the surrounding 

extracellular matrix (ECM) [25-28]. 
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Intercellular communication between the various cell types during muscle wound repair 

involves a multitude of signalling interactions (Table 1). Macrophages are activated by Th1 

cell-secreted cytokines (e.g. tumour necrosis factor (TNF)-α and interferon (IFN)-γ) to 

acquire the M1 phenotype [21,22]. Pro-inflammatory macrophages express and secrete 

enzymes, such as inducible nitric oxide synthase (iNOS) (which catalyses the production of 

nitric oxide (NO)) and matrix-degrading matrix metalloproteinases (MMPs) [30,31]. These 

enzymes release matrix-bound hepatocyte growth factor (HGF), a crucial factor for the 

activation of quiescent satellite cells to myoblasts [19]. Pro-inflammatory macrophages also 

secrete a myriad of growth factors and cytokines, such as TNF-α, interleukin (IL)-1β and IL-

6, which regulate myoblast proliferation, migration and differentiation [23,32,33]. Moreover, 

M1 macrophages mediate anti-apoptotic effects on myoblasts and their differentiated 

myofibres through direct cell-cell contacts via vascular cell adhesion molecule/ very late 

antigen-4 (VCAM-1/VLA-4), intercellular cell adhesion molecule-1/ leukocyte function 

 

Figure 1: Overview of skeletal muscle wound healing. (1) Degeneration occurs upon severe muscle 

injury and results in necrosis of the surrounding tissue. (2) Inflammation follows where neutrophils, 

monocytes and macrophages enter the wound and phagocytose necrotic the tissue; T-helper (Th) 1 

cells stimulate macrophages to acquire a pro-inflammatory (M1) phenotype which activate quiescent 

satellite cells to myoblasts and promote their expansion. (3) Regeneration ensues and Th2 cells 

stimulate M1 macrophages to acquire an anti-inflammatory (M2) phenotype which subsequently 

stimulate myoblast migration and alignment in the wound followed by fusion into multinucleated 

myofibres. M2 macrophages also stimulate the differentiation of fibroblasts into myofibroblasts which 

proliferate to deposit and remodel the extracellular matrix (ECM) [Constructed with reference to 

Forbes and Rosenthal, 2014].  
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associated molecule-1 (ICAM-1/LFA-1), CXCL1/CX3CR1 and platelet-endothelial cell 

adhesion molecule-1 (PECAM-1)/ PECAM-1. These cell-cell interactions potentially activate 

survival signalling pathways, such as mitogen-activated protein kinases (MAPK), 

phosphatidylinositol 3-kinase (PI3K) and serine/threonine protein kinase (PKB/Akt) [34]. 

 

Table 1: Intercellular communication between activating and target cells.  

 

Activating Cell Known 

Mediator(s) 
Target Cell Effect on Target Cell Reference 

Th1 Cells TNF-α; IFN-γ M0 Macrophages Activated to M1 

macrophage [21, 22] 

M1 

Macrophages 

iNOS/NO/HGF; 

MMP/HGF Satellite Cells Activated to myoblasts [19, 30, 31] 

TNF-α; IL-1β; IL-6 Myoblasts 
↑ Proliferation;  
↓ Migration;  
↓ Differentiation 

[23, 32, 33] 

VCAM-1/VLA-4;  
ICAM-1/LFA-1;  
CXCL1/CXCR1;  
PECAM-1/PECAM-

1 

Myoblasts and 

Myotubes ↓ Apoptosis [34] 

Unknown Fibroblasts ↑ IL-6, CCL2, MMPs; 

↓ Collagen [35] 

Th2 Cells IL-4, -10, -13 M1 Macrophages Activation to M2 

macrophages [39, 40] 

M2 

Macrophages 

TGF-β; IL-10 Myoblasts ↑ Migration, alignment, 

fusion [23, 24, 45] 

TGF-β Fibroblasts Differentiation to 

myofibroblasts [25-37] 

Fibroblasts COX-2/PGE
2
 M1 Macrophages ↓ TNF-α and MIP-1α [37, 38] 

Myofibroblasts 
 

Unknown 

 

FGF-2 
Myoblasts 

↑ Migration;  
↓ Apoptosis;  
↓ & ↑ Fusion;  
↑ Alignment 

[44-48] 

Activating cells are recruited during wound repair and facilitate regeneration by signalling to target 

cells. Known signalling mediators are listed as well as the effects, such as the up- (↑) or down-

regulation (↓), on various cell behaviours. 

 

Pro-inflammatory macrophages also interact with fibroblasts and regulate their matrix-

degrading behaviour by secreting factors which upregulate fibroblast expression of pro-



11 

inflammatory genes (e.g. IL-6 and chemokine ligand 2 (CCL2)) and the production of MMPs 

(e.g. MMP-1 and -3), while decreasing the production of collagen (e.g. collagen I and III) 

[35]. Unstimulated (M0) macrophages have been shown to directly interact with fibroblasts 

via ICAM-1 to increase the production of the pro-inflammatory chemokine macrophage 

inflammatory protein (MIP)-1α [36]. In contrast, fibroblast-secreted factors (e.g. 

prostaglandin E2 (PGE2)) have been shown to decrease the production of pro-inflammatory 

factors (e.g. TNF-α and MIP-1α) by M1 macrophages in a cyclooxygenase (COX)-2 

dependent manner [37,38].  

 

As wound repair progresses, M1 macrophages phagocytose apoptotic neutrophils, which 

stimulates the switch to an M2 phenotype; this is augmented by Th2 secreted cytokines (e.g. 

IL-4, IL-10 and IL-13) [39,40]. Anti-inflammatory macrophages attenuate the initial pro-

inflammatory response by secreting factors, such as transforming growth factor (TGF)-β and 

IL-10. These cells and cytokines regulate migration, alignment, and fusion of mono-nucleated 

myoblasts to form multinucleated myofibres [23,24,41]. Anti-inflammatory macrophages also 

stimulate the differentiation of fibroblasts into myofibroblasts in a TGF-β-dependent manner 

[25-27].  

 

Myofibroblasts are primarily involved in the remodelling and maintenance of connective 

tissue surrounding skeletal muscle [28]. These cells secrete growth and ECM factors (such as 

fibroblast growth factor (FGF-2), collagen, fibronectin and laminin) which provide various 

cues that mediate muscle cell behaviour [42-44]. Myofibroblast-secreted factors have been 

shown to promote myoblast migration and prevent apoptosis of differentiating myoblasts [45-

47], but have also displayed opposing effects on myoblast fusion depending on their density 

[44,48]. These connective tissue cells have been shown to promote the alignment of 

myoblasts in both a cell contact-dependent and FGF-2-dependent manner; in contrast, our 

studies suggest that they do not significantly influence myoblast alignment [41,44]. This may 

have been due to differences in the in vitro models, such as the cell lines used. Myofibroblasts 

also deposit the ECM that surrounds and physically supports muscle fibres. Fibrous scaffolds 

(e.g. collagen) exhibit mechanical and physical features, such as orientation and rigidity, that 

influence myogenesis: rigid fibres promote myoblast proliferation, while softer fibres promote 

fusion; organized fibres promote the alignment and subsequent fusion of other myoblasts 

[49].   
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Generating In Vitro Skeletal Muscle Models 

In vitro muscle models have extensively been used to study intercellular relationships and are 

aimed at delineating specific interactions that occur in vivo. In vitro models typically include 

the use of co-culture methods (to study paracrine and juxtacrine signalling), conditioned 

media (to study paracrine signalling) or cell-derived matrices (to study the effect of signalling 

via deposited matrix factors) [50-52]. However, there are several considerations to be made 

when selecting a system; these include expense, ease of operation, degree to which they 

mimic the in vivo environment, and the range of cellular interactions permitted [50].  

Cell Selection 

Cell selection is often the first and most crucial consideration when generating an in vitro 

model since the cell types establish the microenvironment. Species (e.g. animals versus 

humans), tissue type (e.g. skeletal and cardiac muscle) and pathology (e.g. normal or 

dystrophic muscle) must be considered. The origin and phenotype of cells are also crucial: 

cells can be derived from tissues (primary cells), while some are available as cell lines [53]; it 

is important to keep in mind that cells, particularly primary cultures, can  acquire different 

phenotypes over time depending on the experimental conditions [54-56]. 

 

Primary cells are derived from disaggregated tissue explants, which make them somewhat 

similar to cells in vivo; they are preferred to cell lines as they may provide more accurate and 

relevant data during experimentation [53]. However, isolation of primary cells requires ethical 

approval, while reproducibility can be hampered by donor-to-donor variation and is limited by 

lower proliferative abilities than cell lines, therefore requiring multiple isolations [57,58]. 

Secondary cells (cell lines) are immortalized (via genetic manipulation or through long-term 

cell culture) which permits easy and indefinite cell culture (usually without special culture 

conditions e.g. added cytokines) to inexpensively to produce large cell numbers [53]. 

Numerous cell lines are commercially available from cell banks such as American Type 

Culture Collection (ATCC)® (www.atcc.org). Macrophages (e.g. J774a.1 and RAW 264.7 

cells), fibroblasts (e.g. NIH/3T3, NOR-10 and LMTK cells) and myoblasts (e.g. C2C12 and 

L6 cells) have been used in muscle models in vitro [32,44,45,56,59]. Cell lines represent a 

pure population and are therefore able to yield reproducible results; however, phenotypic and 

genotypic variations between cell lines and primary cells may result in disparate experimental 

results [16,58,60]. 

http://www.atcc.org/
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In vitro phenotypes can be regulated by modifying the culture conditions of cells. For 

instance, macrophages (F4/80+ and CD11b+) can be stimulated to acquire a pro-inflammatory 

phenotype (CD64+CD80+) via the addition of lipopolysaccharide (LPS), TNF-α and/or IFN-γ, 

while an M2 phenotype (CD209+) can be achieved via addition of IL-4, IL-10 and/or 

dexamethasone [23,54,61]. Myofibroblasts and fibroblasts (both Tcf4+) represent an 

interchangeable population of cells: fibroblasts (α-smooth muscle actin (SMA)-) differentiate 

to myofibroblasts (α-SMA+) in response to serum or TGF-β and have been reported to de-

differentiate back to fibroblasts in the absence of these stimuli [10,62]. However, studies often 

do not distinguish between the two phenotypes; the term “fibroblast” is used indiscriminately 

to describe both populations. This represents a challenge when interpreting the literature as 

each phenotype behaves differently and provides a distinct contribution during wound repair 

[46,48,55,59]. Lastly, mononucleated myoblasts (Myf5+MyoD+) can be switched from 

conditions which promote proliferation, such as high serum and/or FGF-2, and then switched 

from conditions which promote proliferation, such as high serum and/or FGF-2, to conditions 

that promote differentiation and fusion, such as low serum, into multinucleated myotubes 

which are myosin heavy chain (MHC)+ and muscle creatine kinase (MCK)+ [56,63,64].  

Mono-Culture Systems 

Individual cell types can be plated as a mono-culture to evaluate the effects of various 

proteins on cell behaviour (Figure 2A). Numerous signalling and matrix proteins are available 

as commercial products, such as recombinantly expressed TGF-β or purified tail collagen 

isolates. The advantage of using such commercial products is that they can be used to 

accurately study the effects of single proteins on cell behaviour. These isolates are therefore 

useful in understanding the in vitro mechanism of action on cell behaviour, but may not be a 

true reflection of the environment due to discrepancy between in vivo and in vitro 

concentrations [17]. 
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Cells produce a myriad of proteins and these profiles vary depending on the cell type and its 

role in wound repair. Therefore, it becomes more physiologically relevant to collectively 

assess the effects of all factors on cell behaviour. Conditioned media (CM) and cell-derived 

matrices (CDM) can be generated to study the roles of secreted soluble and deposited 

insoluble factors, respectively. Conditioned media (Figure 2B) is generated by culturing a cell 

type in media which becomes “conditioned” with the cell secretome which includes various 

soluble growth factors, cytokines, chemokines and enzymes. The second cell type is then 

cultured in the presence of the CM [51,65]. Conditioned media is typically generated under 

 

Figure 2: Methods to generate mono-culture systems.  

(A) commercial products of recombinant soluble factors can be added to the culture media and/or 

purified matrix factors can be coated onto a multi-well plate. (B) Conditioned media (CM) is 

generated by culturing cells in media and transferring the CM to a second cell type. (C) Cell-

derived matrices (CDM) are generated by culturing cells on a multi-well plate and subsequently 

removing the cells prior to adding another cell type on top of the CDM.   
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serum-free conditions to prevent masking of any effects by the myriad of proteins present in 

serum [65]. However, the absence of serum may impair cell growth and therefore such media 

may need supplementation [51]. Finally, proteins are often secreted at very low levels and 

may need to be concentrated [66].  

 

Cell-derived matrices (Figure 2C) are created by culturing a confluent monolayer of matrix-

producing cells, such as fibroblasts or endothelial cells, in flasks or multi-well plates for an 

extended period. Cells are then removed (via physical, chemical or enzymatic methods) 

leaving behind the CDM on which other cell populations can subsequently be cultured on 

[52]. The physical and chemical properties of CDMs can be customized as the matrix 

generated depends on the cell type and the conditions they are cultured in. For example, 

culturing cells under shear stress conditions results in the deposition of more organized and 

aligned matrices [67]; while adding factors such as ascorbic acid increases collagen levels, 

and epidermal growth factor (EGF) or FGF-2 increases matrix production and thickness [68].  

Co-Culture Systems 

Co-culture systems represent an in vitro model where two or more distinct cell types are 

cultured together in a common environment in order to study intercellular communication 

[50]. Co-culture systems are utilized in two forms: those that allow direct contact between cell 

types (direct co-culture) and those that physically separate cells but permit paracrine 

signalling (indirect co-culture) [45,46,69]. Direct co-culture is often easier to perform and 

permits a range of interactions present in vivo; indirect co-culture systems often require 

additional equipment and are dependent on the diffusion rates of secreted factors [50]. Despite 

the inherent advantages and disadvantages of direct versus indirect co-culture, simultaneous 

use of both systems may elucidate whether or not direct cell contacts between cell types 

regulate behaviour [16,69,70].  

 

The simplest method of direct co-culture is to plate different cell types together as a mixed 

cell population (Figure 3Ai) or plate one cell type over a confluent layer of another (Figure 

3Aii) [33,48,51]. This approach of mixing or layering cell populations (at different ratios) is 

an easy and inexpensive method of co-culture that does not require any specialized equipment 

and maximizes intercellular communication [51]. However, it is difficult to distinguish 

between cell types during analysis. Analysing the effects of one cell type on the behaviour of 
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another (e.g. apoptosis, proliferation and differentiation) therefore requires specific antibodies 

coupled with confocal microscopy and/or flow cytometry when using this approach 

[48,70,71].  

 

Cellular patterning can be used to spatially control the adherence of different cell types [50]. 

Several patterning techniques are available such as using physical (e.g. stencils [72]) or 

chemical (e.g. bovine serum albumin (BSA) [73]) barriers to exclude cells from a certain area 

and prevent attachment. The first cell type adheres to the area surrounding the barrier, the 

barrier is then removed (by physical removal or by coating the cell repellent area with an 

adhesive matrix factor), and the second cell type is added which adheres to the remaining 

space. We have created a cellular patterning co-culture technique (Figure 3B) without the 

 

Figure 3: Methods to generate co-culture systems.  

Cells can be cultured together by (A) mixing/layering cells, (B) cellular patterning, (C) interlocking 

combs, (D) transwell inserts, (D) interactive co-culture plate (ICCP), (F) µ-slide co-culture wells and 

(G) in vitro fertilization (IVF) plates. 
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need of barriers and corresponding additional reagents/equipment [45]. This method is simply 

performed by plating the first cell type on the outer edge of a culture well followed by 

incubation to promote adherence; the second cell type is added which then adheres to the 

centre. Cells are therefore separate but are still permitted to interact by cell-cell contact to 

some extent. Co-culture by patterning does usually not need specialized equipment and 

creating distinct cell populations makes it easier to analyse cell behaviours without the need to 

identify cell types. 

 

Hui and Bhatia (2006) have previously developed a co-culture system to mechanically control 

cell-cell interactions; this method employs a pair of interlocking silicon combs (Figure 2C), 

where one cell type is plated on the female half and another on the male half [74]. The combs 

can be completely interlocked for direct cell-cell contact between the cell types or slightly 

separated to prevent direct contact and only permit paracrine signalling via indirect co-culture. 

The disadvantages of this method include: the combs (which are currently not commercially 

available) need to be coated with matrix proteins (e.g. collagen); there is no control on the 

ratio of cell numbers and requires confluence to effectively allow direct cell-cell contacts.  

 

The most common method of indirect co-culture is the use of a Corning® Transwell® insert 

(www.corning.com) (or other commercially available transwell inserts) (Figure 3D) 

containing a microporous membrane (ranging from 0.4 and 8µm in diameter) that allows 

soluble factors, but not cells, to pass through it. One cell type is plated in the lower culture 

well while a second cell type is plated directly onto the membrane. A shortcoming of these 

inserts, however, is that adherent cells above the membrane often migrate through the pores 

onto the underside of the membrane [24].   

 

The Interactive Co-Culture Plate (ICCP) (http://arb-ls.com/en/iccp) (Figure 3E) is a newly 

developed alternative to the transwell co-culture system and consists of two side-by-side 

culture wells joined by a microporous membrane. This system enables both cell types to 

easily be observed and analysed at the same time; this is a distinct advantage since both cell 

types may directly influence each other but requires more specialized and unconventional 

equipment. Moreover, due to the relative newness of the technology, limited studies have 

been performed using this method [75]. 

 

http://www.corning.com/
http://arb-ls.com/en/iccp
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ibidi® µ-slide 2-well co-culture plate (https://ibidi.com) (Figure 2F) consists of chambers 

separated by dividers. Individual cell types are plated into each chamber and, once they have 

adhered, the slide is flooded with media to extend above the physical divisions to enable 

communication via soluble factors. Similarly, our laboratory has previously adapted in vitro 

fertilization (IVF) culture plates (Figure 3G) for co-culture [46]. In this method, one cell type 

is plated on the outer ring of the culture plate while another is plated in the centre well. Once 

the cells have adhered, the plate is flooded with culture media and cells are able to 

communicate via secreted soluble factors. The advantage of these “overflow” co-culture 

plates is that both cell types are on the same two-dimensional (2D) plane and can be 

simultaneously observed; however, communication between cell types is reliant on the 

amount of media used and the timeous diffusion rates of secreted factors. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://ibidi.com/
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Studying Myogenesis In Vitro  

Myogenesis can be emulated in vitro to study the effects of specific experimental conditions 

on cell behaviours, such as proliferation, apoptosis, motility, alignment and fusion. There are 

numerous methods to study in vitro myogenesis but these techniques have been extensively 

reviewed elsewhere. Therefore, we only describe the methodological procedures (Table 2) of 

some of the simplest and/or popular techniques to study in vitro cell behaviours during 

myogenesis below.  

Table 2: Summary of methods used to evaluate cellular behaviours of non-myogenic and 

myogenic cells during myogenesis.  

 

Behaviour Method Reference 

Proliferation 

& Apoptosis 
Direct Cell Counts 

• Haemocytometer/Automated Cell Counter 

• Image Counts (Brightfield/Confocal Microscopy) 

• Flow Cytometer 
Indirect Cell Counts 

• Colorimetric Assay 

• Chemiluminescent Assay 

 

[76] 

[35, 77] 

[23, 34] 

 

[78, 79] 

[34] 

Motility Scratch Assay 
Chemotactic Attraction Assay 

[77, 80] 

[70, 81] 
Alignment Fast Fourier Transform  

Local Intensity Gradient 
Binarization-based Extraction of Alignment Score 
ct-FIRE & Alignment Index 

[84] 

[85] 

[86] 

[45] 
Fusion Myotube Morphological Characteristics 

Fusion Index 
Myotube Density 

[88] 

[89] 

[90, 91] 
The simplest and most accessible methods used to assess proliferation, apoptosis, motility, alignment 

and fusion during in vitro myogenesis are shown. 

Proliferation and Apoptosis 

Proliferation is the increase in cell number as a result of growth and mitosis while apoptosis 

results in a decrease in cell number. Therefore, enumeration of living and/or dead cells is a 

useful tool to evaluate the effect of experimental conditions on these behaviours. Cell 

quantification may be performed using direct cell counts or approximated using 

colorimetric/chemiluminescent assays. Cell counts can be easily performed on suspension 

cells stained with trypan blue to distinguish between living (colourless) and dead (blue) cells 

using haemocytometers or automated cell counters [76]. Live cells can also be more 

accurately evaluated using the LIVE/DEAD® Viability/Cytotoxicity Kit (available 

https://www.thermofisher.com) which measures esterase activity and an intact plasma 

https://www/
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membrane. Adherent cells can be resuspended and similarly counted or simply fixed, stained 

with histological dyes (e.g. crystal violet) and counted from brightfield microscope images 

[77]. However, more advanced and accurate methods, such as flow cytometry and confocal 

microscopy, are also available to identify cells that are fluorescently labelled for the 

expression of specific markers, such as Ki-67 (proliferation) or annexin V (apoptosis) 

[23,34,35].  

 

Colorimetric and chemiluminescent assays can be used to approximate proliferation and 

apoptosis by assessing cell number, metabolism or enzyme activity. These assays generate a 

soluble colour (colorimetric) or fluorescent (chemiluminescent) product and the concentration 

of this product (which is proportional to the degree of proliferation or apoptosis) is quantified 

using spectrophotometry at specific absorbance or excitation/emission wavelengths. The 

colorimetric crystal violet assay is used to quantify DNA content of adherent cells stained 

with crystal violet which is then solubilized and assessed via spectrophotometry [78]. The 

colorimetric tetrazolium assay is used to quantify metabolism of viable cells; a tetrazolium 

compound (e.g. MTT) is reduced to formazan by living cells [79]. The chemiluminescent 

caspase-3 activity assay is used to quantify apoptosis by measuring the proteolytic cleaving 

ability of caspase-3 (a marker for apoptosis) for a fluorogenic substrate (e.g. Ac-DEVD-AFC) 

to generate a fluorescent product [34].  

Motility 

Motility assays, such as migration and chemotactic attraction assays, are often used to assess 

directional cell movement. Although there are numerous methods to model and study 2D 

migration in vitro [80], the wound healing assay (or scratch assay) is favoured owing to its 

simplicity, cost effectiveness and ease of analysis [81]. In this assay, a confluent layer of cells 

is mechanically wounded (usually with a pipette tip) to scrape cells and create a cell-free area 

(i.e. wound) that the surrounding cells migrate into. Microscope images of the wound are 

acquired at various time points, the wound area can be manually or automatically measured, 

and the percentage wound closure (relative to the initial wound size) calculated [77]. Wound 

closure is often inaccurately affected by cell proliferation, but the migration period may be 

limited (≤7 hours) to prevent proliferation from being a contributing factor [81].  

 



21 

Chemotactic attraction is the directed movement of cells towards a solubilized attractant 

gradient and this process is often mimicked using a transwell insert (or Boyden chamber) 

[80]. In this chemotactic attraction assay, like the transwell co-culture assay, a cell type is 

plated on top of the porous membrane while a chemoattractant or chemoattractant-producing 

cell is plated below the membrane. The cells are then incubated for an appropriate period (e.g. 

3 hours), the cells fixed and stained, and the cells adhering to the underside of the membrane 

counted; the number of cells being proportional to the degree of chemotactic attraction [70]. 

 

Mechanical attraction (durotaxis) is the directed movement of cells towards a stiff substrate 

region from a softer region [82]. Durotaxis is typically a consequence of changes in the ECM 

stiffness that cells migrate along in vivo. To study mechanical attraction in vitro, hydrogels 

are created with different degrees of stiffness; this is determined by the concentration of the 

hydrogel monomers and the extent of crosslinking [82,83]. 

Alignment 

Cellular alignment is the oriented organization of cells and is quantified by first determining 

cell orientation and then calculating the degree of alignment. Several methods have previously 

been developed to analyse collagen and/or cell alignment. The Fast Fourier Transform (FFT) 

[84] applies the Fourier transform algorithm to images to identify recurring patterns of 

collagen/cells and determines their orientation. The local intensity gradient [85] method 

identifies the edges of collagen/cells in images and determines their orientation. The 

Binarization-based Extraction of Alignment Score (BEAS) [86] distinguishes the background 

from the foreground (i.e. collagen/cells) from which orientation data can be extracted. 

However, we have recently developed a simpler method to quantify alignment. In this 

method, we optimized the program ct-FIRE to automatically extract orientation information 

from binarized microscope images [41]. Once the orientations are determined, the degree of 

alignment can be evaluated by calculating an alignment index (AI) [87]. An AI calculates the 

degree of alignment with reference to a fixed point and assigns a value between 0 (randomly 

oriented) and 1 (perfectly aligned). However, since cells can align independent of a fixed 

point of reference, we have proposed using the direction in which most cells are oriented as 

the point of reference [41].  
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Fusion 

Myoblasts can fuse to form myotubes in vitro and the success of fusion varies can be assessed 

by evaluating morphological characteristics of myotubes, such as width and length, compared 

to a control [88]. Furthermore, a fusion index (FI) may be determined which calculates the 

percentage of nuclei in myotubes (with ≥3 nuclei) relative to the total number of nuclei in a 

field of view [89]. Myotube density has been shown to be directly proportional to the FI 

[90,91]. Therefore, automated image processing strategies have been developed to rapidly 

identify myotubes dyed with histological stains, such as LADD stain and Jenner-Giemsa 

stain, which stain protein-rich myotubes a darker colour than myoblasts; this allows myotubes 

to be easily distinguished from unfused cells [90,91].   

Evaluating Cellular Signalling and Behavioural Mechanisms 

Communication between myogenic and non-myogenic cells and the regulation of cellular 

behaviour often involves a myriad of proteins and several signal transduction pathways 

[34,47]. Myogenesis is regulated by the timely expression of Pax and the myogenic regulatory 

factors (MRFs) MyoD, Myf5, myogenin and MRF4. Quiescent satellite cells (Pax 7+) become 

activated to undergo self-renewal and commit to differentiation as proliferating myoblasts 

(Myf5+ and MyoD+). Myoblasts later become terminally differentiated myocytes (myogenin+ 

and MRF+) which align and fuse into multinucleated myofibres (MHC+ and MCK+) [92]. 

Expression of these muscle cell specific genes is regulated by an array of signalling molecules 

(e.g. HGF and insulin-like growth factor-I (IGF-I)) and transduction pathways (e.g. Wnt, 

Notch and MAPK pathways) [93]. 

 

The in vivo mechanisms can be elucidated by generating transgenic mice which overexpress, 

or are deficient for, specific genes [94,95]. Alternatively, inhibitors or recombinant proteins 

can be administered in vivo [96]. The mechanism by which proteins regulate cellular 

behaviours during intercellular communication in vitro can be evaluated via the addition of 

monoclonal antibodies and/or inhibitors. Neutralizing antibodies bind to an antigen (e.g. 

cytokines) and prevent its function [44]. Blocking antibodies bind to an antigen (e.g. receptors 

and integrins) and prevent its interaction with any other factors (e.g. cytokines) [34]. 

Inhibitors can be used to specifically inhibit enzyme activity; these enzymes can be externally 

secreted (e.g. iNOS and its inhibitor L-NAME) [97] or internally involved in signalling 

transduction pathways (e.g. p38 MAPK and its inhibitor SB202190) [47].  
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Conclusions and Future Perspectives 

Myogenesis represents a complex process involving multiple cell types and a sequence of 

regulated interactions. There are numerous models to study muscle regeneration in vitro, each 

with its own set of capabilities, limitations and challenges. The choice of model greatly 

depends on a researcher’s aims and experimental requirements. In this article, we have 

highlighted some of the most popular and accessible methods for generating in vitro muscle 

models; we then describe some of the most commonly used methods to assess cell behaviour 

and mechanism of effect during myogenesis. Future studies may potentially utilize any 

number of these methods to further investigate the roles of non-myogenic cells on 

myogenesis.  
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Abstract 

Cellular proliferation and migration are crucial during development, regeneration and disease. 

Methods to quantify these processes are available, however many are time consuming and 

require specialised equipment and costly reagents. Simple cell counts (proliferation analysis) 

and the scratch assay (migration analysis) are favourable methods as a result of their 

simplicity and cost-effectiveness, however they rely on subjective and labour intensive 

manual analysis, resulting in low throughput. We have developed optimized protocols to 

rapidly and accurately quantify adherent cell number and wound area using ImageJ, an open-

source image processing program. Notably, these adaptable protocols facilitate quantification 

with significantly greater accuracy than manual identification.  

 

Keywords: proliferation, adherent cell counts, myoblasts, migration, scratch assay, ImageJ 

 

Method Summary: Optimized automated methods to rapidly quantify proliferation and 

migration of adherent cells using ImageJ. These methods support high throughput and deliver 

enhanced accuracy when compared to manual analysis.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



31 

Cellular proliferation and migration are important processes during tissue development, repair 

and disease. Following skeletal muscle injury, proliferation and migration of activated muscle 

stem cells (myoblasts) is crucial to ensure that sufficient progenitor cells reach the wound site 

and facilitate repair [1]. Myoblast proliferation and migration are regulated by signalling 

molecules released from the extracellular matrix (ECM) and resident/infiltrating cells such as 

macrophages and fibroblasts [2]. Proliferation can be quantified by measuring changes in 

DNA (via BrdU, 3H-Thymidine), metabolism (via MTT), proliferation-specific proteins (e.g. 

Ki-67) or simple cell counts (e.g. haemocytometer, TC20™) [3-7]. Migration can be assessed 

by determining the number of cells that move across a microporous membrane (transwell 

migration assay) or by measuring the surface area that cells occupy over time after creating a 

“cell-free” area (scratch assay) [8-10]. Of these, cell counts and the scratch assay are 

favourable methods as a result of their cost-effective and simple nature, with fewer steps and 

a reduced need for specialized equipment.  

 

ImageJ, a popular opensource image processing program, has previously been used to 

manually count cells (selecting and tallying individual cells) and assess wound closure 

(tracing the wound perimeter and calculating percentage closure) [11-13]. These manual 

approaches are laborious and time-consuming, whereas automated image analyses would 

facilitate a higher throughput and greater objectivity. In the current study, we utilised the 

image processing capabilities of ImageJ to develop an optimized batch processing macro for 

rapid and accurate identification and quantification of adherent cell number and wound area 

from images captured using a brightfield phase contrast microscope. We demonstrate that 

these protocols are easier, faster and more objective than alternative methods. 

 

Murine C2C12 myoblasts (ATCC, cat. CRL-1772™, USA) were cultured at 37°C and 5% 

CO2 and maintained in growth medium (GM) containing Dulbecco’s Modified Eagle’s 

Medium (Sigma, cat. D5648, USA) supplemented with 10% (v/v) Fetal Bovine Serum 

(Gibco, cat. 10500, USA), 2% (v/v) Penicillin-Streptomycin (LONZA, cat. DE17-602E, 

Switzerland). Media was changed every 48 hours. Results were analysed using either a paired, 

two-tailed Student’s T-test (for comparison between methods at a single cell number or 

timepoint; Figure 1B, 2C) or one way ANOVA (for cell number changes within a method; 

Figure 1C), and values of p < 0.05 considered statistically significant. All data was 

represented as mean ± SEM. 
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For proliferation analysis, myoblasts (5, 10, 20, 40, 60, 80 and 100 x 103 cells) were cultured 

in GM (500 μl) in a 24-well plate for three hours to promote adherence. Media was then 

removed, and cells stained with 0.2% (w/v) crystal violet (Sigma, cat. C-3886) in methanol 

(Sigma, cat. 24229) for 15 minutes; excess stain was subsequently removed by water 

submergence and the plate left to airdry. Cells were visualized using an Olympus CKX41 

microscope (4x objective lens) and images captured (three fields of view per replicate; three 

replicates) with a Motic 3.0 megapixel camera. Cell number was assessed and compared using 

three methods: manual cell identification, automated cell identification and the 

spectrophotometric (crystal violet) assay.  

 

For manual identification, captured images were converted to grayscale in ImageJ (Image → 

Type → 8-bit) (Figure 1Ai), the cells were manually marked out with a red pencil dot (size: 4 

px) in Microsoft Paint (Figure Aii), the dots were then automatically identified (Image → 

Adjust → Color Threshold (Hue 225 to 255; Dark Background: True)) and counted (Analyze 

→ Analyze Particles) using ImageJ. For automated identification, the images were converted 

to grayscale, image noise removed (Process → Noise → Despeckle), brightness and contrast 

adjusted (Image → Adjust → Brightness/Contrast: min = 87; max = 167), and a Phansalkar 

threshold (Image → Adjust → Auto Local Threshold: Phansalkar) and watershed (Process → 

Binary → Watershed) were finally applied (Figure Aiii). Adjusting the brightness and 

contrast, and applying the Phansalkar threshold, made the cells more distinguishable from the 

background, while the watershed step segmented any clustered cells from one another. The 

identified cells were finally counted using ImageJ. For spectrophotometric analysis, the 

crystal violet-stained cells were solubilized with 200 μl SDS (1% w/v; Merck, cat. 

SAAR5823610EM, USA) for 1 hour; 100 μl of the solution was then removed and added to a 

96-well microplate [14]. The absorbance (595 nm) was read using the FLUOoptima micro 96-

well plate reader.  

 

For proliferation analysis, myoblasts were manually counted or identified and assessed using 

ImageJ. ImageJ could automatically identify cells at lower (5 x 103 cells) and higher (100 x 

103 cells) numbers, despite the cells being clustered closely together; however, this is likely to 

become increasingly challenging as confluence is attained. No significant difference was 

found between automated (ImageJ) versus manual identification, confirming the accuracy of  
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Figure 1. Quantification of cell number: a comparison of manual, automated (ImageJ) and 

spectrophotometric identification methods. (A) C2C12 myoblasts (10 x 103 and 80 x 103 are 

shown) were stained with crystal violet and captured with an Olympus CKX41 microscope 

coupled to a Motic 3.0 megapixel camera: (i) Brightfield images prior to processing, (ii) cells 

manually marked in Microsoft Paint and subsequently counted, (iii) cells automatically identified 

using the optimized ImageJ macro and subsequently counted. Scale bar = 200 µm (B) Standard 

curve of cell density (cells/mm2) following application of the manual versus the automated 

ImageJ analysis. (C). Standard curve of cell density (cells/mm2) following application of 

automated ImageJ analysis versus spectrophotometry. *p<0.05 and **p<0.005 for automated 

ImageJ analysis; #p<0.05 and ##p< 0.005 for spectrophotometric analysis; N=4-9. 
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the automated method (Figure 1B).  Manual cell identification was also a slow and laborious 

task compared to automated assessment.  We then compared our automated cell number 

analysis with spectrophotometric analysis of crystal violet-stained cells; the latter assay is a 

simple, inexpensive method commonly used to quantify cell number (Figure 1C). The 

standard curve generated using the spectrophotometric assay yielded a polynomial line (y= -

1E-05x2 + 0.0031x + 0.0777; R2 = 0.9936); as the number of plated cells increased, the 

absorbance (at 595 nm) increased, but plateaued after 60 x 103 cells (~65% confluence), 

possibly as a result of crystal violet saturation (Figure 1C). In contrast, the standard curve 

generated using the automated ImageJ macro resulted in a straight line (y = 3.5345x; R2 = 

0.999), indicating a directly proportional relationship between the number of cells plated and 

the number calculated per mm2. In addition, each sequential increase in plated cell number 

was reflected as a significant increase in cell density when utilising the automated counting 

method; this was not the case for the polynomial generated from crystal violet absorbance 

readings (Figure 1C). Therefore, ImageJ was sensitive enough to accurately detect both 

smaller changes in cell numbers and a wider range of cellular densities than 

spectrophotometric analysis of crystal violet-stained cells.  

 

For migration analysis, myoblasts (120 x 103) were plated out in GM (1 ml) in a 12-well plate 

for 24 hours, before performing a scratch assay as described by Goetsch et. al. (2011). 

Briefly, the confluent monolayer of myoblasts was scratched with a sterile 200 μl loading tip 

to create a linear “wound” devoid of cells. The cells were then washed twice with sterile PBS 

and fresh GM (500 μl) was added. The cells were incubated for 7 hours and images captured 

at 0, 3, 5 and 7 hours using the camera-attached microscope (4x objective lens) (two fields of 

view per replicate, for two replicates). To measure wound area manually, the edges of the 

wound were traced using the Motic Images Plus 2.0 ML software [15]. To carry out 

automated wound area measurements, the captured image was converted to grayscale, the 

edges found (Process → Find Edges) and the image blurred (Process → Smooth) multiple 

times (x 37).  The Find Edges step highlighted sharp changes in intensity with a white outline 

so that when the image was blurred numerous times, these outlines blurred together; as a 

result, the areas containing cells were white whereas the wound area (devoid of cells) 

remained black. A MinError threshold was then applied (Image → Adjust → Auto Threshold: 

MinError) to automatically detect the wound area. If the wound area was not accurately 

selected, it could be manually thresholded (Image → Adjust → Threshold). Once the wound 



35 

area was identified, it was then quantified (Analyze → Analyze Particles (size: 10 000 – 

infinity)).   

 

The percentage wound closure was calculated and the results generated using the manual 

versus automated methods were compared (Figure 2). The use of ImageJ to detected wound 

edges revealed that, when compared to manual assessment, automated analysis was able to 

accurately define these edges (Figure 2A); in fact, the automated analysis seemed to define 

the wound edges more accurately than the manual method (Figure 2B). As a result, when the 

percentage wound closure was assessed, a significant difference between the manual (12.13 ± 

 

Figure 2: Quantification of wound area: a comparison of manual and automated (ImageJ) 

identification methods. (A) C2C12 myoblasts (120 x 103) were scratched and images captured 

with an Olympus CKX41 microscope coupled to a Motic 3.0 megapixel camera (0, 3, 5 and 7 

hours): manual identification using Motic Images Plus 2.0 ML software to trace the wound edge 

and automated identification using ImageJ. (B) Zoomed-in images of wound edges following 

manual and automated identification at 3 hours. (C) Percentage wound closure (%) at 3,5 and 7 

hours post-injury. *p<0.05; N=16. Scale bar = 200 µm 
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0.98%) and automated (7.54 ± 0.76%) method was detected at 3 h post-wounding (p < 0.05). 

This was attributed to the fact that ImageJ could trace the outline of the wound more 

accurately than the researcher’s manual attempt; this was particularly evident during early 

wound repair when the wound borders were not well defined and therefore harder to 

accurately trace. The ability of ImageJ to sensitively and accurately measure wound area 

would be dependent on the image quality. We used a high-quality image (aspect ratio: 

1280x1024) with many pixels to allow ImageJ to accurately identify the edges of the wound. 

In contrast, a lower quality images with fewer pixels would make it difficult for ImageJ to 

accurately identify the wound. In addition to increased sensitivity and accuracy, the 

application of the ImageJ macro was less laborious and faster than manual analysis (manual 

analysis can take up to 10 minutes per image whereas our automated approach can complete 

the analysis of an image within a few seconds). 

 

In summary, we have developed an optimized ImageJ-based automated method for rapid 

quantification of cell number and migration in vitro. ImageJ could automatically identify and 

accurately quantify cell numbers and wound area; in some cases, the results were superior to 

those generated via traditional manual or spectrophotometric methods. In addition, our macros 

generated data faster than previous manual methods.  Although programs have previously 

been developed to count cells (e.g. CellC and CellCounter) or measure wound closure (e.g. 

TScratch) [16-19],  they did not match the flexibility of ImageJ which, as a single program, 

can be extended to quantify cell number in tissue sections and suspension cultures or adapted 

to monitor important cellular processes [19]. Finally, the opensource nature of this software 

permits further optimization depending on user requirements, yielding a superior and versatile 

method compared to previous protocols.  
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Abstract 

The communication between non-myogenic cells, such as macrophages and fibroblasts, and 

myoblasts is crucial for successful skeletal muscle repair. In vitro co-culture methods can be 

utilised to increase our understanding of these cellular interactions; however, current 

protocols are restricted to two, often physically separate, cell populations. Here, we 

demonstrate a novel, inexpensive in vitro triple co-culture method that facilitates the co-

culture of at least three cell populations with some degree of cell-cell contact. Using this 

method, we determined the effect of macrophages and fibroblasts on myoblast proliferation 

and migration. A significant increase in myoblast proliferation and migration was observed 

following co-culture with either macrophages or fibroblasts. However, triple co-culture of 

macrophages, fibroblasts and myoblasts revealed that the presence of macrophages prevented 

fibroblasts from maintaining this positive effect on myoblast migration. Macrophages, on the 

other hand, continued to promote myoblast proliferation whether in the presence of fibroblasts 

or not. Our triple co-culture system highlights the significance of multicellular 

communication in regulating myoblast proliferation and migration and emphasizes the 

importance of more complex co-culture systems when investigating myogenesis in vitro. 

 

Keywords: macrophages, fibroblasts, myoblasts, triple co-culture, myogenesis 

 

Method Summary: A novel triple co-culture method has been established to facilitate the co-

culture of macrophages, fibroblasts and myoblasts.  This assay, which permits some cell-cell 

contact, can be extended to include more than three cell types, and represents a simple, cost-

effective way to probe complex multicellular communication in vitro. 
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Introduction 

Severe skeletal muscle injury causes damage to myofibres and surrounding extracellular 

matrix (ECM) [1]. As a result, the damaged muscle undergoes sequential and overlapping 

stages of wound repair, where several cell types are activated to proliferate and migrate into 

the wound [2,3]. Macrophages and fibroblasts are present during these stages and are critical 

to the successful completion of the wound healing program [4]. Soon after injury, tissue 

degeneration, characterised by ruptured and necrotizing myofibres, is evident [5,6]. This is 

followed by inflammation, where macrophages residing in the epimysium and perimysium 

enter the wound to clear cell debris and secrete cytokines to initiate regeneration [2,7]. During 

the regenerative phase, infiltrating tissue fibroblasts are induced to differentiate into 

contractile myofibroblasts, which display a greater synthetic phenotype than fibroblasts. 

Myofibroblasts secrete cytokines, growth and extracellular matrix factors as well as enzymes 

that assist in remodelling the wound matrix [8-11]. This provides a mechanical scaffold for 

activated satellite cells (myoblasts) to proliferate and move from their niche between the basal 

lamina and sarcolemma to the area of damage [12]. At the wound site, they differentiate into 

myotubes and fuse with existing skeletal muscle tissue to repair damaged myofibres. The 

interplay of non-myogenic cells with activated satellite cells is therefore crucial for 

myogenesis and successful repair; a cellular imbalance may lead to impaired wound healing 

and, in the long term, chronic disease due to conditions such as fibrosis [4].  

 

In order to fully understand the complex mechanisms controlling myogenesis, it is important 

to take into account the relevant cells that regulate this process. There are a number of 

methods which can be used to achieve this; these include the use of in vivo approaches, in 

vitro 3D tissue engineered skeletal muscle or in vitro co-culture systems. In vivo models are 

more accurate in reflecting the process of muscle wound repair, but due to the array of 

interactions that take place, this environment is highly complex, making it difficult to identify 

individual mechanisms [13]. Muscle is a three-dimensional tissue consisting of contractive 

bundles of muscle fibres and blood vessels. The use of in vitro 3D tissue engineered skeletal 

muscle mimics these in vivo conditions more closely than in vitro monolayer studies to gain a 

comprehensive insight into muscle wound repair. However, 3D tissue culture is more time-

consuming in its establishment and requires extensive optimization.[14]. Co-culture systems 

make use of two or more cell populations, within the same in vitro microenvironment, thereby 

allowing some degree of interaction to study intercommunication between different cell types 
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[13]. This creates an experimental model that more closely mimics the intercellular 

communication within the in vivo environment and is therefore superior to conventional 

mono-culture [13,15,16].  

 

Co-culture systems fall into one of two categories.  Firstly, those that physically separate the 

cell populations from one another, typically by using a multi-compartment approach (e.g. 

transwell plates or “overflow” culture chambers) that allows communication only via soluble 

factors (Figure 1Ai and ii) [17,18]. A disadvantage of this type of method is that cells are not 

permitted to come in direct contact with one another, as would occur under in vivo conditions. 

Diffusion rates of soluble factors in larger culture volumes (as required in the overflow 

chamber) is also a consideration; if the rate of diffusion is too low, signalling factors may not 

be able to reach their targets timeously [13,19]. Secondly, there are those that allow direct 

interactions between cells (i.e. micropatterning); this is usually achieved by spatially 

controlling the position of the adhering cell populations within a culture dish (such as that 

reported by Javaherian et. al. (2013) or the co-culture method presented in this paper) (Figure 

1Aiii and iv) [20]. Co-culturing by way of micropatterning involves the creation of a distinct 

population of cells within a culture dish by selectively controlling the attachment of cells 

(Figure 1Aiii). This can be achieved by creating a non-adhesive area via a physical barrier 

(using stamps for example [21]) or a chemical barrier (e.g. BSA [20]). The first population of 

cells will adhere to the area surrounding the barrier; once the barrier is removed (either by 

physical removal or by coating the non-adhesive area with an adhesive matrix factor [20]), the 

second cell population binds in the remaining space [22]. This method has the advantage of 

allowing cells to interact via both secreted factors and cell-cell interactions, but is laborious, 

requiring additional steps and specialised equipment. 

 

Here, we describe a novel triple co-culture method (Figure Aiv), where a standard circular 

well-containing plate can be employed to culture multiple distinct cell populations, allowing 

for both direct and indirect cellular communication.  Using this method, we investigate the 

regulatory role of macrophages and fibroblasts on myoblast proliferation and migration, and 

demonstrate the importance of macrophage resolution to facilitate fibroblast-regulated wound 

repair in vitro. 
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Materials and Methods 

Cell Culture 

Mouse C2C12 myoblasts (Cat. CRL-1772™, ATCC, Manassas, VA, USA), LMTK 

fibroblasts (Cat. CCL-1.3™, ATCC) and J774A.1 macrophages (Cat. TIB-67™, ATCC) were 

cultured at 37ºC and 5% CO2 and maintained in growth medium containing Dulbecco’s 

Modified Eagle’s Medium (DMEM, Cat. D5648, Sigma, St Louis, MO, USA) supplemented 

with 10% (v/v) Fetal Bovine Serum (FBS, Cat. 10500, Gibco, Thermo Fisher Scientific, 

Waltham, MA, USA) and 2% (v/v) Penicillin-Streptomycin (PenStrep, Cat. DE17-602E, 

Lonza, Basel, Switzerland). Media was changed every 48 hours.  

 

Figure 1: Schematic of co-culture methods and steps. A) Transwell inserts (i), “Overflow” co-

culture chamber (ii), Micropatterning (iii) and our novel co-culture method (iv). B) Steps to 

establish novel triple co-culture method: first cell populations are plated at the outer edge of a 

well (i); culture plate is rotated to distribute the cells along the outer edge of the well (ii); cells are 

incubated for 1 hour to promote adherence (iii); subsequent cell population is then plated in the 

centre of the well (iv); media is added (v). 
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Co-Culture Method 

For co-culture of two cell types, either macrophages or fibroblasts (0, 5, 10, 20, 40, 80 x 103 

cells) were plated along the outer edge of a dry 24-well plate in a volume of growth medium 

not exceeding 100 μl, but not less than 30 μl (Figure 1Bi). For co-culture of three cell types 

(i.e. “triple co-culture) 40 x 103 macrophages and 40 x 103 fibroblasts were combined in 100 

μl growth medium and plated as above. A centrifugal force was then applied to the plate to 

ensure that the cells only attached to the outer edge of the well; this was achieved by simply 

rotating the plate in a circular motion (2 minutes) by hand, or using a rotational device (20 

rpm) set at a 45o angle (Figure 1Bii). Cohesion of the low medium volume ensures the cells 

do not spread towards the centre of the well. The cells were then incubated at 37˚C and 5% 

CO2 for 1 hour to promote adherence (Figure 1Biii). Following this, myoblasts were plated in 

the centre of the well and allowed to adhere to the unoccupied area (Figure 1Biv and v). 

Proliferation and migration of myoblasts in the centre of the well was then analysed as 

described below. The cells lines used with the co-culture method were cultured in the same 

culture medium and required no additional optimization. If cell types require different culture 

media, this method may not be suitable. 

Proliferation Analysis 

To analyse the effect of macrophages and fibroblasts on myoblast proliferation, 20 x 103 

C2C12 cells were allowed to adhere for 2 hours, then washed twice with sterile PBS and 

cultured in serum-free DMEM (500 μl).  Cells were co-cultured for 24 hours, washed with 

PBS and stained with basic Fuchsin (Cat. 47860, Sigma) for 10 minutes (1% w/v basic 

Fuchsin dissolved in 100% methanol). Cells were then submerged in water to remove excess 

stain and manually counted following visualization and image capture with an Olympus 

CKX41 microscope (Olympus Corporation, Tokyo, Japan) and a Motic 3.0 megapixel camera 

(4x objective; Motic, Kowloon, Hong Kong). Three randomly selected fields of view per 

replicate (taken from the centre of the well), with three replicates per experiment, were 

utilised. C2C12 cells, plated in the absence of macrophages or fibroblasts, served as a control. 

Changes in myoblast number were calculated relative to the number of myoblasts initially 

plated out and expressed as a percentage increase (%).   
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Migration Analysis 

For migration analysis, 50 x 103 C2C12 myoblasts were allowed to adhere for 24 hours before 

undergoing a scratch assay as described by Goetsch et. al. (2011) in serum-free DMEM (500 

μl). Briefly, while being careful not to disturb the cells on the outer edge, the confluent 

monolayer of myoblasts at the centre of the well was scratched with a sterile 200 μl loading 

tip to physically remove myoblasts and create a linear “wound”. The remaining cells were 

washed twice with sterile PBS and serum-free DMEM added (500 μl). They were then 

incubated for 7 hours and images taken at 0 and 7 hours using an Olympus CKX41 

microscope and a Motic 3.0 megapixel camera (4x objective). Percentage wound closure was 

calculated after tracing the wound edges using the Motic Images Plus 2.0 ML software 

(Goetsch et. al. (2011)).   

Immunocytochemistry and Confocal Microscopy 

To immunocytochemically identify cells in co-culture, cells were cultured on glass coverslips 

as described above. Briefly, macrophages (40 x 103) or fibroblasts (40 x 103) were plated in 

growth medium at the edge of the well, followed by myoblasts (20 x 103) in the centre of the 

well. The cells were then washed twice with PBS and switched to serum-free DMEM for 24 

hours to mimic the proliferation time-frame. To analyse the effect of macrophages on 

fibroblast phenotype, macrophages (40 x 103) were plated in growth medium at the edge of 

the well after which fibroblasts (40 x 103) were allowed to adhere in the centre of the well. 

The cells were then washed twice with PBS and switched to serum-free DMEM for 7 h to 

mimic the migration time-frame.  

 

Cells were then fixed with 4% paraformaldehyde, washed with PBS, blocked at 4ºC with 5% 

donkey serum (Cat. D9663, Sigma) and incubated at room temperature for 2 hours with the 

following primary antibodies as appropriate: polyclonal rabbit anti-desmin antibody (1:500; 

Cat. ab15200, Abcam, Cambridge, UK), monoclonal mouse anti-TCF-4 antibody (1:20; Cat. 

05-511, Merck Millipore, Billerica, MA, USA), polyclonal rabbit anti-E-cadherin (1:40; Cat. 

sc-7870, Santa Cruz Biotechnology, Dallas,TX, USA) or monoclonal mouse anti-α-smooth 

muscle actin (SMA) (1:500; Cat. A2547, Sigma). The cells were then washed with PBS and 

incubated at room temperature for 1 hour in the dark with one of the following appropriate 

secondary antibodies: Dylight488-conjugated donkey anti-rabbit antibody (1:1000; Cat. 711-

485-152, Jackson ImmunoResearch, Newmarket, Suffolk, UK), Dylight594-conjugated 
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donkey anti-mouse antibody (1:1000; Cat. 715-515-151, Jackson ImmunoResearch) or 

Dylight488-conjugated donkey anti-mouse antibody (1:2000; Cat. 715-485-151, Jackson 

ImmunoResearch). Hoescht (1:100; stock 10 mg/ml; Cat. B2261, Sigma) was subsequently 

added for 10 minutes and coverslips washed with PBS prior to being fixed again with 4% 

paraformaldehyde (10 mins), washed with PBS and mounted on glass slides with Mowiol 

(Cat. 81381, Sigma). The cells were viewed with a Zeiss 710 confocal microscope (Carl Zeiss 

GmbH, Oberkochen, Germany). 

Statistical Analysis 

Data was determined to be normally distributed; results were analysed using a parametric 

paired, two-tailed Student’s T-test and values of p < 0.05 were considered to be statistically 

significant compared to the control. All data was represented as mean ± SEM. 

Results 

To initially co-culture two cell populations, macrophages were plated at the outer edge of the 

well, while myoblasts were cultured in the centre of the well (Figure 2A, B). J774A.1 

macrophages are relatively small, circular cells, easily distinguishable from larger, spindle-

shaped myoblasts that overlap to an extent with macrophages, allowing for a degree of cell-

cell interaction (Figure 2B). This method of co-culture was then successfully repeated using 

fibroblasts instead of macrophages (Figure 2C). LMTK fibroblasts are larger than J774A.1 

macrophages, but smaller than C2C12 myoblasts and have an elongated shape. To establish 

the “triple co-culture”, macrophages and fibroblasts were both cultured at the outer edge of 

the well, while myoblasts were cultured at the centre of the well (Figure 2D). Fibroblasts and 

macrophages were clearly identified at the outer edge of the well via their expression of TCF-

4 and E-cadherin respectively (Figure 2E); significant numbers of macrophages and 

fibroblasts were not observed in amongst the myoblasts at the centre of the well (Figure 2E). 

Our method was established using a 24-well plate, but can be adapted to any culture vessel 

with circular wells. The advantage of this method over others lies in its simplicity and the fact 

that it can be established quickly without the need for additional, specialized equipment. A 

further benefit of our system is that it can be expanded to include more than three cell types; 

this is crucial when one is trying to mimic the in vivo environment. 
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Figure 2: Cell populations in distinct regions of the co-culture plate. A) Myoblasts are at the 

centre of the well, while B) macrophages, C) fibroblasts or D) macrophages and fibroblasts are 

present predominantly at the outer edge of the culture well (right side of the image) with some 

overlap with myoblasts. E) Fibroblast-myoblast co-cultures (left panel) immunostained with both 

mouse monoclonal anti-TCF-4 (red; fibroblasts) and rabbit polyclonal anti-desmin (green; 

myoblasts), while macrophage-myoblast co-cultures (right panel) were immunostained with 

rabbit polyclonal anti-E-cadherin (green; macrophages).  Hoeschst (blue) was used as a nuclear 

stain. Images were captured using a Zeiss 710 confocal microscope with a 25x objective lens. 

Scale bar = 50µm. Representative images from the outer edge and centre of the well are shown. 
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Using our co-culture method, we sought to determine the effect of macrophages and 

fibroblasts on myoblast proliferation and migration. Co-culture experiments revealed that 

macrophages and fibroblasts promote the proliferation of myoblasts (Figure 3A). Relative 

myoblast numbers already showed a small significant increase from 130 ± 4.38% to 146 ± 

4.12% (16% increase; p < 0.05) when co-cultured for 24 hours with 5 x 103 macrophages 

compared to control (Figure 3B). A maximal effect was reached following co-culture with 80 

x 103 macrophages (188 ± 1.75%; p < 0.05; Figure 3B). Fibroblasts also increased the 

proliferation of myoblasts, however a significant, maximal effect was only achieved in 

response to 20 x 103 fibroblasts; when fibroblast numbers were increased further, this pro-

proliferative effect was lost (Figure 3C). In response to 20 x 103 fibroblasts, relative myoblast 

numbers increased significantly from 189 ± 8.31% to 232 ± 16.76% (p < 0.05); whereas in 

response to co-culture with 80 x 103 fibroblasts, relative myoblast numbers returned to control 

levels of 187 ± 7.72% (Figure 3C). 
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Figure 3: The effect of macrophages or fibroblasts on myoblast proliferation and migration.  

A) Cells were stained with 1% Fuchsin in methanol and viewed using an Olympus CKX41 

microscope and images captured with a Motic 3.0 megapixel camera (4x objective lens). B) and 

C) Relative cell number for myoblasts cultured in the presence of increasing numbers of 

macrophages or fibroblasts, respectively. D) The wound area of myoblasts was visualized using 

an Olympus CKX41 microscope and images captured with a Motic 3.0 megapixel camera (4x 

objective lens). E and F) Percentage wound closure at 7 hours for myoblasts cultured in the 

presence of increasing numbers of macrophages or fibroblasts, respectively. * = p < 0.05; B, C 

and E: N=6; F: N=5). 
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Analysis of myoblast migration revealed that co-culture with 80 x 103 macrophages resulted 

in a significant increase in the percentage wound closure (17.0 ± 2.04%) compared to the 

control (9.42 ± 0.75%), 5 x 103 (9.58 ± 1.00%) and 20 x 103 (8.51 ± 1.52%) macrophages 

(Figure 3D and E; p < 0.05). The presence of lower numbers of macrophages had no 

significant effect on myoblast migration (Figure 3E). When co-cultured with fibroblasts, 

myoblasts responded by increasing their migration in a cell-density dependent manner (Figure 

3D and F).  Significant effects were already observed in response to 20 x 103 fibroblasts 

(Figure 3F), rather than at only 80 x 103 as seen with macrophages (Figure 3E). Following co-

culture with 20 x 103 cells, myoblast wound closure had increased significantly to 19.57 ± 

1.71% with a maximal significant effect observed in response to 80 x 103 cells (21.9 ± 1.62%) 

compared to the control (13.5 ± 0.79%) (p < 0.05; Figure 3F). This data suggests that rising 

fibroblast numbers promote myoblast motility, while macrophages lose their pro-migratory 

effect as their numbers decrease.  

 

To determine the combined effect of macrophages and fibroblasts on myoblast proliferation 

and migration, a triple co-culture experiment was carried out where myoblasts were co-

cultured with 40 x 103 macrophages and 40 x 103 fibroblasts. Total cell numbers exceeding 80 

x 103 cells caused the fibroblasts and macrophages to move to the centre of the well, hence 40 

x 103 of each cell type was used. Analysis of myoblast proliferation revealed that triple co-

culture of myoblasts with both macrophages and fibroblasts did not significantly change 

myoblast numbers when compared to conditions using macrophages or fibroblasts alone 

(Figure 4A). The pro-proliferative effect of macrophages on myoblasts was therefore 

observed, both in the absence and presence of fibroblasts. However, when myoblast migration 

was analysed, triple co-culture of myoblasts with both macrophages and fibroblasts abrogated 

the previous significant positive effect of fibroblasts on myoblast migration (Figure 4B). The 

pro-migratory effect of fibroblasts on myoblasts was therefore lost in the presence of 

macrophages. Further immunocytochemistry and confocal microscopy revealed that, whether 

in the absence or presence of macrophages, fibroblasts expressed alpha smooth muscle actin 

(-SMA; Figure 4C). It is well known that the presence of serum promotes the myofibroblast 

phenotype [23]; it was therefore not unexpected to observe -SMA expression in these cells. 

Our results suggest that macrophages do not initiate de-differentiation of myofibroblasts over 
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the 7h migration period. Interestingly, a decrease in cell number was observed, suggesting 

perhaps a pro-apoptotic effect of macrophages. This requires further investigation. 

 

 

 

Figure 4: The effect of both macrophages and fibroblasts on myoblast proliferation and 

migration. A) Relative cell number or B) percentage wound closure for myoblasts cultured in the 

presence of both 40 x 103 macrophages and 40 x 103 fibroblasts (40J40L). Controls include: no 

macrophages or fibroblasts (0), 40 x 103 fibroblasts alone (40L) or 40 x 103 macrophages alone 

(40J). C) Myofibroblasts were cultured alone (left image) or co-cultured with macrophages (right 

image), immunostained with mouse monoclonal anti-α-SMA antibody (green) and stained with 

Hoescht (blue). Images were captured using a Zeiss 710 confocal microscope (25x objective). 

Scale bar = 50µm. * = p < 0.05; N=5). 
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Following muscle injury, the inflammatory response is accompanied by an increasing 

population of macrophages, followed by the migration of resident fibroblasts that are 

promoted to proliferate and differentiate to myofibroblasts [24-29]. Triple co-culture studies, 

utilising macrophages, fibroblasts and myoblasts, revealed that the presence of macrophages 

negates the pro-migratory effects of fibroblasts on myoblasts. This supports the premise that 

although an inflammatory response is crucial for repair, under certain conditions, it can 

negatively affect repair. The pro-proliferative effect of macrophages on myoblasts was 

however maintained, even in the presence of fibroblasts, suggesting less of an influence of 

fibroblasts on macrophage-myoblast communication. Previous studies using more than two 

cell types in culture, the so-called “triple” co-culture, are very limited [30]; in fact, no 

previous studies have been performed to determine the combined effect of macrophages and 

fibroblasts on myoblast proliferation and migration. A crucial advantage of the current 

protocol is that it can be expanded to include additional relevant cell types, such as 

endothelial cells. In addition, the format allows the user to a) determine the phenotype of the 

participating cells (e.g. M1 versus M2 macrophages or fibroblasts versus myofibroblasts) 

using immunocytochemistry and b) polarise the co-cultured cells in order to determine 

whether distinct populations have differential effects on myoblast proliferation and migration. 

Our results underscore the importance of including cellular complexity in in vitro co-culture 

systems in order to gain a better understanding of how cellular communication regulates 

regenerative outcomes in skeletal muscle.  

 

In previous in vitro studies, the conditioned media of pro-inflammatory M1 macrophages was 

found to increase the proliferation of myoblasts, while inhibiting migration [31-34]. In our 

study, we used unmanipulated macrophages. This may account for some of the differences 

seen in our results compared to these published studies. It would be valuable to determine 

whether any change in macrophage phenotype is observed in response to myoblast injury. In 

vivo studies suggest that ablation of fibroblasts leads to depletion of satellite cells, premature 

satellite cell differentiation and results in smaller regenerated myofibres [35]. In vitro studies 

have shown that increasing fibroblasts in co-culture also promotes the migration of myoblasts 

[18] and that fibroblasts protect myoblasts from apoptosis during differentiation, promoting 

myotube formation [36]. This agrees with our current studies showing that the presence of 

fibroblasts promotes myoblast cell number and migration. 
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In summary, our optimised triple co-culture assay has numerous advantages: it is easier, 

simpler and cheaper to establish than conventional techniques, it allows for both direct and 

indirect cellular communication and it can be expanded in its complexity to include additional 

cell types such as endothelial cells. Using this model, we confirm that macrophages and 

fibroblasts are important regulators of myoblast proliferation and migration. We also show, 

for the first time, that macrophages can negatively influence the ability of fibroblasts to 

promote myoblast migration, in an in vitro wound healing setting. Knowledge generated from 

this method will further our understanding of the role of cellular interplay in regenerative 

processes. 
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Abstract 

Successful skeletal muscle wound repair requires the alignment and fusion of myoblasts to 

generate multinucleated myofibers. In vitro, the accurate quantification of cellular alignment 

remains a challenge. Here we present the application of ImageJ and ct-FIRE to quantify 

muscle cell orientation by means of an alignment index (AI). Our optimised method, which 

does not require programming skills, allows the alignment of myoblasts in vitro to be 

determined independently of a predefined reference point. Using this method, we demonstrate 

that co-culture of myoblasts with macrophages, but not fibroblasts, promotes myoblast 

alignment in a cell density-dependent manner. Interestingly, myoblast fusion was significantly 

decreased in response to co-culture with macrophages, while the effect of fibroblasts on 

fusion was density-dependent. At lower numbers, fibroblasts significantly increased myoblast 

fusion, whereas at higher numbers a significant decrease was observed. Finally, triple co-

culture revealed that the effect of macrophages on myoblast alignment and fusion is unaltered 

by the additional presence of fibroblasts. Application of our optimized method has therefore 

revealed quantitative differences in the roles of macrophages versus fibroblasts during 

alignment and fusion: while successful myoblast alignment is promoted by increasing 

macrophage numbers, regenerative fusion coincides with a decreasing macrophage population 

and initial rise in fibroblast numbers.  

 

Keywords: cellular alignment; co-culture; differentiation; myoblast; macrophage; fibroblast  
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Introduction 

Skeletal muscle represents a heterogenous tissue with multiple cell types that each play 

distinct and important roles in wound repair [1]. Damage to skeletal muscle results in the 

disruption of myofibres and the extracellular matrix (ECM) that surrounds them [2]. 

Myogenesis, the differentiation and fusion of mono-nucleated myoblasts into multi-nucleated 

myofibers, is a critically important stage of muscle regeneration and serves to restore muscle 

structure and function [3]. Non-myogenic cell types, such as macrophages and fibroblasts, 

mediate the behaviour of muscle cells during wound repair by secreting an array of signalling 

molecules and matrix factors [4,5]. We have previously investigated the effect of these non-

myogenic cells on myoblast proliferation and migration. We demonstrated that macrophages 

promote the proliferation of myoblasts in co-culture, while fibroblasts promote migration, 

during in vitro wound repair; the latter pro-migratory effect was reduced when myoblasts 

were co-cultured in the presence of both fibroblasts and macrophages under triple co-culture 

conditions [6,7].   

 

During the terminal phase of myogenesis, myoblasts align to organize themselves relative to 

each other and to existing myofibres [8]. This process brings the lipid bilayers in close contact 

with one another in order for the cells to fuse together to form functional muscle with 

myotubes orientated in the same direction [8]. Several strategies can be used to promote 

myotube alignment, including topographical patterning (e.g. grooved culture plates [9]), 

mechanical stimulation (e.g. stretch [10]) or application of magnetic/electrical fields [11,12]. 

In order to quantify the exact effect of these strategies on alignment, one has to identify the 

cell/nuclear outline or actin cytoskeleton, then determine the orientation of these elements and 

finally calculate a value that represents the extent of alignment [13]. To achieve this, cells are 

visually identified in images, their outlines manually selected, and their orientation 

ascertained by determining the angle of deviation of the longitudinal axis of the cell (in 

degrees) from the x-axis (set to 0°). In the study performed by Xu et. al. (2011), manual 

analysis (using several individuals to limit human bias) was compared to automated image 

processing techniques, such as the Fast Fourier Transform and local intensity gradient 

[14,15]. Manual analysis was accurate, but arduous and time-consuming with low throughput. 

[13]. Furthermore, the automated image processing techniques have previously been used to 

determine cellular orientation; however, these approaches were designed for determining the 
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orientation of a type of pattern rather than determining the orientation of cells and therefore 

yield low alignment scores [13].  

 

Xu et. al. (2011) addressed the challenges of these techniques by developing the Binarization-

based Extraction of Alignment Score (BEAS) method to rapidly and accurately quantify the 

alignment of cells [13]. However, a major challenge with BEAS (and other previous methods) 

is that the information required to determine cellular orientation is presented as a complex 

image-processing algorithm, which needs to be computed in MATLAB (a costly computer 

programming language and computing environment). This implementation is problematic for 

researchers who have neither programming experience nor access to MATLAB. An easily 

accessible, automated method to quantify cellular orientation was therefore required.   

 

ct-FIRE is a freely available, standalone and fully developed framework designed to 

determine the orientation of collagen fibres; it has not been tested for its ability to determine 

cellular orientation [16]. In order to adapt ct-FIRE to measure cellular orientation, a number 

of approaches can be used. Data can be organized into 10° bins and either represented as a 

histogram of frequency distribution (however, this gives no indication of the extent of 

alignment and makes significance testing problematic) or used to calculate the degree of 

alignment. In the latter method, cells within less than 10° of the preferred orientation are 

considered aligned and the percentage of cells in that particular frequency is then calculated 

[17,18]. Alternatively, an alignment index (AI), which determines how well cells align in a 

specified direction can be calculated [18-20]. An AI is generally easier to calculate if there is 

a set direction to which orientation can be compared (e.g. directional angle of the grooves on 

a plate or the average direction of the cells in a culture dish). However, under standard 

myoblast culture conditions, there is often no set direction to which alignment can be 

compared as the cells align independently of physical properties of culture plate and 

subsequently self-organize in response to elongating myoblasts during fusion [21].  

 

In the current study, we present a method for determining cellular alignment; this method 

does not require a pre-defined reference direction. ct-FIRE is first tested for its ability to 

determine the alignment of elliptical shapes (representing hypothetical cells) compared to 

linear collagen shapes (for which the programme was developed); the orientation determined 

by ct-FIRE is compared to actual orientation using the AI (Figure 1A). We then generate an 
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alignment model, creating data sets with defined standard deviations, which represent 

hypothetical images of cells aligned to different extents (Figure 1B). These hypothetical 

images are then rotated, and an AI calculated using either the average (i.e. the mean direction 

of cell alignment) or preferred (i.e. direction in which most cells are aligned) orientation 

(Figure 1B). Lastly, we test our method using images of cultured myoblasts, where the image 

processing capability of ImageJ is first applied to automatically mark the boundaries of cells 

and ct-FIRE is subsequently used to analyse cellular orientation and calculate an AI (Figure 

1C) [13,16].  Once established, we then apply this protocol to assess the effect of 

macrophages and fibroblasts on the alignment of myoblasts during fusion. This accessible, 

optimised method for the analysis of cellular orientation presents a tool for analysis of 

alignment in vitro. Our results highlight the distinct regulatory role of non-myogenic cells on 

alignment and fusion during terminal skeletal muscle differentiation. 
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Figure 1: Overview of methodology development. A) ct-FIRE was tested for its ability to 

determine the orientation of linear versus elliptical shapes, representing either collagen or cells, 

respectively. B) A model for alignment was created using Microsoft Excel to represent 

hypothetical cells that were then rotated at -90 and +37.1˚ ; their alignment was calculated and 

compared using the average orientation versus preferred orientation. C) Images of differentiating 

myoblasts were then acquired, and the AI calculated using the preferred orientation. 
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Materials and Methods 

Testing ct-FIRE on Images of Hypothetical Cells 

The programme ct-FIRE was initially developed to determine the alignment of collagen 

fibres; these fibres have linear shapes as opposed to elliptical shapes that are classically 

associated with elongated spindle-shaped cells. Linear and elliptical shapes were therefore 

created using Microsoft PowerPoint (2016) and orientated at 0˚, 30˚, 60˚, 90˚, 120˚ and 150˚ 

(Figure 2); these orientations represent x in the equation below, where N is the total number of 

orientations [20,22]:   

 

Alignment Index (AI) = 
1

𝑁
∑ (2 [𝑐𝑜𝑠(𝑥 − 𝑦)]2 − 1)𝑁

𝑖=1  

 

ct-FIRE was then tested to determine whether it would be able to measure the orientation of 

both shapes, generating the value y in the above equation. An AI value of 0 represents no 

agreement between x and y, while a value of 1 represents a perfect agreement (i.e. x equals y). 

This evaluated how well the orientation determined by ct-FIRE agrees with the actual 

orientation.  

 

 

 

Figure 2: Representative images of collagen fibres (linear) and cells (elliptical). Hypothetical 

shapes representing collagen fibres and cells were created using Microsoft PowerPoint orientated 

at 0˚, 30˚, 60˚, 90˚, 120˚ and 150˚. 
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Alignment Modelling  

A set of normally distributed random data (N=98) around a mean (set to 90) with a specified 

standard deviation (0, 4, 16, 64) (Supplementary Table 1) was created using the Microsoft 

Excel (2016) =NORM.INV (probability; mean; standard deviation) function with =RAND() 

as the probability (which creates a random factional value: 0 ≤ α ≤ 1). The values in this data 

set represent theoretical directions in which an “image” containing 98 cells are likely to be 

orientated (the smaller the standard deviation, the greater the extent of alignment, and vice 

versa). Using this model, a cell orientated at 180˚ has the same alignment as a cell orientated 

at 0˚. Similarly, 225˚ equals 45°, 270˚ equals 90˚ and so on. Therefore, 180˚ was subtracted 

from values ≥ 180˚ and added to values < 0˚ in order to represent cell direction exclusively 

between 0˚ and 180˚. In order to rotate hypothetical images of these cells, every theoretical 

cell in a data set was shifted by -90˚ or +37.1˚ and values ≥ 180˚ or < 0˚ adjusted accordingly. 

For every data set, the average orientation (an average of all orientations) and preferred 

orientation (an average of cell orientations in the frequency bin with the largest value) was 

calculated and used in the same alignment index equation stated earlier, where N is now the 

total number of cells, x is the average OR preferred orientation used as a reference point of 

the data set and y is the orientation of an individual cell within that data set. This equation 

determines how well a cell aligns along a particular direction (e.g. a fixed point of reference) 

or along the average/preferred direction of cells within each individual cell in a data set. The 

alignment index of every cell in a data set was used to calculate an average alignment index 

(of all the cells in that data set) between 0 and 1, where 0 represents a group of cells that are 

randomly orientated and 1 represents a population that is perfectly aligned [22]. The AI was 

first calculated using the average orientation (often associated with a defined reference point 

[17,18,20]) and this was repeated using the preferred orientation of the data set, in order to 

compare the two. 

Cell Culture 

Mouse C2C12 myoblasts (ATCC, USA, cat. CRL-1772™), LMTK fibroblasts (ATCC, USA, 

cat. CCL-1.3™) and J774A.1 macrophages (ATCC, USA, cat. TIB-67™) were cultured at 

37°C and 5% CO2 and maintained in growth medium (GM) containing Dulbecco’s Modified 

Eagle’s Medium (DMEM, Capital Lab Supplies, South Africa, cat. D5648) supplemented 

with 10% (v/v) Fetal Bovine Serum (FBS, Gibco, USA, cat. 10500) and 2% (v/v) Penicillin-
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Streptomycin (PenStrep, LONZA, Switzerland, cat. DE17-602E). Media was changed every 

48 hours.  

 

Co-culture of macrophages and/or fibroblasts with myoblasts was established as described in 

Venter and Niesler (2018) [6]. Briefly, for double co-culture, macrophages or fibroblasts (0, 

5, 10, 20, 40 and 80 x 103) were plated on the outer edge of the well of a 24-well culture plate 

in GM for an hour to promote adherence; C2C12 myoblasts (50 x 103 cells) were then plated 

and left to adhere in the centre of the same well for 24 hours in GM. For triple co-culture, 

both macrophages (40 x 103) and fibroblasts (40 x 103) were plated on the outer edge and 

myoblasts plate in the centre as described above. Myoblasts were differentiated for 5 days in 

differentiation medium (DM; 2% FBS in DMEM) with media changed every 2-3 days. After 

differentiation, the cells were stained with 1% Fuchsin (Capital Lab Supplies, South Africa, 

cat. 47860) in methanol (15 minutes), washed three times with distilled water, left to air dry 

overnight, and evaluated for alignment and fusion. 

Evaluating Alignment   

Images (5 randomly selected fields of view; 2 replicates per experiment; 10 images in total) of 

differentiated myoblasts were taken with an Olympus CKX41 microscope and a Motic 3.0 

megapixel camera (10x objective lens) (Supplementary Figure 1A) and processed with 

ImageJ, using an adaptation of the binarization method described by Xu et. al. [13] 

(Supplementary Figure 1B). The image was converted to grayscale (Image → Type → 8-bit), 

image noise removed (Process → Noise → Despeckle) and a mean threshold applied (Image 

→ Adjust → Auto Local Threshold: Mean; Uncheck “White objects on black background”) 

and further processed with ct-FIRE (Supplementary Figure 1C). The AI was then calculated 

using the preferred orientation of cells (as described earlier). 

Fusion Index 

Images (5 randomly selected fields of view; 2 replicates per experiment) of differentiated 

C2C12 myoblasts (day 5) were taken with an Olympus CKX41 microscope and a Motic 3.0 

megapixel camera (20x objective lens) and the fusion index calculated as follows: 

 

Fusion Index (%) = (No. of myotube nuclei (≥3 nuclei)/Total no. nuclei) x 100  
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Statistical Analysis 

Data was determined to be normally distributed; all results were analysed using a parametric 

paired, two-tailed Student’s T-test and values of p < 0.05 were considered to be statistically 

significant compared to the control. All data was represented as mean ± SEM. Experiments 

were repeated 3 to 5 times. 

Results 

ct-FIRE can determine the orientation of cell-like shapes 

ct-FIRE was originally developed to determine the orientation of linear collagen fibres, but its 

ability to determine the orientation of elliptical cell-like shapes had not been evaluated. The 

AI’s of linear versus elliptical shapes were determined to be 0.9992 versus 0.9999 

respectively (Table 1), demonstrating that ct-FIRE is able to determine the orientation of both 

shapes with a very high degree of accuracy (maximum AI = 1). No significant differences in 

AI calculation between linear and elliptical shapes were observed. This demonstrates that ct-

FIRE can be used to accurately determine the orientation of elliptical shaped objects, such as 

cells. 

Table 3: Comparison of the alignment index for hypothetical linear and elliptical shapes.  

Shape Linear Elliptical 

Mean 0,9992 0,9999 

SD 0,0005 0,0002 

An alignment index (AI) was calculated to determine how well the orientation of the linear and 

elliptical shapes, as determined by ct-FIRE, agrees with the actual known orientation. 

Calculation of cellular alignment should use preferred rather than average orientation  

The rotation of a hypothetical image of aligned cells (orientated at 90˚) by -90˚ or +37.1˚ 

(Figure 3) does not change how they are aligned, but merely shifts the direction in which they 

are aligned (0˚ or 127.1˚, respectively). The data set in Supplementary Table 1 represents 

either a population of hypothetical cells that are perfectly aligned (SD = 0), somewhat aligned 

(SD = 4 or 16) or unaligned and randomly orientated (SD = 64). 
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The alignment index (AI), for each data set representing a hypothetical image of cells (Table 

2) with different degrees of alignment (SD = 0, 4, 16 and 64) was then compared, following 

calculation, using the average orientation and preferred orientation; the significance within 

SD’s was subsequently tested between 90° and either 0° or 127.71˚ orientations. When 

comparing the AI generated for cells orientated at 90° and 127.71˚ using the average 

orientation, there was no significant difference irrespective of the SD (Table 2). When 

comparing cells orientated at 90° with those oriented 0°, there was significant difference for 

SD’s 4, 16 and 64. For instance, for SD = 4, the AI was 0.98 at 90° when using the average 

orientation which was significantly different when compared with -0.94 at 0° (Table 2). There 

was no significant difference between 90° versus 0° and 90° versus 127.1° for any of the 

standard deviations when using the preferred orientation. This suggests that using the average 

orientation as a point of reference to calculate the AI of cells will yield inaccurate results 

when an image is orthogonally rotated; using the preferred orientation yields the same AI 

regardless of which direction an image may be rotated.  

 

 

 

 

 

 

Figure 3: Model of Alignment. Schematic to show that a group of cells can be orientated in any 

direction (90˚, 0˚ or 127.1˚) and still have the same degree of alignment.  
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Table 4: Comparison of the alignment index of data sets with different standard deviations, 

calculated using the average vs. the preferred orientation.  

 Alignment Index (AI) 

 Average Orientation Preferred Orientation 

SD 90o 0o 127.1o 90o 0o 127.1o 

0 1 1 1 1 1 1 

4 0,98 -0,94* 0,98 0,98 0,98 0,98 

16 0,87 -0,85* 0,88 0,85 0,85 0,86 

64 0,16 -0,15* 0,02 0,14 0,14 0,15 

Data sets with increasing standard deviations (and orientated about 90˚) were created using Microsoft 

Excel. These data sets represent hypothetical cells aligned to different extents. Hypothetical cells were 

shifted to 0° and 127.1˚ and the alignment index calculated compared to the average and the preferred 

orientation. * = p < 0.05 compared to the alignment index (AI) at 90˚. 

Macrophages inhibit fusion, but promote alignment of myoblasts in a density-dependent 

manner 

Once we had determined that the preferred orientation was more appropriate in determining 

cellular AI’s, we went on to evaluate the effect of macrophages on myoblast alignment. 

Visual analysis of co-culture of macrophages with myoblasts (Figure 4) suggested that 

macrophages had differing effects of alignment versus fusion (Figure 4A). Following 

calculation, it was evident that the myoblast AI was significantly increased in response to 5 x 

103 macrophages (0.21 ± 0.02; p < 0.05) and continued to increase in a cell density-dependent 

manner reaching a maximum effect at 80 x 103 cells (0.46 ± 0.03; p < 0.05), compared to the 

control (0.14 ± 0.02) (Figure 4B). Co-culture with macrophages, however, was observed to 

negatively impact fusion (Figure 4C), with 20 x 103 macrophages causing a significant 

decrease in the fusion at day 5 (14.88 ± 0.75 %; p < 0.05) compared to the control (19.55 ± 

0.15 %). Macrophages continued to negatively affect myoblast fusion in a density-dependent 

manner with 80 x 103 macrophages having the greatest significant effect (6.08 ± 0.49 %; p < 

0.05) compared to the control.  
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Figure 4: The effect of macrophages on the alignment and fusion of myoblasts. Macrophages 

(0 (control), 5, 10, 20, 40 and 80 x 103) were co-cultured with differentiating myoblasts for 5 

days, stained with Fuchsin and viewed using an Olympus CKX41 microscope A) Images of 

myoblasts co-cultured with increasing numbers of macrophages (0, 5 and 80 x 103) captured with 

a Motic 3.0 megapixel camera; arrows indicate differentiated myotubes. B) Cell orientation and 

alignment index (AI) evaluated using ct-FIRE and the alignment index (AI) calculated. C: Fusion 

index (%). * = p < 0.05; Alignment: N=4; Fusion: N=3 
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Fibroblasts do not significantly alter myoblast alignment, but have differential effects on 

fusion  

 

Co-culturing fibroblasts with myoblasts resulted in no observable difference in alignment; it 

appears though that lower fibroblast numbers were associated with larger myotubes, while co-

cultures with higher fibroblast numbers displayed smaller myotubes (Figure 5A). 

Quantification of AI revealed no significant increase in myoblast alignment in response to 

these non-myogenic cells; indeed, AI values did not exceed 0.27 under any conditions (Figure 

5B). However, a significant increase in the fusion index was observed in response to 5 x 103 

fibroblasts (42.28 ± 3.47 %; p<0.05) in comparison with the control (24.23 ± 1.93 %) (Figure 

5C). When further increasing the number of fibroblasts, this positive effect was slowly lost 

until in fact, at 80 x 103 fibroblasts, a significant decrease in fusion is observed (12.62 ± 0.75 

%; p < 0.05) compared to control (Figure 5C). 
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Figure 5: The effect of fibroblasts on the alignment and fusion of myoblasts. Fibroblasts (0, 5, 

10, 20, 40 and 80 x 103) were co-cultured with differentiating myoblasts for 5 days, stained with 

Fuchsin and viewed using an Olympus CKX41 microscope. A) Images of myoblasts co-cultured 

with increasing numbers of fibroblasts (0, 5 and 80 x 103) captured with a Motic 3.0 megapixel 

camera; arrows indicate differentiated myotubes. B) Cell orientation and alignment index (AI) 

evaluated using ct-FIRE. C) Fusion index (%). * = p < 0.05; Alignment: N=3; Fusion: N=3 
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Macrophages continue to promote myoblast alignment and inhibit fusion in the presence of 

fibroblasts  

In order to determine the effect of an inflammatory and fibrotic environment on myoblast 

differentiation, triple co-cultures of macrophages and fibroblasts with myoblasts were carried 

out (Figure 6). Analysis of myoblast alignment showed that macrophages (40 x 103) on their 

own continued to significantly promote the alignment of myoblasts (0.45 ± 0.03) compared to 

the control (0.05 ± 0.01; p < 0.05), while fibroblasts (40 x 103) had no significant effect 

(Figure 6A). Co-culture of macrophages (40 x 103) with myoblasts continued to have a 

negative effect on myoblast fusion (6.37 ± 0.87%; p < 0.5) compared to the control (12.90 ± 

1.00%), while fibroblasts (40 x 103) continued to have no significant effect on myoblast 

fusion (Figure 6B). When macrophages and fibroblasts were co-cultured with myoblasts, 

macrophages maintained both their positive effect on myoblast alignment (0.38 ± 0.03; p < 

0.05; Figure 6A) and their negative effect on myoblast fusion (7.51 ± 0.51; p < 0.05; Figure 

6B) compared to the control.  

  

 

Figure 6: The effect of macrophages and fibroblasts on the alignment and fusion of myoblasts.  

Macrophages (40J; 40 x 103 cells), fibroblasts (40L; 40 x 103 cells) or both macrophages and 

fibroblasts (40J40L; 40 x 103 cells, each) were co-cultured with differentiating myoblasts for 5 days. 

A) Alignment index (AI). B) Fusion index (%). * = p < 0.05; Alignment: N=5; Fusion: N=5 
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Discussion 

Skeletal muscle has the remarkable ability to repair itself post-injury. In order for this process 

to occur, satellite cells become activated, migrate into the wound, align with one another as 

well as existing muscle, and differentiate to form multi-nucleated myotubes [23]. Alignment 

is an important step during myogenesis, because it orientates the muscle cells in a similar 

direction and brings lipid membranes together; this allows the cells to fuse and form 

multinucleated myofibres with parallel longitudinal axes [8,24]. Muscle cells that are cultured 

in vitro maintain their ability to align and can do so without a predefined template [21]. 

 

A number of previous studies have used physical templates, such as grooves in a culture well, 

to improve myoblast alignment in vitro [19,21,25,26]. The alignment of these cells was 

quantified by determining their orientation relative to these grooves, which were set as the 

reference. Cells orientated in the direction of these grooves were classified as perfectly 

aligned (AI = 1), whereas those that were randomly orientated around the reference point 

were  deemed unaligned (AI = 0) [13,22]. A problem however arises when cells are able to 

align in the absence of a template; under these circumstances there is no point of reference for 

assessment of AI. We therefore sought to develop a method to address this shortcoming. 

 

Random data sets with a range of standard deviations were created in order to represent cells 

aligned to different degrees. The smaller the standard deviation within this set, the better the 

alignment; conversely, the higher the standard deviation, the greater the random orientation. 

The overall alignment of all the “cells” in the image can be determined by either calculating 

the mean (referred to as the “average orientation”) or the mode (referred to as the “preferred 

orientation”) of the data set. Rotating this image (irrespective of the standard deviation) 

should not change the AI, because it merely shifts the direction in which all the “cells” are all 

distributed. When the AI was calculated using the average orientation, it did not however 

remain the same when the data set was shifted; on the other hand, when the preferred 

orientation was used, the AI remained the same no matter what direction the data set was 

shifted. For this reason, we subsequently used the preferred orientation in all subsequent 

calculations. 

 

The orientation of each individual cell can be manually determined by measuring the angle at 

which it lies relative to another cell [13]. However, this becomes unfeasible when dealing 
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with high numbers of cells. There are few available programs that can perform automated 

alignment assessment without the need for programming skills. ct-FIRE, software originally 

designed to determine the orientation of collagen fibres (in essence, straight lines) is one such 

program [16]. In order to test and compare its ability to determine the orientation of elliptical 

cell-like shapes, images of straight lines (akin to “collagen”) and ellipsis (akin to “cells”) were 

created, orientated in known directions. ct-FIRE was then employed to determine the 

orientation of these shapes; the measured orientation was then evaluated to determine how 

well it matched the actual alignment. It was determined that ct-FIRE could not only precisely 

determine the orientation of straight lines as it was intended, but could also be used to 

measure alignment of elliptical cell-like shapes. ct-FIRE is therefore an appropriate tool for 

the calculation of cellular AI in vitro.  

 

Next, we sought to use our established method to determine the effect of macrophages and 

fibroblasts on myoblast alignment and fusion. Pro-inflammatory macrophages are prevalent in 

the early stages of wound repair and are important for clearing necrotic debris and apoptotic 

cells [27,28]. These macrophages are also known to secrete a host of pro-inflammatory 

signalling molecules that regulate muscle regeneration, however the mechanisms regulating 

this are unclear [29,30]. Moreover, these soluble factors secreted by M1 macrophages have 

previously been shown to inhibit myoblast fusion without direct contact [31]. Co-cultures of 

macrophages with myoblasts demonstrated, for the first time, that macrophages significantly 

improve the alignment of myoblasts during differentiation. Co-culture with as few as 5 x 103 

macrophages and up to 80 x 103 macrophages resulted in significantly increased myoblast 

alignment. Subsequent analysis of fusion suggests that, while the lower macrophage number 

has no effect on fusion, higher numbers significantly decrease it. Additional triple co-culture 

studies showed that this effect of macrophages on myoblasts differentiation was not altered by 

the presence of fibroblasts. This suggests that, whether in the presence or absence of 

fibroblasts, macrophages are important in the early stages of myogenesis in order to correctly 

orientate and align the cells. while their resolution may be crucial during terminal 

differentiation.  

 

Fibroblasts are important in muscle regeneration because they are known secretors of ECM 

scaffold components, such as collagen I and III [32,33]. Fibroblasts, upon in vivo muscle 

injury, differentiate to form the ECM-secreting “myofibroblasts” [32,34]; in vitro, the 
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myofibroblast phenotype is commonly generated in response to serum [35]. As with 

macrophages, an extended presence of myofibroblasts may lead to aberrant muscle 

regeneration [5]. When fibroblasts were co-cultured with myoblasts, no significant effect was 

observed on alignment. Evaluating the effect of myofibroblasts on myoblast fusion, revealed 

that low numbers of myofibroblasts (5 x 103) significantly promoted fusion. However, as the 

number of myofibroblasts increased, fusion decreased in a cell density-dependent manner to 

the point where at the highest numbers, fibroblasts significantly lowered myoblast fusion in 

comparison to control. The data suggests that while fibroblasts may not be central regulators 

of myoblast alignment, their effect on fusion is significant, but highly dependent on their 

density.  

 

In summary, we have optimised a protocol for the quantification of cellular alignment, which 

can calculate the alignment index of a population of cells in the absence of a predefined 

reference template. Evaluating the effect of macrophages and fibroblasts on myoblast 

alignment during differentiation, we showed that macrophages had opposing effects on 

myoblast alignment versus fusion, promoting and inhibiting these processes, respectively. 

Furthermore, while fibroblasts had no significant effect on myoblast alignment, they could 

either promote or inhibit fusion depending on their density. Finally, the presence of 

fibroblasts did not alter the effect of macrophages on myoblast differentiation. This accessible 

alignment analysis tool can now be used to provide further insight into the regulation of 

cellular orientation during myogenesis and other processes. 
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Supplementary Information 

Table S5: A data set representative of a cell population with different extents of alignment.  

Cell No. Standard Deviation Cell No. Standard Deviation Cell No. Standard Deviation 

 

0 4 16 64 

 

0 4 16 64 

 

0 4 16 64 

1 90,00 81,21 54,00 15,44 34 90,00 88,74 86,95 75,98 67 90,00 92,96 100,15 115,31 

2 90,00 81,76 58,03 18,10 35 90,00 88,91 87,10 76,49 68 90,00 93,37 100,45 117,22 

3 90,00 81,80 62,03 23,29 36 90,00 89,01 87,13 79,35 69 90,00 93,39 100,88 121,14 

4 90,00 82,48 62,57 24,51 37 90,00 89,05 88,33 81,08 70 90,00 93,45 101,87 122,19 

5 90,00 84,79 64,94 25,71 38 90,00 89,09 88,63 81,70 71 90,00 93,47 101,93 123,21 

6 90,00 84,82 67,30 26,75 39 90,00 89,11 89,14 83,98 72 90,00 93,70 102,31 123,66 

7 90,00 84,92 68,30 31,43 40 90,00 89,14 89,18 85,54 73 90,00 93,92 102,64 124,07 

8 90,00 85,26 69,90 32,43 41 90,00 89,17 89,91 85,80 74 90,00 93,93 102,69 124,32 

9 90,00 85,57 70,63 32,85 42 90,00 89,20 89,91 85,84 75 90,00 94,10 102,70 127,57 

10 90,00 85,64 70,72 33,05 43 90,00 89,63 89,97 86,08 76 90,00 94,13 102,75 130,39 

11 90,00 85,64 73,39 34,52 44 90,00 89,94 90,01 87,25 77 90,00 94,22 104,03 130,95 

12 90,00 86,05 73,90 38,61 45 90,00 89,98 90,42 88,58 78 90,00 94,28 104,06 135,09 

13 90,00 86,17 75,33 39,26 46 90,00 90,14 90,48 88,70 79 90,00 94,57 105,67 135,50 

14 90,00 86,30 76,51 43,01 47 90,00 90,29 90,90 90,48 80 90,00 95,15 106,50 139,93 

15 90,00 86,35 77,83 45,63 48 90,00 90,43 91,15 92,15 81 90,00 95,64 106,71 140,06 

16 90,00 86,37 78,86 46,95 49 90,00 90,56 91,41 93,07 82 90,00 95,70 107,98 143,10 

17 90,00 86,44 79,50 48,93 50 90,00 90,79 91,59 93,62 83 90,00 96,04 108,54 143,88 

18 90,00 86,89 79,75 50,53 51 90,00 90,99 92,92 95,97 84 90,00 96,11 109,02 144,67 

19 90,00 86,91 80,12 51,85 52 90,00 91,05 93,01 99,77 85 90,00 96,26 109,04 151,48 

20 90,00 87,10 81,17 54,28 53 90,00 91,11 93,52 100,59 86 90,00 96,49 109,32 152,58 

21 90,00 87,45 81,40 54,59 54 90,00 91,18 93,97 102,40 87 90,00 96,64 110,52 153,21 

22 90,00 87,50 81,75 54,82 55 90,00 91,32 94,31 104,02 88 90,00 96,74 110,77 153,47 

23 90,00 87,58 81,99 60,51 56 90,00 91,39 94,80 105,56 89 90,00 97,56 111,14 156,65 

24 90,00 87,62 82,40 60,71 57 90,00 91,60 96,04 105,84 90 90,00 97,61 111,87 158,64 

25 90,00 87,73 82,42 64,23 58 90,00 91,61 96,15 106,14 91 90,00 97,71 113,36 161,50 

26 90,00 87,81 82,54 68,42 59 90,00 91,73 96,37 107,51 92 90,00 98,05 114,66 161,51 

27 90,00 88,18 83,05 69,37 60 90,00 91,96 96,40 108,70 93 90,00 98,49 115,07 164,74 

28 90,00 88,24 83,13 70,76 61 90,00 92,29 96,52 109,23 94 90,00 98,75 117,51 164,83 

29 90,00 88,33 83,25 72,62 62 90,00 92,59 97,20 109,74 95 90,00 98,83 119,63 165,52 

30 90,00 88,39 83,70 72,66 63 90,00 92,65 98,44 111,80 96 90,00 99,10 122,83 177,85 

31 90,00 88,59 84,49 72,92 64 90,00 92,69 98,84 113,64 97 90,00 100,57 123,54 179,40 

32 90,00 88,70 86,32 74,07 65 90,00 92,92 99,54 114,33 98 90,00 101,36 126,04 179,73 

33 90,00 88,70 86,71 74,48 66 90,00 92,93 99,58 114,74 

     A set of random data that represents the orientations of 98 hypothetical cells in an image with different 

extents of alignment was created using the Microsoft Excel (2016) =NORM.INV (probability; mean; 

standard deviation) function with =RAND() as the probability, 90 as the mean and standard deviations 

(SD) equal to 0, 4, 16 or 64.  
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Figure S1: Stages of Image Processing. A) Image Acquisition: myoblasts stained with Fuchsin 

were captured using an Olympus CKX41 microscope and a Motic 3.0 megapixel camera (10x 

objective lens). B) ImageJ Pre-processing: images were processed using ImageJ, representing the 

cells as white and the spaces between them as black. C) ct-FIRE Analysis: cell orientation was 

evaluated using ct-FIRE that inserts coloured lines through the longitudinal axis of a cell, 

signifying the orientation of the cells. 
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Abstract 

Skeletal muscle regeneration is a complex process mediated by both myogenic and non-

myogenic cell populations, including satellite cells, macrophages and fibroblasts.  

Dysregulated communication between these cell types can result in conditions such as 

impaired wound repair or fibrosis. In our previous studies, we evaluated the direct roles of 

macrophages and fibroblasts on myogenesis; in the current study, we sought to better 

understand the intercellular communication between macrophage and fibroblast populations. 

Macrophages and fibroblasts can acquire different phenotypes in response to changing 

experimental conditions; serum stimulates the differentiation of fibroblasts into 

myofibroblasts, while lipopolysaccharide stimulates the polarisation of M0 macrophages to 

acquire a M1 pro-inflammatory phenotype. We characterized these phenotypes using 

morphology (with circularity as a shape descriptor) as well as the expression of either α-

smooth muscle actin (SMA) or CD86. Myofibroblasts were characterised by high circularity 

(corresponding to a round morphology) and high levels of α-SMA expression; de-

differentiation to fibroblasts resulted in a lower circularity and decreased levels of α-SMA. 

When unstimulated (M0) macrophages were activated with LPS, there was a decrease in 

circularity and increased CD86 expression, indicative of a M1 macrophage population. 

Utilising these established conditions, we then co-cultured M1 macrophages with 

myofibroblasts and myoblasts; we found that M1 macrophages decreased myofibroblast, but 

not myoblast number. We subsequently evaluated the mechanism whereby M1 macrophages 

mediated this decrease in myofibroblast numbers and found that LY294002 and 

dexamethasone rescued myofibroblasts. LY294002 was also observed to decrease 

macrophage cell number, suggesting a mechanism whereby myofibroblasts were rescued. 

Dexamethasone, on the other hand, increased the circularity of the myofibroblast population, 

suggesting a decrease in the number of remaining fibroblasts within the population. In 

conclusion, macrophages and fibroblasts regulate myogenesis, but the phenotypes these cells 

acquire are also important. M1 macrophages have a detrimental effect on the population of 

fibroblasts; since fibroblasts have previously been shown to regulate muscle cell behaviour 

and promote myoblast migration and fusion, detrimental effects on fibroblasts would 

negatively impact myogenesis.   

 

Keywords: skeletal muscle, macrophages, fibroblasts, phenotypes, LY294002, 

dexamethasone 
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Introduction 

Skeletal muscle repair involves the differentiation and fusion of muscle stem cells (myoblasts) 

into regenerated muscle fibres. This process, known as myogenesis, is regulated by non-

myogenic cells, such as macrophages and fibroblasts [1]. Macrophages are present during the 

early stages of wound repair and acquire a pro-inflammatory (M1) phenotype to produce 

factors (such as tumour necrosis factor (TNF)-α and nitric oxide (NO)) which activate 

myogenic satellite cells to myoblasts. M1 macrophages then stimulate the expansion of 

myoblasts by promoting their proliferation and inhibiting apoptosis [2-4]. As wound repair 

progresses, macrophages acquire an anti-inflammatory (M2) phenotype to secrete factors 

(such as interleukin (IL)-10) which attenuate the initial pro-inflammatory response and 

stimulate myoblast differentiation and fusion [4-6]. Anti-inflammatory macrophages 

additionally secrete pro-fibrotic factors (such as transforming growth factor (TGF)-β) to 

activate fibroblasts to differentiate into an intermediate proto-myofibroblast phenotype 

(absent of any contractile apparatus) before fully differentiating into contractile 

myofibroblasts [6-8]. Myofibroblasts are primarily responsible for depositing matrix factors 

(e.g. collagen I) to re-establish the extracellular matrix (ECM) surrounding healing muscle 

fibres, but also secrete soluble factors (e.g. fibroblast growth factor (FGF)-2) which regulate 

muscle regeneration [9,10]. Despite these distinct fibroblast populations, in vitro studies often 

do not actively distinguish between them. 

 

Muscle regeneration during wound repair is a highly regulated process and effective 

reparation hinges on the proper communication within the myogenic and non-myogenic cell 

populations [11,12]. Aberrant wound repair can occur when certain non-myogenic cell 

populations and accompanied secreted factors persist without resolution [12]. 

Pathophysiological fibrosis occurs in response to a persistent M2 macrophage population, 

creating a sustained anti-inflammatory and pro-fibrotic environment; this leads to a persistent 

population of myofibroblasts and an excessive accumulation of matrix factors that ultimately 

impair muscle healing [11,12]. Other muscle diseases, such as muscular dystrophy and 

myositis, are characterized by muscle weakness and recurring muscle regeneration and often 

accompanied by an upregulated pro-inflammatory microenvironment mediated by 

inflammatory cells (e.g. T cells and macrophages) and certain cytokines (e.g. TNF-α and 

interferon (IFN)-γ) [12-14]. However, the effect of this pathological microenvironment on 

myofibroblast populations, and the implication on skeletal muscle wound repair, is unclear.  
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Intercellular communication between non-myogenic cells regulates myogenic cellular 

behaviours, such as proliferation, migration and apoptosis [15]. Signalling typically starts 

with an external stimulus (biomechanical or biochemical) which acts on cells to activate 

intracellular signalling pathways (e.g. phosphatidylinositol 3-kinase (PI3K), nuclear factor 

(NF)-κB and mitogen-activated protein kinase (MAPK) pathways) and ultimately control 

gene expression and regulate cell behaviour [16]. It is important to elucidate these signalling 

pathways involved in intercellular communication to understand which pathways can be 

targeted to effectively mitigate muscle diseases associated with aberrant non-myogenic cell 

communication [17,18]. Macrophages initially become activated by a pro-inflammatory 

stimulus (e.g. T-helper (Th) 1 cell-secreted IFN-γ), which leads to the production of 

inflammatory proteins (e.g. TNF-α, IL-6, cyclooxygenase (COX)-2 and inducible nitric oxide 

synthase (iNOS)) [19,20]. Pro-inflammatory macrophages have been shown to regulate 

fibroblast population behaviour in a paracrine manner to favour inflammation by upregulating 

expression of pro-inflammatory genes (e.g. IL-6 and chemokine (C-C motif) ligand 2 

(CCL2)) [21]. Furthermore, M1 macrophages favour matrix degradation by increasing 

fibroblast production of matrix metalloproteinases (MMPs) and decreasing the production of 

collagen I and III; this negatively affects tissue architecture and is characteristic of non-

healing wounds [21]. It is apparent that M1 macrophages regulate the behaviour of fibroblasts 

via the action of signalling pathways; pharmacological inhibitors are important tools to 

evaluate these signalling systems (Table 1). 
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Table 6: Summary of the effects of inhibitors on M1 macrophages.  

 

Inhibitor Pathway Effect Reference 

L-NAME iNOS/NO ↓ NO levels [33] 

Indomethacin COX-2/PGE2 ↓ PGE2 levels [34] 

LY294002 PI3K 
↓ iNOS expression 
↓ TNF-α levels 
↓ TNF-α & IL-6 levels 

[35] 
[36] 
[37] 

SB203580 p38 MAPK 
↓ COX-2 & iNOS expression 
↓ IL-1β  
↑ & ↓ TNF-α & IL-6 expression 

[35] 
[38] 

[38, 39] 

SP600125 JNK 
↓ iNOS expression 
↓ COX-2  

[35] 
[40] 

Dexamethasone Unknown 
↓ iNOS expression 
↓ TNF-α expression 

[41] 
[42] 

Pathway and effect of L-NAME, indomethacin, LY294002, SB203580, SP600125 and dexamethasone 

on macrophages.  

 

Fibroblasts and macrophages are therefore essential for muscle regeneration [22,23]. We have 

previously investigated the roles of these cell populations on myoblast behaviour [24,25]. We 

found that fibroblasts promote myoblast migration and fusion, but the addition of 

macrophages abrogated the pro-migratory effects of fibroblasts on myoblasts; we 

hypothesized that this may be as a result of a decrease in fibroblast numbers [24]. However, 

the macrophages were unstimulated and the phenotype of the fibroblast population was 

uncertain. Given that these non-myogenic cells can exists in various states, we first sought to 

establish and characterize the population of macrophages (in response to LPS) and fibroblasts 

(in response to serum) and then to expand on our initial studies and investigate the mechanism 

by which these cells regulate the in vitro muscle regenerative environment.  

Methods 

Reagents 

Lipopolysaccharide (LPS; 1 mg/ml; Capital Lab Supplies, cat. L4391) and L-NAME (200 

mM; BioVision, cat. 2356) were prepared in distilled water. Dexamethasone (100 mM; 

Sigma, cat. D1756), indomethacin (100 mM; Sigma, cat. I7378), SB203580 (10 mM; Santa 

Cruz, cat. SC-3533), LY294002 (10 mM; Santa Cruz, cat. SC-201426) and SP600125 (100 



83 

mM; Santa Cruz, cat. SC-200635) were prepared in DMSO (Sigma, cat. D2650). Fuchsine 

(1% w/v; Capital Lab Supplies, cat. 47860) was dissolved in 100% methanol. Serum-free 

medium (SFM) was prepared by supplementing Dulbecco’s Modified Eagle’s Medium 

(DMEM, Capital Lab Supplies, cat. D5648) with 2% (v/v) Penicillin-Streptomycin (PenStrep, 

LONZA, cat. DE17-602E). Serum-containing medium (SCM) was prepared by 

supplementing SFM with 2% (v/v) or 10% (v/v) Fetal Bovine Serum (FBS, Gibco, cat. 

10500).  

Cell Culture 

Mouse C2C12 myoblasts (ATCC, USA, cat. CRL-1772™; passage 10-20), LMTK fibroblasts 

(ATCC, USA, cat. CCL-1.3™; passage 6-25) and J774A.1 macrophages (ATCC, USA, cat. 

TIB-67™; passage 60-90) were cultured at 37°C and 5% CO2 and maintained in 10% SCM. 

Media was changed every 48 hours.  

 

Mono-culture proliferation/morphology studies were performed by seeding macrophages (40 

x 103) or fibroblasts (30 x 103) into 24-well culture plates in 10% SCM (500 µl) and incubated 

for 2 hours to promote adherence. Co-cultures were performed as previously described [24]: 

macrophages (0 or 40 x 103) were first plated on the outer edge of a 24-well plate in 10% 

SCM and incubated for 1 hour; fibroblasts (30 x 103) or myoblasts (5 or 20 x 103) were then 

plated in the centre of the well and incubated for 2 hours. Adherent mono- and co-cultures 

were washed twice with sterile PBS (500 µl) and treated as described below.  

Cell Treatments 

For proliferation/morphology studies, mono-cultures of macrophages and fibroblasts were 

either treated with different concentrations of SCM (0, 2 and 10%; 500 µl) or LPS (0 and 0.1 

µg/ml; 500 µl) in 2% SCM for 24 hours. To evaluate the effect of M1 macrophages on 

fibroblasts and myoblasts, mono-cultures of myofibroblasts/myoblasts (negative controls) and 

co-cultures of these cells with macrophages were treated with LPS (0.1 µg/ml) in 2% SCM 

for 24 hours where indicated. To evaluate DMSO cytotoxicity, mono-cultures and co-cultures 

(pre-treated with LPS) of macrophages with myofibroblasts were cultured with different 

dilutions of DMSO (0, 1:1000 and 1:10000) in 2% SCM. To evaluate the effect of various 

drugs and inhibitors on macrophage-mediated myofibroblast death, mono-cultures of 

macrophages or co-cultures of macrophages with myofibroblasts were treated with an 
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inhibitor in 2% SCM before (30 mins), with (1 hour) and after (24 hours) LPS pre-treatment 

where indicated. Cells were washed twice with sterile PBS after LPS pre-treatment.  

Morphology Analysis 

Cells were briefly washed with PBS and stained with 1% Fuchsine (10 mins), submerged in 

water to remove the stain and left to dry. Cells were visualized and captured with an Olympus 

CKX41 microscope and a Motic 3.0 megapixel camera (10x objective lens; 5 fields of view 

per replicate for two replicates per experiment). Morphology was quantitively analysed by 

assessing cell circularity (circularity = 4π x ([Area]/ [Perimeter]2) in ImageJ. ImageJ was first 

set to include circularity analysis (Analyze → Set Measurements; check Shape descriptors). 

Images were first converted to 8-bit (Image →Type → 8-bit), converted to a binary image 

(Process → Binary → Make Binary) and analysed (Analyze → Analyze Particles). The size 

was set between 100-800 pixels to limit background and excluded touching cells that 

prevented accurate analysis. The result was a value between 0 and 1 which indicated cells that 

are irregularly shaped or perfectly circular, respectively.  

Proliferation Analysis 

Proliferation studies were analysed as previously described [26]. Images of stained cells (4x 

objective lens; 5 randomly selected fields of view per replicate for two replicates per 

experiment) were automatically identified using ImageJ by converting the captured image to 

grayscale (Image → Type → 8-bit), removing the image noise (Process → Noise → 

Despeckle), adjusting the brightness and contrast (Image → Adjust → Brightness/Contrast: 

min = 87; max = 167) and finally applying first a Phansalkar threshold (Image → Adjust → 

Auto Local Threshold: Phansalkar), and then a watershed (Process → Binary → Watershed). 

The identified cells were then automatically quantified (Analyze → Analyze Particles).  

Confocal Microscopy 

Myofibroblasts (30 x 103) were plated in 24-well plates on top of glass coverslips in 10% 

SCM for 3 hours, washed twice with PBS and switched to 0, 2 and 10% SCM for 24 and 72 

hours. Macrophages (40 x 103) were similarly plated in 2% SCM with or without 0.1 µg/ml 

LPS for 24 hours. The media was then removed, the cells fixed with 4% paraformaldehyde 

(10 mins), permeabilized with 0.3% Triton-X100 (Sigma, cat. X100) (10 mins), blocked with 

5% donkey serum (Sigma, cat. D9663) for 30 mins at room temperature. The (myo)fibroblasts 



85 

were then incubated overnight at 4°C with mouse anti-α-smooth muscle actin (SMA; 1:1000; 

Sigma, cat. A2547), washed with PBS (3 x 5 mins) and incubated at room temperature (1 

hour) in the dark with Dylight594-conjugated donkey anti-mouse antibody (1:1000; Jackson 

ImmunoResearch, cat. 715-515-151). Macrophages were incubated with PE-conjugated rat 

anti-CD86 (1:200; BioLegend, cat. 105008) overnight at 4°C. Hoescht (1:100; 10 mg/ml; 

Sigma, cat. B2261) was subsequently added for 10 mins and the coverslips washed with PBS 

(6 x 5 mins) and mounted on glass slides with Mowiol (Sigma, cat. 81381). The cells were 

viewed with a Zeiss 710 confocal microscope (Carl Zeiss GmbH, Oberkocken, Germany). 

Statistical Analysis 

Data was determined to be normally distributed; all results were analysed using a one-way 

ANOVA with post-hoc tests in GraphPad Prism 8 and values of p < 0.05 were considered to 

be statistically significant compared to the control. All data was represented as mean ± SEM. 

Results 

Phenotypic characterization of macrophages and fibroblast populations 

Fibroblasts have been shown to differentiate into myofibroblasts in the presence of serum 

and/or TGF-β; differentiation is thought to be reversible [27-29]. LMTK cells were 

subsequently cultured in 0, 2 and 10% SCM for 24 hours and phenotypes characterised based 

on morphology and α-SMA (Figure 1). Cells cultured in media containing 0% serum acquired 

an elongated, thin morphology compared to those maintained in 10% SCM, which were 

clustered with thick, rounded shapes (Figure 1Ai); cells switched to 2% SCM had an 

intermediate morphology. Circularity was assessed to quantify these changes in morphology 

(Figure 1Aii). Cells maintained in 10% SCM had a peak frequency of circularity at 0.60-0.69.  

In response to 2% SCM, the peak frequency shifted cells to a circularity of 0.30-0.39, while 

0% serum shifted the population further where the peak frequency of circularity was observed 

at 0.20-0.29. The average cell circularity for each serum concentration was determined to be 

0.60 ± 0.03 (10% SCM), which decreased significantly (p < 0.05) to 0.47 ± 0.01 in response 

to 2% SCM and further decreased to 0.35 ± 0.02 when cultured in 0% SCM (Figure 1Aiii). 

Macrophages were also cultured in the presence of different concentrations of SCM to 

determine any changes in morphology (Figure 1Aiv): only a small but significant decrease (p 

< 0.05) was observed from 0.72 ± 0.02 to 0.63 ± 0.01 when the medium was changed from 
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10% to 0% SCM; cells cultured in 2% SCM had an average circularity of 0.69 ± 0.03, but this 

change was not significant when compared with circularity under low or high serum levels. 

Circularity data also shows that macrophages are, in general, rounder cells than both 

fibroblasts and myofibroblasts. Confocal microscopy was used to evaluate changes in α-SMA 

expression of the fibroblast population following incubation in SCM (0, 2 and 10%) (Figure 

1B). Although myofibroblasts cultured in media containing either 0% or 2% serum still 

expressed α-SMA, the level of expression appeared lower at 72 h, when compared to those 

cells culture in the presence of 10% serum. In addition, cells cultured under low serum 

conditions morphologically displayed longer, thinner shapes, whereas those culture in the 

presence of 10% serum were much rounder. We therefore concluded that under 0% serum, 

fibroblasts are present with low α-SMA expression and a low circularity; in response to 2% 

and 10% serum, these cells differentiate into myofibroblasts with increased α-SMA 

expression and a high circularity. 
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Macrophages were cultured with LPS to establish a M1 phenotype which was then 

characterized based on morphology and CD86 expression (Figure 2). Macrophages cultured 

in the absence of LPS were small with a very round morphology, while the cells cultured in 

the presence of LPS also had a round shape, but several cells acquired long bipolar 

protrusions (Figure 2i). The average circularity of macrophages was calculated (Figure 2ii): 

macrophage circularity in the absence of LPS was 0.72 ± 0.02 and this significantly decreased 

(p < 0.05) to 0.61 ± 0.02 when treated with LPS. The circularity of the fibroblast population 

in response to LPS in 2% SCM was also assessed (Figure 2iii). These cells displayed an 

average circularity of 0.37 ± 0.01 which very slightly, but significantly (p < 0.05), decreased 

to 0.34 ± 0.01 in response to LPS. Furthermore, macrophages stimulated with LPS in 2% 

SCM displayed a notable increase in CD86 expression compared to unstimulated cells (Figure 

2iv). 

 

Figure 1: Characterization of fibroblast and macrophage population phenotypes in different 

concentrations of serum-containing medium (SCM). (A) Morphological analysis of cells 

maintained in 0, 2 and 10% SCM showing (i) Fuchsine-stained (myo)fibroblasts, (ii) frequency 

distribution of (myo)fibroblasts, and the average circularity of (iii) (myo)fibroblasts and (iv) 

macrophages. (B) Confocal microscopy of (myo)fibroblasts immunostained with mouse anti-α-

SMA (red) maintained in different concentrations of SCM for 24 and 72 hours. Hoeschst was used 

as a nuclear stain (blue). Images were captured using an Olympus CKX41 microscope coupled to a 

Motic 3.0 megapixel camera (4x objective lens; scale bar = 200 µm) and a Zeiss 710 confocal 

microscope (25x objective lens; scale bar = 50 µm). * = p < 0.05; N = 7 ((myo)fibroblasts) and 4 

(macrophages). 
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Figure 2: Characterization of macrophages and myofibroblasts in the presence of 

lipopolysaccharide (LPS). Morphological analysis of cells maintained in 2% SCM with and 

without LPS (0.1 µg/ml) showing (i) Fuchsine-stained macrophages and the average circularity of 

(ii) macrophages and (iii) myofibroblasts. (iv) Confocal microscopy of macrophages 

immunostained with rat anti-CD86 (red) treated with LPS for 24 hours.  Hoeschst was used as a 

nuclear stain (blue). Images were captured using an Olympus CKX41 microscope coupled to a 

Motic 3.0 megapixel camera (10x objective lens; scale bar = 200 µm) and a Zeiss 710 confocal 

microscope (25x objective lens; scale bar = 50 µm). * = p < 0.05; N = 6 (macrophages and 

myofibroblasts). 
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Pro-inflammatory macrophages result in myofibroblast, but not myoblast, cell death 

Macrophages were then co-cultured with myofibroblasts or myoblasts in the presence of LPS 

to determine the effect of a pro-inflammatory environment on myofibroblast and myoblast 

proliferation (Figure 3). Myofibroblasts alone (Mϕ-LPS-) (Figure 3i, ii) were present with a 

relative cell number of 230 ± 23% which was not significantly different from 232 ± 27% and 

223 ± 22% when the cells were cultured in the presence of M0 macrophages (Mϕ+LPS-) or 

LPS (Mϕ-LPS+) respectively. However, co-culture with M1 macrophages (Mϕ+LPS+) caused 

a significant decrease (p < 0.05) in myofibroblast numbers to 64 ± 7% which was below the 

number of cells originally plated (i.e. 100%). Myoblasts alone (Mϕ-LPS-) (Figure 3iii) were 

present with a relative cell number of 306 ± 63% and displayed no significant change 

compared to 325 ± 78% and 323 ± 95% when the cells were cultured in the presence of M0 

macrophages (Mϕ+LPS-) or LPS (Mϕ-LPS+), respectively. Furthermore, myoblasts cultured in 

the presence of M1 macrophages (Mϕ+LPS+) were present with a relative cell number of 297 

± 68% which was also not significantly different compared to myoblasts cultured with LPS 

alone. M0 macrophages (Mϕ+LPS-) (Figure S1) continued to significantly increase (p < 0.05) 

relative myoblasts numbers in SFM from 141 ± 4% to 220 ± 15% in the presence of M0 

macrophages (Mϕ+LPS-) as previously shown [24]. Myoblasts maintained in the presence of 

LPS (Mϕ-LPS+) and were present with relative cell numbers of 145 ± 6% which was not 

significantly different compared to the control. Co-culture with M1 macrophages (Mϕ+LPS+) 

also significantly increased relative myoblast numbers to 191 ± 12%, but this was not 

significantly different compared to co-culture with M0 macrophages.  

 



91 

Mechanism of pro-inflammatory macrophage-mediated myofibroblast death 

The mechanism by which M1 macrophages decrease myofibroblast numbers was assessed by 

co-culturing macrophages and myofibroblasts in the presence of LPS and 2% serum in the 

presence or absence of soluble inhibitors (Figure 4). DMSO (at any dilution) showed no 

significant effect on macrophages or myofibroblast numbers and had no significant effect on 

the ability of LPS pre-treated macrophages to decrease myofibroblast cell numbers (Figure 

S2). Myofibroblasts treated with L-NAME, an iNOS inhibitor (Figure 4i) or indomethacin 

(INDO), a COX-2 inhibitor, (Figure 4ii), p38 MAPK inhibitor SB203580 (SB) (Figure 4iii) or 

JNK inhibitor SP600125 (SP) (Figure 4iv) showed no significant ability in rescuing 

myofibroblast cell loss in response to M1 macrophages. However, addition of LY294002 

(LY) to myofibroblasts co-cultured with M1 macrophages significantly (p < 0.05) rescued 

myofibroblast numbers from 156 ± 12% (LY-LPS+) to 219 ± 14% (LY+LPS+) (Figure 4v); 

incubation of myofibroblasts with LY294002 (LY+LPS-) were at relative cell numbers of 236 

± 16% which was not significantly different from 250 ± 16% when the cells were cultured in 

 

Figure 3: The effect of macrophages on myofibroblasts and myoblasts. Cells were cultured with or 

without macrophages (Mϕ; 40 x 103) in 2% SCM with or without LPS (0.1 µg/ml) pre-treatment. (i, ii) 

Fibroblasts and (iii) myoblasts were stained with Fuchsine and the relative cell numbers determined. 

Images were captured using an Olympus CKX41 microscope coupled to a Motic 3.0 megapixel 

camera (10x objective lens; scale bar = 200 µm). * = p < 0.05; N = 6 (myofibroblasts and myoblasts). 
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the absence of LY294002 (LY-LPS-). Finally, myofibroblasts treated with dexamethasone 

alone (Figure 4vi) displayed a small decrease (p = 0.05) from 230 ± 22% (DEX-LPS-) to 188 

± 20% (DEX+LPS-); treating myofibroblasts co-cultured with M1 macrophages in the 

presence of dexamethasone rescued myofibroblast numbers from 136 ± 26% (DEX-LPS+) to 

191 ± 21% (DEX+LPS+). However, this effect was not significant. 

 

 

Figure 4: Evaluating the mechanism of pro-inflammatory macrophage-mediated myofibroblast 

death. Myofibroblasts were co-cultured with macrophages (Mϕ; 40 x 103) with or without LPS (0.1 

µg/ml) with or without the inhibitors (i) L-NAME (200 µM), (ii) indomethacin (INDO; 10 µM), (iii) 

SB203580 (SB; 10 µM), (iv) SP600125 (SP; 10 µM), (v) LY294002 (LY; 10 µM), (vi) 

dexamethasone (DEX; 10 µM) and the relative cell numbers determined. * = p < 0.05; N = 4-7. 
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The effect of the inhibitor LY294002 and glucocorticosteroid dexamethasone on 

myofibroblast morphology in the presence of macrophages and LPS was evaluated (Figure 5). 

LY294002 had no observable (Figure 5i) or quantifiable (Figure 5ii) effects on myofibroblast 

morphology. Dexamethasone, however, caused myofibroblasts to acquire a more rounded 

morphology (Figure 5i); when an average circularity was calculated (Figure 5iii), 

dexamethasone significantly increased (p < 0.05) the average circularity from 0.38 ± 0.01 

(DEX-LPS+) to 0.49 ± 0.003 (DEX+LPS-). Dexamethasone continued to significantly increase 

the average circularity of myofibroblasts from 0.36 ± 0.01 (DEX-LPS+) to 0.50 ± 0.01 

(DEX+LPS+) in the presence of LPS. The effect of LY294002 and dexamethasone on 

macrophage numbers was also evaluated (Figure 5iv, v). M0 and M1 macrophages had 

relative cell numbers of 54 ± 9.6% (LY-LPS-) and 56 ± 6.9% (LY-LPS+), respectively, which 

were not significantly different. However, macrophages cultured in the presence of LY294002 

displayed significant decreases in cell numbers of 16 ± 4.9% (LY+LPS-) and 16 ± 4% 

(LY+LPS+). Dexamethasone, however, had no significant effect on relative macrophage 

numbers (Figure 5v).  
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Figure 5: The effect of LY294002 and dexamethasone on myofibroblasts and macrophages.  

(i-iii) Myofibroblasts were co-cultured with macrophages (40 x 103) with or without LPS (0.1 

µg/ml) pre-treatment and with or without the inhibitors (10 µM) LY294002 and dexamethasone 

and the average circularity determined. (iv, v) Macrophages were pre-treated with LPS and treated 

with or without LY294002 and dexamethasone and the relative cell numbers determined. Images 

were captured using an Olympus CKX41 microscope coupled to a Motic 3.0 megapixel camera 

(4x objective lens; scale bar = 200 µm). * = p < 0.05; N = 4. 
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Discussion 

Diseases such as muscular dystrophy and myositis are often characterized by a pro-

inflammatory microenvironment, but it is unclear what the effect is on the population of 

fibroblasts [12]. Pro-inflammatory macrophages have been shown to inhibit myoblast fusion; 

at low numbers, fibroblasts promote myoblast fusion, while at higher numbers they decrease 

this stage of terminal differentiation [6,25,30,31]. However, it is unclear what effect M1 

macrophages have on the population of fibroblasts and what the subsequent implication on 

muscle wound repair would be [25]. We therefore sought to investigate the effect of M1 

macrophages on the population of fibroblasts in experimental conditions that would promote 

myoblast differentiation and fusion in vitro (i.e. low serum).  

 

Fibroblasts and macrophages can acquire different phenotypes and morphologies depending 

on the in vivo microenvironment or in vitro experimental conditions [21,32]. Studies often 

distinguish between M1 and M2 macrophages, but often make no such distinction between 

fibroblasts and myofibroblasts. Rapid assessment and quantification of cell shapes may be a 

useful tool to evaluate the effect of experimental conditions on the cells. Previous studies have 

shown that fibroblasts cultured in SFM in vitro can differentiate into myofibroblasts with the 

addition of TGF-β and/or serum [27,28]. Furthermore, fibroblasts first acquire a proto-

myofibroblast phenotype before fully differentiating into myofibroblasts, and differentiation 

is reversible [8,29,32]. We therefore first sought to establish and characterize the different 

populations in our experimental model. We observed that myofibroblasts maintained in 10% 

SCM had a short and wide morphology and were consistently positive for high levels of α-

SMA expression; these cells dedifferentiated to fibroblasts when the media was switched to 

0% SCM (i.e. SFM) as evidenced by a decrease in α-SMA expression with a long and narrow 

morphology. Furthermore, we observed an intermediate morphology that also expressed low 

levels of α-SMA in response to 2% SCM; this is characteristic of the proto-myofibroblasts 

phenotype of myofibroblasts [8]. We then sought to rapidly and quantitatively assess 

morphology using circularity as a cell shape descriptor and found that myofibroblasts were 

the most circular and elongate as they acquire a fibroblast phenotype. Therefore, assessing 

circularity using image processing software, such as ImageJ, could be used to quantifiably 

describe cell shape and distinguish between these morphologies.  
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The plasticity of macrophages was further investigated in an in vitro muscle regenerative 

microenvironment by establishing a population of M1 macrophages in 2% SCM. We 

observed that macrophages displayed a high circularity, but when M0 macrophages 

(expressing low levels of CD86) were stimulated with LPS to yield M1 macrophages 

(expressing high levels of CD86), the cells acquired elongated protrusions with slightly 

decreased circularity.  

 

We have previously shown that M0 macrophages abrogated the pro-migratory effects of 

fibroblasts on myoblasts, but it was unclear how macrophages mediated this effect [24]. We 

sought to determine whether these effects were mediated via a decrease in myofibroblast 

numbers. We observed that the co-culture of M1 macrophages resulted in a significant 

decrease in myofibroblast numbers. This suggests that LPS interacts with macrophages to 

stimulate a pro-inflammatory phenotype which in turn caused myofibroblast death. This M1 

macrophage-induced cell death was specific to myofibroblasts, as the same effect was not 

observed with myoblasts. 

 

We next sought to investigate the mechanism by which M1 macrophages cause a decrease in 

myofibroblast number. Macrophages typically respond to an inflammatory stimulus, such as 

LPS, by upregulating the secretion of an array of pro-inflammatory mediators, such as TNF-α, 

IL-1β, IL-6, iNOS/NO and COX-2/PGE-2; inhibitor studies have shown that these factors 

stimulate pathways such as PI3K, p38 MAPK and JNK (Table 1) [33-42]. Furthermore, some 

of the M1 macrophage-produced soluble factors (e.g. NO, TNF-α and PGE2) have previously 

been shown to induce fibroblast death [43-45]. We therefore sought to screen several 

inhibitors to determine the pathways they targeted were responsible for the rescue of 

myofibroblast numbers when co-cultured with M1 macrophages. We showed that 

myofibroblast death was not mediated by iNOS/NO, COX-2/PGE, p38 MAPK or JNK, but 

that PI3K was involved. Furthermore, we showed that dexamethasone was also able to rescue 

myofibroblast numbers despite causing a decrease in numbers on its own; this glucocorticoid 

is known to inhibit fibroblast proliferation [46]. We further found that LY294002 potentially 

does not directly act on myofibroblasts since there was no observable effect on myofibroblast 

numbers or morphology. However, LY294002 decreased macrophage cell number; this 

suggests that LY294002 rescues myofibroblast numbers by decreasing M0 and/or M1 

macrophage numbers. The PI3K/Akt pathway is an important cell survival pathway in 



97 

macrophages and inhibition via LY294002 has previously resulted in macrophage death [47]. 

In contrast to LY294002, dexamethasone had no effect on macrophages, but caused the 

myofibroblasts to acquire a more rounded morphology. Previous studies have shown that 

dexamethasone confers protection to fibroblasts against TNF-α-induced cytotoxicity by 

activating NF-κB to promote cell survival [48]. Furthermore, dexamethasone has been shown 

to exhibit pro-fibrotic effects by augmenting TGF-β-induced α-SMA expression in 

myofibroblasts [49].  

Conclusion  

We have successfully established and characterized the different phenotypes that fibroblasts 

and macrophages acquire in response to different in vitro experimental conditions. In the 

absence of serum, elongated fibroblasts had a low circularity and decreased α-SMA 

expression; with increasing serum concentration, these cells differentiated into myofibroblasts 

with high circularity and increased α-SMA expression. Unstimulated macrophages had a high 

circularity and low CD86 expression; when these cells were stimulated with LPS to acquire a 

M1 phenotype, they displayed increased CD86 expression and a decreased circularity. We 

then used our previously established co-culture method to evaluate the effect of M1 

macrophages on myofibroblast and myoblast cell numbers; we found that M1 macrophages 

resulted in myofibroblast, but not myoblast, cell death. The addition of LY294002 could 

rescue myofibroblast cell numbers: LY294002 prevented myofibroblast cell death by causing 

a decrease in macrophage numbers; dexamethasone may confer protection by affecting 

myofibroblast morphology, but the effect on myofibroblast proliferation was not significant. 

Altogether, these findings highlight the ability of macrophages and fibroblasts to acquire 

different functional phenotypes depending on the experimental conditions. Importantly, these 

phenotypes have differential effects on myoblasts during stages of wound repair. The 

detrimental effect of M1 macrophages on myofibroblasts would negatively affect myogenesis 

since myofibroblasts are important for promoting myoblast migration and fusion.  
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 Supplementary Information 

 

Figure S1: The effect of macrophages on myoblasts. Cells were cultured with or without 

macrophages (Mϕ; 40 x 103) in SFM with or without LPS (0.1 µg/ml) for 24 hours and the relative 

cell numbers determined. * = p < 0.05; N = 4. 
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Figure S2: The effect of DMSO on myofibroblasts and macrophages. (i) Myofibroblasts, (ii) 

macrophages and (iii) myofibroblasts cultured with macrophages (pre-treated with 0.1 µg/ml LPS) 

were treated with DMSO (1:1000 and 1:10 000) in 2% SCM for 24 hours and the relative cell 

numbers determined. * = p < 0.05; N = 4. 
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CHAPTER 7: CONCLUSIONS AND RECOMMENDATIONS FOR FURTHER 

RESEARCH 

Myogenesis during wound repair involves the activation of satellite cells to myoblasts, which 

proliferate, migrate into the wound and subsequently align and fuse into myofibres; this 

process is regulated by non-myogenic cells, such as macrophages and fibroblasts. Studying 

myogenesis in vitro is dependent on the establishment of muscle models and the assessment 

of cellular behaviours in response to various experimental conditions. In this thesis, we have 

developed an in vitro co-culture model and analysis tools to investigate muscle regeneration. 

Our novel co-culture technique, which is simpler and faster to establish than previously used 

co-culture techniques, also enabled co-culture of at least three different cell types with no 

physical separation and permitted an array of cellular interactions that would occur in vivo, 

including direct cell-cell contact. We successfully optimized ImageJ (image analysis 

software) to identify and quantify both cell number and wound area to assess proliferation and 

migration, respectively. These methods were faster and more accurate to perform than manual 

analysis and conventionally used methods. We also optimized the program ct-FIRE to 

determine the orientation of cells and quantify alignment using an alignment index; this 

method of alignment analysis was accurate and simpler to perform compared to previously 

developed methods. Lastly, we used ImageJ’s circularity feature as a tool to quantitively 

describe and assess changes in cellular morphology. Altogether, these methods were applied 

to investigate the effect of non-myogenic cells on myogenesis as well as communication 

between the non-myogenic cells.  

 

We first used our novel co-culture model and optimized analysis tools to understand the 

effects of increasing macrophage and/or fibroblast numbers on the early (proliferation and 

migration) and late (alignment and fusion) stages of myogenesis. We observed that 

macrophages promoted the proliferation of myoblasts in a cell density-dependent manner (5 

to 80 x 103 cells); low macrophage numbers (5 to 40 x 103 cells) had no effect on myoblast 

migration while high macrophage numbers (80 x 103 cells) promoted migration. We observed 

that low fibroblast numbers (20 x 103 cells) promoted myoblast proliferation, but this effect 

was lost when cell numbers were increased further (40 to 80 x 103 cells). Additionally, 

fibroblasts promoted myoblast migration in a cell density-dependent manner (5 to 80 x 103 

cells). When both macrophages (40 x 103 cells) and fibroblasts (40 x 103 cells) were co-
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cultured with myoblasts (i.e. triple co-culture), we observed that myoblast proliferation 

continued to be promoted by macrophages, but the positive effect of fibroblasts on myoblast 

migration was abrogated in the presence of macrophages. We also observed that macrophages 

(5 to 80 x 103 cells) promoted alignment, but inhibited fusion, in a cell density-dependent 

manner. Fibroblasts, on the other hand, had no significant effect on myoblast alignment but 

could promote (5 to 10 x 103 cells) and inhibit (20 to x 103 cells) fusion. In triple co-culture, 

macrophages (40 x 103 cells) continued to promote myoblast alignment and inhibit fusion in 

the presence of fibroblasts (40 x 103 cells).  

 

We initially did not stimulate the macrophages or fibroblasts to acquire specific phenotypes; 

phenotypic changes may have occurred, however, in response to co-culture conditions. 

Furthermore, we did not distinguish between the fibroblast and myofibroblast phenotypes in 

our initial studies, which were performed in serum-free or serum-containing media. We next 

expanded on our initial studies by intentionally stimulating macrophages to acquire a pro-

inflammatory phenotype and myofibroblasts to de-differentiate from fibroblasts. We 

characterized the phenotypes of these non-myogenic cells using circularity to quantitively 

assess changes in morphology and confocal microscopy to assess the expression of specific 

markers (i.e. α-SMA for myofibroblasts and CD86 for M1 macrophages). We found that 

myofibroblasts had a greater circularity (corresponding with a rounded morphology) and 

higher levels of α-SMA expression; fibroblasts had a lower circularity (corresponding with an 

elongated morphology) and decreased α-SMA expression. Unstimulated macrophages had a 

higher circularity and low CD86 expression; M1 macrophages had a lower circularity with 

increased levels of CD86.  

 

Our initial results indicated a potential for macrophages to negatively affect fibroblasts and 

their pro-migratory effect on myoblasts. We expanded on this and found that macrophages 

stimulated to an M1 phenotype specifically resulted in a decrease on myofibroblast numbers 

with no negative effects on myoblast numbers. We investigated the mechanism of M1 

macrophage-mediated decrease in myofibroblast numbers and found that the iNOS/NO, 

COX-2/PGE2, p38 MAPK and JNK pathways were not involved. However, the PI3K 

inhibitor LY294002 prevented myofibroblast death by M1 macrophages. Furthermore, we 

showed that LY294002 prevented myofibroblast death by decreasing macrophage numbers. 

Dexamethasone, on the other hand, directly interacted with myofibroblasts to increase cell 

circularity, but the implications of this require further investigation.  
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The findings in this thesis provided novel insights into the involvement of macrophages and 

fibroblasts during the early and late stages of wound repair. The number of cells in co-culture 

represented either the expansion (low to high cell numbers) or resolution (high to low cell 

numbers) of non-myogenic cells as would be observed during the progression of muscle 

wound repair in vivo. We showed that it is important for macrophages to increase in number 

upon muscle injury to promote myoblast proliferation. The population of macrophages needs 

to subsequently subside to enable recruited fibroblasts to promote myoblast migration into the 

wound. However, it is important that macrophages do not completely resolve during the later 

stages of wound repair to promote myoblast alignment prior to fusion. Fibroblasts are also 

required to incompletely resolve to promote myoblast fusion. Furthermore, these non-

myogenic cells displayed cell density-dependent, and even opposing effects, on myogenesis. 

This highlights an important consideration when studying myogenesis using in vitro co-

culture models since most co-culture studies focus on evaluating a set number of cells in co-

culture rather than distinct ratios. It is difficult to accurately associate the cell numbers used in 

vitro with the cell numbers that are present in vivo. Therefore, cell type ratios present during 

in vivo wound repair require investigation to design wound repair strategies that carefully 

regulate the timely expansion and resolution of non-myogenic cells. 

 

Our findings also showed that macrophages with a pro-inflammatory phenotype are 

detrimental to the population of fibroblasts; this would result in aberrant wound repair since 

the fibroblast population is important for promoting myoblast fusion. The phenotypes that 

macrophages acquire and their timely transition from the M1 to M2 phenotype during wound 

repair is therefore important. Furthermore, M1 macrophage-mediated death of myofibroblasts 

was prevented by inhibiting the PI3K signalling pathway; this resulted in macrophage, but not 

myofibroblast, death. Therefore, the PI3K pathway is a potential therapeutic target to treat 

aberrant muscle wound repair in diseases, such as myositis, that is caused by the dysregulated 

presence of macrophages.  

 

We primarily investigated the effect of the presence of macrophages and/or fibroblasts on 

myoblast behaviour, but not the mechanism of communication. Our co-culture technique 

permitted an array of cellular interactions between cell types (i.e. cell-cell, cell-soluble factor 

and cell-matrix factor), but we did not identify the exact mediators of communication. 

Therefore, future studies would be aimed at identifying these and determining if direct cell-
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cell contact with macrophages and fibroblasts modulates myoblast behaviour by comparing 

the effects of direct contact vs. secreted factors. In this study, conditioned media from the 

non-myogenic cells would be collected and serially diluted to represent different cell 

numbers. Investigating changes in mRNA/protein levels of signalling molecules could also 

shed light on how non-myogenic cells influence myogenesis. However, analysing specific 

changes in signalling molecules would be a challenge using our co-culture method; analysis 

would need to be microscopy-based.  

 

We have demonstrated that non-myogenic cells have different effects on myogenesis 

depending on their cell density. Future studies would be aimed at determining the optimal 

ratio of non-myogenic cells to promote myoblast behaviour. We previously showed that 40 x 

103 macrophages promoted myoblast alignment while 5 x 103 fibroblast promoted fusion; a 

future study would use these cell numbers in triple co-culture to promote myoblast alignment 

and fusion. Myogenesis in vivo could also be mimicked in vitro by timeously adding and 

removing non-myogenic cells (to represent their expansion and subsequent resolution in the 

wound), as well as stimulating them to acquire specific phenotypes, as myoblasts proliferate, 

migrate, align and fuse into myotubes.  

 

Although we limited our study to macrophages and fibroblasts, other non-myogenic cells 

(such as endothelial cells) are involved in muscle wound repair and should be evaluated for 

their role in regulating myogenesis. This can be done in the future by using our co-culture 

system to include four or more cell types. We also stimulated macrophages to acquire an M1 

phenotype and investigated the effect on fibroblasts; however, we have yet to evaluate the 

effect of M2 macrophages on fibroblasts. Furthermore, our study was limited to murine cell 

lines and future studies should be aimed at determining if similar results are obtained with 

more clinically relevant primary human cells. 
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APPENDIX A: PROTOCOL FOR: RAPID QUANTIFICATION OF 

CELLULAR PROLIFERATION AND MIGRATION USING IMAGEJ 

Protocol Title: Quantification of Adherent Cell Proliferation and Migration Using 

ImageJ 

Reagents 

1. Dulbecco’s Modified Eagle’s Medium (DMEM; Sigma, St Louis, MO, USA) 

2. Fetal bovine serum (FBS; Biowest, Riverside, MO, USA) 

3. Penicillin/Streptomycin (PenStrep; Lonza, Basel, Switzerland) 

4. Phosphate buffered saline (PBS; Merck, Kenilworth, NJ, USA) 

5. T75 culture flasks, 12- and 24-well plates (NEST, Wuxi, China) 

6. Trypsin-EDTA (Trypsin, Lonza, Basel, Switzerland) 

7. Methanol (Radchem, Orland Park, IL, USA) 

8. Crystal Violet (Sigma, St Louis, MO, USA) 

Recipes  

1. Growth Media (GM): Supplement DMEM with FBS (10%) and PenStrep (2%) 

2. Crystal Violet Stain: Add 0.2% (m/v) crystal violet powder to 100% methanol 

Equipment 

1. Innova® CO-170 CO2-incubator (New Brunswick, USA) 

2. Olympus CKX41 microscope (Olympus, Tokyo, Japan) 

3. Motic 3.0 megapixel camera (Wetzlar, Germany) 

4. Computer (Windows, OS or Linux) 

5. ImageJ (available at https://imagej.nih.gov/ij/) 

Procedure 

Cell Culture  

1. Culture C2C12 myoblasts in a T75 culture flask with GM at 37°C and 5% CO2 until 70% 

confluent. 

https://imagej.nih.gov/ij/
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2. Wash the cells twice with sterile PBS (5 ml), detach with trypsin (2 ml, 10 mins), add GM 

(2 ml) and count the cells. 

Experimentation 

Proliferation:  

3.1. Plate out cells (5 – 20 x 103) into a 24-well plate in GM (500 µl) and incubate (3 hours) 

to promote adherence. 

Attention: The number of cells plated out depends entirely on the researcher’s requirements 

and experimental conditions. Avoid plating out too many cells which cause cell clumps and 

making analysis difficult.  

Hint: Gently swirl and shake the culture plate prior to incubating to ensure even cell 

distribution. 

 

3.2. Change the media to experimental conditions and incubate (24 hours). 

3.3. Remove the media, wash with PBS (500 µl, 5 mins) and stain with crystal violet (500 

µl, 15 mins). 

3.4. Remove the stain, wash the cells be gently submerging the plate in a water bath until all 

the stain is removed and leave to completely dry. 

3.5. Take images of the cells (3-5 fields of view per replicate for 2-3 replicates) using a 

camera-attached brightfield microscope (4x objective lens). 

Migration:  

4.1. Plate out cells (120 x 103) into 12-well plate in GM (1 ml) and incubate (24 hours). 

Attention: The number of cells can be varied but aim to achieve a confluency of 90-100% 

after 24 hours. Plate the cells out into a 12-well and not a 24-well plate to produce wound 

areas that can be accurately identified by ImageJ. 

4.2. Scratch the confluent monolayer with a 200 µl sterile loading tip. 

Attention: Perform the scratch directly in the centre of the well to produce wound areas that 

can be accurately identified by ImageJ. 

Hint: Use a ruler as a brace for the loading tip when performing scratches to generate a 

straight and central wound. 
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4.3. Wash the cells twice with sterile PBS (500 µl), change to experimental media and 

incubate (7 hours). 

4.4. Take images of the wound area at different time points (0, 3, 5 and 7 hours) with a 

camera-attached microscope (4x objective lens). 

ImageJ Processing  

Macro Creation 

5.1. Open ImageJ and navigate to Plugins → New → Macro. 

5.2. In the new window, copy/paste the corresponding code for the following macros. 

5.3. Proliferation Macro: 

//Convert Image to 8-bit 

run("8-bit"); 

//Remove Noise 

run("Despeckle"); 

//Adjust Brightness and Contrast 

setMinAndMax(-87, 167); 

run("Apply LUT"); 

//Apply Phansalkar Local Threshold 

run("Auto Local Threshold...", "method=Phansalkar radius=15 parameter_1=0 

parameter_2=0 white"); 

setAutoThreshold("Default"); 

//Watershed 

run ("Watershed"); 

//Count Objects (i.e. Cells) 

run("Analyze Particles...", "display clear summarize"); 

 

5.4. Migration Macro: 

run("8-bit"); 

run("Find Edges"); 

for (i = 0; i < 37; i++)  

{run("Smooth");} 

setAutoThreshold("MinError"); 

//run("Threshold..."); 

run("Analyze Particles...", "size=10000-Infinity show=Outlines display"); 

 

5.5. Migration Image Processing Macro: 

run("8-bit"); 

run("Find Edges"); 

for (i = 0; i < 37; i++)  

{run("Smooth");} 
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5.6. Save each macro (File → Save As) separately with the corresponding name followed by 

“.IJM” (without the inverted commas). 

Attention: each macro needs to be saved as a separate file followed with the suffix “.IJM” e.g. 

Proliferation Macro.IJM  

Batch Processing 

6.1. On a computer, create two folders named “Original” and “Analyzed” in the file location 

of your choice (e.g. Desktop). 

6.2. Copy the images to be analysed into the Original folder. 

6.3. In ImageJ, navigate to Process → Batch → Macro. 

6.4. Click on Input and select the Original folder; click on Output and select the Analyzed 

folder. 

Hint: The Input and Output do not need to be selected every time a batch process is performed 

unless the names and/or file locations for the Original and Analyzed folders are changed. 

 

6.5. Click on Open and select the macro of choice (e.g. Proliferation Macro or Migration 

Macro). 

6.6. Click on Process. 

Hint: The images in the Original folder can be deleted once the batch process is complete; the 

analysed images are in the Analyzed folder. 

 

6.7. For proliferation, save the “Summary” window. The “Count” column contains the 

number of cells for each image.  

6.8. For migration, save the “Results” window. The “Area” column contains the wound area 

for each image. If there are two areas for one image, select the area which corresponds 

with the wound area of the analysed image (in the Analyzed folder). 

 

Attention: in the event that ImageJ does not accurately identify the wound area, drag and drop 

the image into ImageJ, run the Migration Image Processing macro (Plugins → Macros → Run 

→ Migration Image Processing Macro.IJM), manually select the wound area (Image → 

Adjust → Threshold; uncheck Dark Background; adjust the threshold bars) and Analyze 

(Analyze → Analyze Particles → OK).   



111 

APPENDIX B: PROTOCOL FOR: A TRIPLE CO-CULTURE METHOD TO 

INVESTIGATE THE EFFECT OF MACROPHAGES AND FIBROBLASTS ON 

MYOBLAST PROLIFERATION AND MIGRATION 

Protocol Title: Triple co-culture of myoblasts, macrophages and fibroblasts 

Reagents 

1. DMEM with L-glutamine (Sigma, cat. no. D5648-1L) 

2. FBS (Gibco, cat. no. 10499-044) 

3. PenStrep (Lonza, cat. no. DE17-602E) 

4. T75 flasks (Nest, cat. no. 708003) 

5. 24-well plates (Nest, cat. no. 702001) 

6. Trypsin-EDTA (Lonza, cat. no. BE17-161E) 

Recipes  

1. Growth Media (GM): Supplement DMEM with FBS (10%) and PenStrep (2%) 

Equipment 

1. Innova® CO-170 CO2-incubator (New Brunswick, USA) 

2. Olympus CKX41 microscope (Olympus, Tokyo, Japan) 

3. Motic 3.0 megapixel camera (Wetzlar, Germany) 

4. DSC-158T desktop centrifuge 

Procedure 

Cell Culture 

1. Culture J774a.1 macrophages, LMTK fibroblasts and C2C12 myoblasts in separate T75 

flasks with GM at 37˚C and 5% CO2 until 70% confluent. 

2. Detach macrophages with a cell scraper, pellet the cells via gentle centrifugation (600 rpm, 

10 mins), resuspend in 2 ml GM and count using a hemocytometer. 

3. Detach fibroblasts with 2 ml trypsin-EDTA for 10 minutes at 37˚C, add 2 ml GM and 

count using a hemocytometer.  
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Co-Culture 

4. Pipette 40 x 103 macrophages and/or 40 x 103 fibroblasts along the outer edge of a 24-well 

plate. 

 

Attention: Ensure that the volume is not less than 30 μl, but not more than 100 μl. If the 

volume is less than 30 μl, add more growth media to ensure that the cells will be evenly 

distributed along the outer edge when swirling. If the volume is too high, concentrate the cells 

further via centrifugation and resuspend in a lower volume of GM; a higher volume will cause 

the cells to shift towards the centre of the well. 

 

Hint: The number of cells seeded along the outer edge of the well can be changed depending 

on the experimenter’s needs. However, the higher the number of cells seeded, the more likely 

they are to move to the centre of the well during experimentation. We have found that the 

upper limit of the total number of cells to be seeded was ~80 x 103 cells.  

 

5. Swirl the culture flask by hand to evenly distribute the cells along the outer edge of the 

well. 

 

Attention: Ensure you rapidly swirl (do not shake) the entire culture plate by hand in a circular 

fashion. This will cause the media/cell mixture to be evenly distributed along the outer edge 

of the well.  

 

6. Incubate for one hour at 37˚C and 5% CO2 to promote cell adherence. 

7. Add myoblasts to the centre of the well 

 

Hint: the number of myoblasts can vary depending on the experimenter’s needs. We use 20 x 

103 myoblasts for proliferation analysis and 50 x 103 myoblasts for migration analysis.  

 

8. Add 500 μl GM. 

10. Gently move the culture plate to evenly distribute the myoblasts. 

11. Incubate for 3 h to promote complete adherence. 

12. Remove GM and wash with PBS (x2) and continue with desired experiment. 
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APPENDIX C: PROTOCOL FOR: CELLULAR ALIGNMENT AND FUSION: 

QUANTIFYING THE EFFECT OF MACROPHAGES AND FIBROBLASTS 

ON MYOBLAST TERMINAL DIFFERENTIATION 

Protocol Title: Quantifying the alignment of cells with ct-FIRE 

Reagents 

1. Methanol (Radchem, Orland Park, IL, USA) 

2. Fuchsine (Sigma, St Louis, MO, USA) 

Recipes 

1. Fuchsine Stain: Add 1% (m/v) Fuchsine powder to 100% methanol 

Equipment 

1. Olympus CKX41 microscope (Olympus, Tokyo, Japan) 

2. Motic 3.0 megapixel camera (Wetzlar, Germany) 

3. Computer (Windows, OS or Linux) 

4. ImageJ (available at https://imagej.nih.gov/ij/) 

5. ct-FIRE (available at https://loci.wisc.edu/software/ctfire)  

Procedure 

Image Capture 

1. Stain the cells with Fuchsine stain for 10 mins, remove the dye by submerging in a water 

bath, and leave to completely dry. 

Note: other cytological stains, such as crystal violet, may be used instead of Fuchsine. 

2. Capture images with a brightfield microscope using the 10x objective lens. 

Attention: it is important to capture images using a high illumination and/or camera exposure 

to clearly distinguish between cells at a high confluency. 

ImageJ Processing 

3. Open an image in ImageJ (File → Open), convert it to grayscale (Image → Type → 8-bit), 

remove image noise (Process → Noise → Despeckle) and apply a mean threshold (Image 

https://imagej.nih.gov/ij/
https://loci.wisc.edu/software/ctfire
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→ Adjust → Auto Local Threshold: Mean; Uncheck “White objects on black 

background”). 

Hint: it is possible to simultaneously process several images using the macro recording and 

batch processing feature in ImageJ, but this is not covered in this protocol. 

ct-FIRE Processing 

4. Open the processed image in ct-FIRE (Open File) and run the program (Run). 

Attention: ensure that “Angle histogram & values” under Output Options is selected; all other 

options may be deselected. 

Hint: it is possible to simultaneously analyse several images using the batch processing 

feature by checking Batch before selecting the files. 

Data Analysis 

5. Locate the excel document with the output values (ctFIREout → HistANG_ct-

FIRE_ImageName). 

6. Copy the output values to the template under “ct-FIRE Values”.  

Attention: ct-FIRE output values use a period, and not a comma, to separate decimal points. 

Ensure that Excel is set up to do the same. 

7. Under “Calculate Mode”, highlight the largest value under frequency.  

8. To calculate the mode average, add the largest value from the frequency column to 

“Largest Value”. Furthermore, select the equation for “Mode AVG” and change the “X” 

and “Y” to the largest and smallest bin values, respectively.  

9. Extend the equation for Alignment Index down to calculate an AI for all ct-FIRE values. 

10. The average AI for the image is under “Image AI”. 

Hint: the template is for one image, but the sheet may be copied multiple times for several 

images. The AI for all images (for a replicate) may then be averaged.  

 

 

 

 



115 

APPENDIX D: CONFERENCE ABSTRACTS 

Conference: Second International Conference on Tissue Engineering and Regenerative 

Medicine (ICTERM) (2017) 

Title: Myogenesis in a dish: Investigating the complexity of skeletal muscle regeneration 

Abstract 

Skeletal muscle wound repair and regeneration is associated with multiple cell types that each 

play distinct roles in regulating satellite cell activation and myogenesis. Macrophages secrete 

a host of inflammatory cytokines that activate and regulate the proliferation of satellite cells, 

and also modulate their differentiation. Fibroblasts differentiate to myofibroblasts and secrete 

cytokines and extracellular matrix (ECM) factors that form a scaffold for wound repair. 

Macrophages and fibroblasts therefore work together with myoblasts to facilitate wound 

repair.  In order to understand the regulation of myogenesis by macrophages and fibroblasts, 

previous in vitro studies have primarily focused on the use of conditioned media or co-culture 

systems that physically separate the cell populations. The current study developed a simple 

and inexpensive co-culture method that allows for physical contact between cell types; in 

addition, a novel method was developed to quantitively assess myoblast alignment prior to 

fusion. The effect of macrophages and fibroblasts on myoblast proliferation, migration, 

alignment and fusion was then determined. 

 

J774A.1 macrophages and LMTK fibroblasts were found to promote the proliferation of 

C2C12 myoblasts in a cell dependent manner; macrophages had a maximal effect at 80 x 103 

cells, whereas fibroblasts promoted maximum proliferation at 20 x 103 cells. Macrophages 

and fibroblasts both promoted myoblast migration with maximal effects at 80 x 103 cells. Co-

culturing a combination of macrophages (40 x 103) and fibroblasts (40 x 103) with myoblasts 

revealed that fibroblasts did not alter the pro-proliferative effects of macrophages on 

myoblasts; however, macrophages were able to decrease the pro-migratory effects of 

fibroblasts on myoblasts.  

 

Analysis of alignment demonstrated that fibroblasts did not significantly affect 

myoblast/myotube alignment, while macrophages promoted alignment in a cell density-



116 

dependent manner with a maximal effect at 80 x 103 cells. Macrophages had no significant 

effect on myoblast fusion at 5 x 103, but increasing the number of cells beyond this 

significantly decreased myoblast fusion with the lowest percentage fusion at 80 x 103 

macrophages. Co-culture with 5 or 10 x 103 fibroblasts significantly increased myoblast 

fusion; however, further increases in fibroblast number abrogated this effect. 

 

In conclusion, we have developed a novel co-culture technique that better represents in vivo 

cell interactions by allowing for cell-cell contact and facilitating variable numbers. We show 

that macrophages are more important for promoting myoblast proliferation, while fibroblasts 

have a prominent role in promoting myoblast migration. We have also created a novel method 

to quantify alignment and further go on to show that macrophages play a distinct role in 

promoting myoblast/myotube alignment prior to fusion, but are required to resolve for 

successful fusion to occur. Fibroblasts, on the other hand, are required at low, but not high, 

numbers to promote myoblast fusion. 

Conference: First Conference of Biomedical and Natural Sciences and Therapeutics 

(CoBNeST) (2018) 

Title: Myogenesis in a dish: Investigating the complexity of skeletal muscle regeneration 

Abstract 

Communication between non-myogenic cells, such as macrophages and fibroblasts, and 

myoblasts is critical for successful skeletal muscle repair by influencing various cell 

behaviours. To evaluate the relationship between these cell types, we first developed a novel, 

inexpensive in vitro co-culture method for two or more cell types with some degree of cell 

contact; we the evaluated the effect of macrophages and/or fibroblasts on myoblast 

proliferation and migration. We found that macrophages and fibroblasts can both promote 

myoblast proliferation and migration depending on their cell numbers; triple co-culture of 

macrophages, fibroblasts and myoblasts revealed that macrophages and fibroblasts continued 

to promote myoblast proliferation, but the presence of macrophages impaired the positive 

effect of fibroblasts on myoblasts migration. We then developed a method to rapidly 

determine cell orientation and quantify alignment and used our co-culture technique to 

determine the effect of macrophages and/or fibroblasts on myoblast alignment and fusion. We 
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found that increasing numbers of macrophages promoted myoblast/myotube alignment but 

inhibited fusion; fibroblasts, however, had no effect on alignment but promoted and inhibited 

fusion at lower and higher numbers, respectively. Triple co-culture of the cells showed that 

the effect of macrophages on myoblast alignment remains unaltered in the presence of 

fibroblasts. Altogether, our results show that high numbers of macrophages and fibroblasts are 

initial important to promote myoblast proliferation and migration, but lower numbers are 

required later on during terminal differentiation to promote alignment and fusion. 
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Rapid quantification of cellular proliferation and 
migration using ImageJ
C Venter1 & CU Niesler*,1

ABSTRACT
Cellular proliferation and migration 
are crucial during development, 
regeneration and disease. Methods 
to quantify these processes are 
available; however, many are time 
consuming and require specialized 
equipment and costly reagents. 
Simple cell counts (proliferation 
analysis) and the scratch assay 
(migration analysis) are favorable 
methods due to their simplicity 
and cost–effectiveness; however, 
they rely on subjective and labor-
intensive manual analysis, resulting 
in low throughput. We have developed 
optimized protocols to rapidly and 
accurately quantify adherent cell 
number and wound area using 
ImageJ, an open-source image 
processing program. Notably, these 
adaptable protocols facilitate quanti-
fication with significantly greater 
accuracy than manual identification.

METHOD SUMMARY
Optimized automated methods 
to rapidly quantify proliferation 
and migration of adherent cells 
using ImageJ are presented. These 
methods support high-throughput 
and deliver enhanced accuracy when 
compared to manual analysis.

Cellular proliferation and migration are 
important processes during tissue devel-
opment, repair and disease. Following 
skeletal muscle injury, proliferation and 
migration of activated muscle stem cells 
(myoblasts) is crucial to ensure that suffi-
cient progenitor cells reach the wound site 
and facilitate repair [1]. Myoblast prolifer-
ation and migration are regulated by 
signalling molecules released from the 
extracellular matrix and resident/infiltrating 
cells such as macrophages and fibro-
blasts [2]. Proliferation can be quantified by 
measuring changes in DNA (via BrdU, 
3H-Thymidine), metabolism (via MTT), prolif-
eration-specific proteins (e.g., Ki-67) or 
simple cell counts (e.g., hemocytometer, 
TC20™) [3–7]. Migration can be assessed by 
determining the number of cells that move 
across a microporous membrane (transwell 
migration assay) or by measuring the 
surface area that cells occupy over time 
after creating a ‘cell-free’ area (scratch 
assay) [8–10]. Of these, cell counts and the 
scratch assay are favorable methods due 
to their cost-effective and simple nature, 
with fewer steps and a reduced need for 
specialized equipment.

ImageJ, a popular opensource image 
processing program, has previously been 
used to manually count cells (selecting and 
tallying individual cells) and assess wound 
closure (tracing the wound perimeter and 
calculating percentage closure) [11–13]. 
These manual approaches are laborious 
and time-consuming, whereas automated 
image analyses would facilitate a higher 
throughput and greater objectivity. In 
the current study, we utilized the image 
processing capabilities of ImageJ to 
develop an optimized batch processing 
macro for rapid and accurate identifi-
cation and quantification of adherent cell 
number and wound area from images 
captured using a brightfield phase contrast 
microscope. We demonstrate that these 
protocols are easier, faster and more 
objective than alternative methods.

Murine C2C12 myoblasts (ATCC, cat. 
CRL-1772™, USA) were cultured at 37°C and 
5% CO2 and maintained in growth media 
(GM) containing Dulbecco’s Modified Eagle’s 
Medium (Sigma, cat. D5648, USA) supple-
mented with 10% (v/v) Fetal Bovine Serum 
(Gibco, cat. 10500, USA), 2% (v/v) penicillin–
streptomycin (LONZA, cat. DE17–602E, 
Switzerland). Media was changed every 
48 h. Results were analyzed using either 
a paired, two-tailed Student’s T-test (for 
comparison between methods at a single 
cell number or timepoint; Figure 1B & 2C) or 
one-way ANOVA (for cell number changes 
within a method; Figure 1C), and values of 
p < 0.05 considered statistically significant. 
All data were represented as mean ± SEM.

For proliferation analysis, myoblasts (5, 
10, 20, 40, 60, 80 and 100 × 103 cells) were 
cultured in GM (500 μl) in a 24-well plate 
for 3 h to promote adherence. Media was 
then removed, and cells stained with 0.2% 
(w/v) crystal violet (Sigma, cat. C-3886) in 
methanol (Sigma, cat. 24229) for 15 min; 
excess stain was subsequently removed 
by water submergence and the plate left 
to air dry. Cells were visualized using an 
Olympus CKX41 microscope (4x objective 
lens) and images captured (three fields 
of view per replicate; three replicates) 
with a Motic 3.0 megapixel camera. Cell 
number was assessed and compared 
using three methods: manual cell identifi-
cation, automated cell identification and the 
spectrophotometric (crystal violet) assay.

For manual identification, captured 
images were converted to grayscale in 
ImageJ (Image → Type → 8-bit) (Figure 1Ai), 
the cells were manually marked out with a 
red pencil dot (size: 4 px) in Microsoft Paint 
(Figure Aii), the dots were then automati-
cally identified (Image → Adjust → Color 
Threshold (Hue 225 to 255; Dark Background: 
True)) and counted (Analyze → Analyze 
Particles) using ImageJ. For automated 
identification, the images were converted 
to grayscale, image noise removed (Process 
→ Noise → Despeckle), brightness and 
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contrast adjusted (Image → Adjust → 
Brightness/Contrast: min = 87; max = 167), 
and a Phansalkar threshold (Image → Adjust 
→ Auto Local Threshold: Phansalkar) and 
watershed (Process → Binary → Watershed) 

were finally applied (Figure Aiii). Adjusting 
the brightness and contrast, and applying 
the Phansalkar threshold, made the cells 
more distinguishable from the background, 
while the watershed step segmented any 

clustered cells from one another. The 
identified cells were finally counted using 
ImageJ. For spectrophotometric analysis, 
the crystal violet-stained cells were solubi-
lized with 200 μl SDS (1% w/v; Merck, cat. 
SAAR5823610EM, USA) for 1 h; 100 μl of 
the solution was then removed and added 
to a 96-well microplate [14]. The absorbance 
(595 nm) was read using the FLUOoptima 
micro 96-well plate reader.

For proliferation analysis, myoblasts were 
manually counted or identified and assessed 
using ImageJ. ImageJ could automatically 
identify cells at lower (5 × 103 cells) and 
higher (100 × 103 cells) numbers, despite 
the cells being clustered closely together; 
however, this is likely to become increasingly 
challenging as confluence is attained. No 
significant difference was found between 
automated (ImageJ) versus manual identi-
fication, confirming the accuracy of the 
automated method (Figure 1B). Manual cell 
identification was also a slow and laborious 
task compared to automated assessment. 
We then compared our automated cell 
number analysis with spectrophotometric 
analysis of crystal violet-stained cells; the 
latter assay is a simple, inexpensive method 
commonly used to quantify cell number 
(Figure 1C). The standard curve generated 
using the spectrophotometric assay yielded 
a polynomial line (y = -1E-05x2 + 0.0031x 
+ 0.0777; R2 = 0.9936); as the number of 
plated cells increased, the absorbance (at 
595  nm) increased, but plateaued after 
60 × 103 cells (∼65% confluence), possibly 
due to crystal violet saturation (Figure 1C). 
By contrast, the standard curve generated 
using the automated ImageJ macro resulted 
in a straight line (y = 3.5345x; R2 = 0.999), 
indicating a directly proportional relationship 
between the number of cells plated and the 
number calculated per mm2. In addition, each 
sequential increase in plated cell number 
was reflected as a significant increase in 
cell density when utilizing the automated 
counting method; this was not the case for 
the polynomial generated from crystal violet 
absorbance readings (Figure 1C). Therefore, 
ImageJ was sensitive enough to accurately 
detect both smaller changes in cell numbers 
and a wider range of cellular densities than 
spectrophotometric analysis of crystal 
violet-stained cells.

For migration analysis, myoblasts 
(120 × 103) were plated out in GM (1 ml) in 
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Figure 1. Quantification of cell number: a comparison of manual, automated (ImageJ) and spectro-
photometric identification methods. (A) C2C12 myoblasts (10 × 103 and 80 × 103 are shown) were 
stained with crystal violet and captured with an Olympus CKX41 microscope coupled to a Motic 3.0 
megapixel camera: (i) Brightfield images prior to processing, (ii) cells manually marked in Microsoft 
Paint and subsequently counted, (iii) cells automatically identified using the optimized ImageJ 
macro and subsequently counted. Scale bar = 200 μm. (B) Standard curve of cell density (cells/
mm2) following application of the manual versus the automated ImageJ analysis. (C) Standard 
curve of cell density (cells/mm2) following application of automated ImageJ analysis versus 
spectrophotometry.  
*p < 0.05 and **p < 0.005 for automated ImageJ analysis; #p < 0.05 and ##p < 0.005 for spectropho-
tometric analysis; n = 4–9.
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a 12-well plate for 24 h, before a scratch 
assay was performed as described by 
Goetsch et al. [15]. Briefly, the confluent 
monolayer of myoblasts was scratched with 
a sterile 200 μl loading tip to create a linear 
‘wound’ devoid of cells. The cells were then 
washed twice with sterile PBS and fresh GM 
(500 μl) was added. The cells were incubated 
for 7 h and images captured at 0, 3, 5 and 7 h 
using the camera-attached microscope (4x 
objective lens; two fields of view per replicate, 
for two replicates). To measure wound area 
manually, the edges of the wound were 
traced using the Motic Images Plus 2.0 ML 
software [15]. To carry out automated wound 
area measurements, the captured image 
was converted to grayscale, the edges 
found (Process → Find Edges) and the image 
blurred (Process → Smooth) multiple times 
(x37). The Find Edges step highlighted sharp 
changes in intensity with a white outline so 
that when the image was blurred numerous 
times, these outlines blurred together; as 
a result, the areas containing cells were 
white whereas the wound area (devoid of 
cells) remained black. A MinError threshold 
was then applied (Image → Adjust → Auto 
Threshold: MinError) to automatically detect 
the wound area. If the wound area was not 
accurately selected, it could be manually 
thresholded (Image → Adjust → Threshold). 
Once the wound area was identified, it was 
then quantified (Analyze → Analyze Particles 
[size: 10,000 – infinity]).

The percentage wound closure was 
calculated and the results generated using 
the manual versus automated methods were 
compared (Figure 2). The use of ImageJ to 
detect wound edges revealed that, when 
compared with manual assessment, 
automated analysis was able to accurately 
define these edges (Figure 2A); in fact, the 
automated analysis seemed to define the 
wound edges more accurately than the 
manual method (Figure 2B). As a result, 
when the percentage wound closure was 
assessed, a significant difference between 
the manual (12.13 ± 0.98%) and automated 
(7.54  ±  0.76%) method was detected at 
3  h post-wounding (p  <  0.05). This was 
attributed to the fact that ImageJ could trace 
the outline of the wound more accurately 
than the researcher’s manual attempt. This 
was particularly evident during early wound 
repair when the wound borders were not well 
defined and, therefore, harder to accurately 

trace. In addition to increased sensitivity 
and accuracy, the application of the ImageJ 
macro was less laborious and faster than 
manual analysis.

In summary, we have developed an 
optimized ImageJ-based automated method 
for rapid quantification of cell number and 
migration in vitro. ImageJ could automati-
cally identify and accurately quantify cell 
numbers and wound area; in some cases, 
the results were superior to those generated 
via traditional manual or spectrophotometric 
methods. In addition, our macros generated 
data faster than previous manual methods. 
Although programs have previously been 
developed to count cells (e.g., CellC and 
CellCounter) or measure wound closure 
(e.g., TScratch) [16–19], they did not match 
the flexibility of ImageJ which, as a single 
program, can be extended to quantify cell 
number in tissue sections and suspension 

cultures or adapted to monitor important 
cellular processes [19]. Finally, the open-
source nature of this software permits further 
optimization depending on user require-
ments, yielding a superior and versatile 
method compared with previous protocols.

AUTHOR CONTRIBUTIONS
CV: PhD postgraduate student responsible 
for the execution of the laboratory work, as 
well as compilation and revision of the 
manuscript. CUN: Senior author providing 
intellectual input and supervision to the 
student involved. This author also provided 
the funding for the project and contributed 
to revisions of multiple drafts of the article.

FINANCIAL & COMPETING 
INTERESTS DISCLOSURE
The work was supported by the South 
African National Research Foundation 

 
A

B

C

Figure 2. Quantification of wound area: a comparison of manual and automated (ImageJ) identi-
fication methods. (A) C2C12 myoblasts (120 × 103) were scratched and images captured with an 
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identification using Motic Images Plus 2.0 ML software to trace the wound edge and automated 
identification using ImageJ. (B) Zoomed-in images of wound edges following manual and 
automated identification at 3 h. (C) Percentage wound closure (%) at 3, 5 and 7 h post-injury. 
*p < 0.05; n = 16. Scale bar = 200 μm.
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Severe skeletal muscle injury causes 
damage to myofibers and the surrounding 
extracellular matrix (ECM) (1). As a result, the 
damaged muscle undergoes sequential and 
overlapping stages of wound repair, where 
several cell types are activated to proliferate 
and migrate into the wound (2,3). Macro-
phages and fibroblasts are present during 
these stages and are critical to the successful 
completion of the wound healing process 
(4). Soon after injury, tissue degeneration, 
characterized by ruptured and necrotizing 
myofibers, is evident (5,6). This is followed 
by inflammation, where macrophages 
residing in the epimysium and perimysium 

enter the wound to clear cell debris and 
secrete cytokines to initiate regeneration 
(2,7). During the regenerative phase, infil-
trating tissue fibroblasts are induced to 
differentiate into contractile myofibroblasts, 
which display a greater synthetic phenotype 
than fibroblasts. Myofibroblasts secrete 
cytokines, growth and extracellular matrix 
factors, as well as enzymes that assist in 
remodelling the wound matrix (8–11). This 
provides a mechanical scaffold for activated 
satellite cells (myoblasts) to proliferate and 
move from their niche between the basal 
lamina and sarcolemma to the area of 
damage (12). At the wound site, they differ-

entiate into myotubes and fuse with existing 
skeletal muscle tissue to repair damaged 
myofibers. The interplay of nonmyogenic 
cells with activated satellite cells is therefore 
crucial for myogenesis and successful 
repair; a cellular imbalance may lead to 
impaired wound healing and, in the long 
term, chronic disease due to conditions 
such as fibrosis (4). 

In order to fully understand the complex 
mechanisms controlling myogenesis, it is 
important to take into account the relevant 
cells that regulate this process. There are 
a number of methods that can be used to 
achieve this; these include the use of in vivo 
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The communication between nonmyogenic cells, such as macrophages and fibroblasts, and myoblasts 
is crucial for successful skeletal muscle repair. In vitro co-culture methods can be used to increase our 
understanding of these cellular interactions; however, current protocols are restricted to two, often physi-
cally separate, cell populations. Here, we demonstrate a novel, inexpensive in vitro triple co-culture meth-
od that facilitates the co-culture of at least three cell populations with some degree of cell–cell contact. 
Using this method, we determined the effect of macrophages and fibroblasts on myoblast proliferation 
and migration. A significant increase in myoblast proliferation and migration was observed following co-
culture with either macrophages or fibroblasts. However, triple co-culture of macrophages, fibroblasts, 
and myoblasts revealed that the presence of macrophages prevented fibroblasts from maintaining this 
positive effect on myoblast migration. Macrophages, on the other hand, continued to promote myoblast 
proliferation whether in the presence of fibroblasts or not. Our triple co-culture system highlights the sig-
nificance of multicellular communication in regulating myoblast proliferation and migration and empha-
sizes the importance of more complex co-culture systems when investigating myogenesis in vitro.

Reports

METHOD SUMMARY
A novel triple co-culture method facilitates the co-culture of macrophages, fibroblasts, and myoblasts.  This assay, which permits some 
cell–cell contact, can be extended to include more than three cell types, and it represents a simple, cost-effective way to probe complex 
multicellular communication in vitro.
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approaches, in vitro 3D tissue engineered 
skeletal muscle, or in vitro co-culture 
systems. In vivo models are more accurate 
in reflecting the process of muscle wound 
repair, but due to the array of interactions 
that take place, this environment is highly 
complex, making it difficult to identify 
individual mechanisms (13). In vitro 3D 
tissue engineered skeletal muscle mimics 
in vivo conditions more closely than in vitro 
monolayer studies, but this approach is 
more time-consuming in its establishment 
and requires extensive optimization (14). 
Co-culture systems make use of two or 
more cell populations, within the same in 
vitro microenvironment, thereby allowing 
some degree of interaction for studying 
intercommunication between different 
cell types (13). This creates an experi-
mental model that more closely mimics the 
intercellular communication in the in vivo 
environment and is therefore superior to 
conventional mono-culture (13,15,16). 

Co-culture systems fall into one of 
two categories.  First, those that physi-
cally separate the cell populations from 
one another, typically by using a multi-
compartment approach  (e.g., transwell 
plates or “overflow” culture chambers) 
that allows communication only via 

soluble factors (Figure 1Ai and ii) (17,18). A 
disadvantage of this type of method is that 
cells are not permitted to come in direct 
contact with one another, as would occur 
under in vivo conditions. Diffusion rates of 
soluble factors in larger culture volumes (as 
required in the overflow chamber) are also 
a consideration; if the rate of diffusion is 
too low, signalling factors may not be able 
to reach their targets timeously (13,19). 
Secondly, there are methods that allow 
direct interactions between cells (i.e., 
micropatterning); this is usually achieved 
by spatially controlling the position of the 
adhering cell populations within a culture 
dish (such as that reported by Javaherian 
et al., 2013, or the co-culture method 
presented in this paper) (Figure 1A iii and iv) 
(20). Co-culturing by way of micropatterning 
involves the creation of a distinct population 
of cells within a culture dish by selectively 
controlling the attachment of cells (Figure 
1A iii). This can be achieved by creating 
a nonadhesive area via a physical barrier 
(using stamps, as seen in (21)) or a chemical 
barrier (e.g., bovine serum albumin (BSA) 
(20)). The first population of cells will adhere 
to the area surrounding the barrier; once 
the barrier is removed (either by physical 
removal or by coating the nonadhesive 

area with an adhesive matrix factor (20)), 
the second cell population binds in the 
remaining space (22). This method has the 
advantage of allowing cells to interact via 
both secreted factors and cell–cell interac-
tions, but is laborious, requiring additional 
steps and specialized equipment.

Here, we describe a novel triple 
co-culture method (Figure 1A iv), where a 
standard circular well-containing plate can 
be employed to culture multiple distinct cell 
populations, allowing for both direct and 
indirect cellular communication.  Using 
this method, we investigate the regulatory 
role of macrophages and fibroblasts on 
myoblast proliferation and migration, and 
demonstrate the importance of macro-
phage resolution to facilitate fibroblast-
regulated wound repair in vitro.

Materials and methods
Cell culture
Mouse C2C12 myoblasts (Cat. CRL-1772™, 
ATCC, VA, USA), LMTK fibroblasts (Cat. 
CCL-1.3™, ATCC) and J774A.1 macro-
phages (Cat. TIB-67™, ATCC) were cultured 
at 37ºC and 5% CO2 and maintained in 
growth media containing Dulbecco’s 
Modified Eagle’s Medium (DMEM; Cat. 
D5648, Sigma, MO, USA) supplemented 
with 10% (v/v) fetal bovine serum (Cat. 
10500, Gibco, Thermo Fisher Scientific, MA, 
USA) and 2% (v/v) penicillin–streptomycin 
(Cat. DE17-602E, Lonza, Basel, Switzerland). 
Media was changed every 48 h. 

Co-culture method
For co-culture of two cell types, either 
macrophages or fibroblasts (0, 5, 10, 20, 40, 
or 80 x 103 cells) were plated along the outer 
edge of a dry 24-well plate in a volume of 
growth media not exceeding 100 μl, but not 
less than 30 μl (Figure 1B i). For co-culture of 
three cell types (i.e., “triple” co-culture) 40 x 
103 macrophages and 40 x 103 fibroblasts 
were combined in 100 μl growth media and 
plated as above. A centrifugal force was then 
applied to the plate to ensure that the cells 
only attached to the outer edge of the well; 
this was achieved by simply rotating the 
plate in a circular motion (2 min) by hand, 
or using a rotational device (20 rpm) set at 
a 45o angle (Figure 1B ii). Cohesion of the 
low media volume ensures the cells do not 
spread towards the center of the well. The 
cells were then incubated at 37˚C and 5% 
CO2 for 1 h to promote adherence (Figure 1B 
iii). Following this, myoblasts were plated in 
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Figure 1: Schematic diagram of co-culture methods and steps. A) Transwell inserts (i); overflow co-
culture chamber (ii); micropatterning (iii); and our novel co-culture method (iv). B) Steps to establish the 
novel triple co-culture method: first cell populations are plated at the outer edge of a well (i); the culture 
plate is then rotated to distribute the cells along the outer edge of the well (ii); cells are incubated for 1 
hour to promote adherence (iii); the subsequent cell population is then plated in the center of the well 
(iv); media is added (v).
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the center of the well and allowed to adhere 
to the unoccupied area (Figure 1B iv and v). 
Proliferation and migration of myoblasts in 
the center of the well was then analyzed as 
described below.

Proliferation analysis
To analyze the effect of macrophages and 
fibroblasts on myoblast proliferation, 20 x 
103 C2C12 cells were allowed to adhere for 
2 h, then washed twice with sterile PBS and 

cultured in serum-free DMEM (500 μl).  Cells 
were co-cultured for 24 h, washed with PBS 
and stained with basic Fuchsin (Cat. 47860, 
Sigma) for 10 min (1% w/v basic Fuchsin 
dissolved in 100% methanol). Cells were 
then submerged in water to remove the stain 
and manually counted following visualization 
and image capture with an Olympus CKX41 
microscope (Olympus Corporation, Tokyo, 
Japan) and a Motic 3.0 megapixel camera 
(4x objective; Motic, Kowloon, Hong Kong). 

Three fields of view per replicate (taken from 
the center of the well), with three replicates 
per experiment, were used. C2C12 cells 
plated in the absence of macrophages or 
fibroblasts served as a control. Changes in 
myoblast number were calculated relative to 
the number of myoblasts initially plated out 
and expressed as a percentage increase (%).  

Migration analysis
For migration analysis, 50 x 103 C2C12 
myoblasts were allowed to adhere for 24 
h before undergoing a scratch assay as 
described by Goetsch et al. (2011) (23) in 
serum-free DMEM (500 μl). Briefly, while 
being careful not to disturb the cells on 
the outer edge, the confluent monolayer 
of myoblasts at the center of the well was 
scratched with a sterile 200 μl loading tip 
to physically remove myoblasts and create 
a linear “wound.” The remaining cells were 
washed twice with sterile PBS and 500 μl 
serum-free DMEM was added. The cells 
were then incubated for 7 h and images 
taken at 0 and 7 h using an Olympus CKX41 
microscope and a Motic 3.0 megapixel 
camera (4x objective). The percentage of 
wound closure was calculated after tracing 
the wound edges using the Motic Images 
Plus 2.0 ML software (23).  

Immunocytochemistry and 
confocal microscopy
To immunocytochemically identify cells in 
co-culture, cells were cultured on glass 
coverslips as described above. Briefly, 
macrophages (40 x 103) or fibroblasts (40 
x 103) were plated in growth medium at the 
edge of the well, followed by myoblasts (20 
x 103) in the center of the well. The cells were 
then washed twice with PBS and switched 
to serum-free DMEM for 24 h to mimic 
the proliferation time-frame. To analyze 
the effect of macrophages on fibroblast 
phenotype, macrophages (40 x 103) were 
plated in growth medium at the edge of the 
well after which fibroblasts (40 x 103) were 
allowed to adhere in the center of the well. 
The cells were then washed twice with PBS 
and switched to serum-free DMEM for 7 h 
to mimic the migration timeframe. 

Cells were then fixed with 4% 
paraformaldehyde, washed with PBS, 
blocked at 4ºC with 5% donkey serum 
(Cat. D9663, Sigma) and incubated 
at room temperature for 2 h with the 
following primary antibodies as appropriate: 
polyclonal rabbit anti-desmin antibody 
(1:500; Cat. ab15200, Abcam, Cambridge, 

E
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C D

Outer edge 
of the well

Center
of the well

Firboblast–myoblast co-culture Macrophage–myoblast co-culture

Figure 2: Cell populations in distinct regions of the co-culture plate. A) Myoblasts are at the center of 
the well, while B) macrophages, C) fibroblasts, or D) macrophages and fibroblasts are present predomi-
nantly at the outer edge of the culture well (right) with some overlap with myoblasts. E) Fibroblast–myo-
blast co-cultures (left panel) immunostained with both mouse monoclonal anti-TCF-4 (red; fibroblasts) 
and rabbit polyclonal anti-desmin (green; myoblasts), while macrophage–myoblast co-cultures (right 
panel) were immunostained with rabbit polyclonal anti-E-cadherin (green; macrophages).  Hoeschst 
(blue) was used as a nuclear stain. Images were captured using a Zeiss 710 confocal microscope with 
a 25x objective lens. Scale bar = 50µm. Representative images from the outer edge and center of the 
well are shown.
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UK), monoclonal mouse anti-TCF-4 
antibody (1:20; Cat. 05-511, Merck Millipore, 
MA, USA), polyclonal rabbit anti-E-cadherin 
(1:40; Cat. sc-7870, Santa Cruz Biotech-
nology, TX, USA) or monoclonal mouse 
anti-α-smooth muscle actin (SMA; 1:500; 
Cat. A2547, Sigma). The cells were then 
washed with PBS and incubated at room 
temperature for 1 h in the dark with one 

of the following appropriate secondary 
antibodies: Dylight488-conjugated 
donkey anti-rabbit antibody (1:1000; Cat. 
711-485-152, Jackson ImmunoResearch, 
Newmarket, Suffolk, UK), Dylight594-conju-
gated donkey anti-mouse antibody (1:1000; 
Cat. 715-515-151, Jackson ImmunoRe-
search) or Dylight488-conjugated donkey 
anti-mouse antibody (1:2000; Cat. 715-485-

151, Jackson ImmunoResearch). Hoescht 
(1:100; stock 10 mg/ml; Cat. B2261, Sigma) 
was subsequently added for 10 min and 
coverslips washed with PBS prior to being 
fixed again with 4% paraformaldehyde (10 
mins), washed with PBS, and mounted 
on glass slides with Mowiol (Cat. 81381, 
Sigma). The cells were viewed with a 
Zeiss 710 confocal microscope (Carl Zeiss 
GmbH, Oberkochen, Germany).

Statistical analysis
Data was determined to be normally 
distributed; results were analyzed using 
a parametric paired, two-tailed Student’s 
t-test and values of p < 0.05 were 
considered to be statistically significant 
compared with the control. All data was 
represented as mean ± SEM.

Results & discussion
To initially co-culture two cell populations, 
macrophages were plated at the outer 
edge of the well, while myoblasts were 
cultured in the center of the well (Figure 2A 
& 2B). J774A.1 macrophages are relatively 
small, circular cells, easily distinguishable 
from larger, spindle-shaped myoblasts 
that overlap to an extent with macro-
phages, allowing for a degree of cell–cell 
interaction (Figure 2B). This method of 
co-culture was then successfully repeated 
using fibroblasts instead of macrophages 
(Figure 2C). LMTK fibroblasts are larger 
than J774A.1 macrophages, but smaller 
than C2C12 myoblasts, and have an 
elongated shape. To establish the “triple 
co-culture,” macrophages and fibroblasts 
were both cultured at the outer edge of the 
well, while myoblasts were cultured at the 
center of the well (Figure 2D). Fibroblasts 
and macrophages were clearly identified 
at the outer edge of the well via expression 
of TCF-4 and E-cadherin, respectively 
(Figure 2E); significant numbers of macro-
phages and fibroblasts were not observed 
amongst the myoblasts at the center of the 
well (Figure 2E). Our method was estab-
lished using a 24-well plate, but it can be 
adapted to any culture vessel with circular 
wells. The advantage of this method over 
others lies in its simplicity and the fact that 
it can be established quickly without the 
need for additional, specialized equipment. 
A further benefit of our system is that it can 
be expanded to include more than three 
cell types; this is crucial when one is trying 
to mimic the in vivo environment.
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Figure 3: The effect of macrophages or fibroblasts on myoblast proliferation and migration. A) Cells 
were stained with 1% Fuchsin in methanol. B) and C) Relative cell number for myoblasts cultured in 
the presence of increasing numbers of macrophages or fibroblasts, respectively. D) The wound area of 
myoblasts. E) and F) Percentage wound closure at 7 h for myoblasts cultured in the presence of increas-
ing numbers of macrophages or fibroblasts, respectively. * = p < 0.05; B, C and E: n = 6; F: n = 5). 
Cells were visualized using an Olympus CKX41 microscope and images were captured with a Motic 3.0 
megapixel camera (4x objective lens).
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 Using our co-culture method, we sought 
to determine the effect of macrophages 
and fibroblasts on myoblast proliferation 
and migration. Co-culture experiments 
revealed that macrophages and fibroblasts 
promote the proliferation of myoblasts 
(Figure 3A). Relative myoblast numbers 
already showed a small significant increase 
from 130 ± 4.38% to 146 ± 4.12% (16% 
increase; p < 0.05) when co-cultured for 
24 h with 5 x 103 macrophages compared 
with control cultures (Figure 3B). A maximal 
effect was reached following co-culture 
with 80 x 103 macrophages (188 ± 1.75%; 
p < 0.05; Figure 3B). The presence of fibro-
blasts also increased the proliferation of 
myoblasts; however a significant, maximal 
effect was only achieved in response to 20 
x 103 fibroblasts; when fibroblast numbers 
were increased further, this pro-proliferative 
effect was lost (Figure 3C). In response to 20 
x 103 fibroblasts, relative myoblast numbers 
increased significantly from 189 ± 8.31% 
to 232 ± 16.76% (p < 0.05); whereas in 
response to co-culture with 80 x 103 fibro-

blasts, relative myoblast numbers returned 
to control levels of 187 ± 7.72% (Figure 3C). 

Analysis of myoblast migration revealed 
that co-culture with 80 x 103 macrophages 
resulted in a significant increase in the 
percentage of wound closure (17.0 ± 2.04%) 
compared with the control (9.42 ± 0.75%), 
5 x 103 (9.58 ± 1.00%) and 20 x 103 (8.51 
± 1.52%) macrophages (Figure 3D and 3E; 
p < 0.05). The presence of lower numbers 
of macrophages had no significant effect 
on myoblast migration (Figure 3E). When 
co-cultured with fibroblasts, myoblasts 
responded by increasing their migration in 
a cell-density dependent manner (Figure 3D 
and 3F).  Significant effects were already 
observed in response to 20 x 103 fibro-
blasts (Figure 3F), rather than at only 80 x 
103 as seen with macrophages (Figure 3E). 
Following co-culture with 20 x 103 cells, 
myoblast wound closure had increased 
significantly to 19.57 ± 1.71% with a maximal 
significant effect observed in response to 
80 x 103 cells (21.9 ± 1.62%) compared with  
the control (13.5 ± 0.79%) (p < 0.05; Figure 

3F). This data suggests that rising fibroblast 
numbers promote myoblast motility, while 
macrophages lose their promigratory effect 
as their numbers decrease. 

To determine the combined effect of 
macrophages and fibroblasts on myoblast 
proliferation and migration, a triple co-culture 
experiment was carried out where myoblasts 
were co-cultured with 40 x 103 macrophages 
and 40 x 103 fibroblasts. Total cell numbers 
exceeding 80 x 103 cells caused the fibro-
blasts and macrophages to move to the 
center of the well, hence 40 x 103 of each 
cell type was used. Analysis of myoblast 
proliferation revealed that triple co-culture 
of myoblasts with both macrophages and 
fibroblasts did not significantly change 
myoblast numbers when compared with 
conditions using macrophages or fibro-
blasts alone (Figure 4A). The pro-prolifer-
ative effect of macrophages on myoblasts 
was therefore observed both in the absence 
and presence of fibroblasts. However, when 
myoblast migration was analyzed, triple 
co-culture of myoblasts with both macro-
phages and fibroblasts abrogated the 
previous significant positive effect of fibro-
blasts on myoblast migration (Figure 4B). 
The promigratory effect of fibroblasts on 
myoblasts was therefore lost in the presence 
of macrophages. Further immunocytochem-
istry and confocal microscopy revealed 
that, whether in the absence or presence 
of macrophages, fibroblasts expressed 
aSMA (Figure 4C). It is well known that the 
presence of serum promotes the myofi-
broblast phenotype (24); therefore a-SMA 
expression was expected in these cells. Our 
results suggest that macrophages do not 
initiate de-differentiation of myofibroblasts 
over the 7 h migration period. Interestingly, 
a decrease in cell number was observed, 
suggesting perhaps a pro-apoptotic effect 
of macrophages. This requires further inves-
tigation.

Following muscle injury, the inflammatory 
response is accompanied by an increasing 
population of macrophages, followed by 
the migration of resident fibroblasts that are 
promoted to proliferate and differentiate to 
myofibroblasts (25–30). Triple co-culture 
studies using macrophages, fibroblasts 
and myoblasts revealed that the presence 
of macrophages negates the promigratory 
effects of fibroblasts on myoblasts. This 
supports the premise that although an 
inflammatory response is crucial for repair, 
under certain conditions, it can negatively 
affect repair. The pro-proliferative effect of 

Figure 4: The effect of macrophages and fibroblasts on myoblast proliferation and migration. A) Rela-
tive cell number or B) percentage of wound closure for myoblasts cultured in the presence of both 40 
x 103 macrophages and 40 x 103 fibroblasts (40J40L). Controls include no macrophages or fibroblasts 
(0), 40 x 103 fibroblasts alone (40L), or 40 x 103 macrophages alone (40J). C) Myofibroblasts cultured 
alone (left) or co-cultured with macrophages (right), immunostained with mouse monoclonal anti-α-
SMA antibody (green), and stained with Hoescht (blue). Images were captured using a Zeiss 710 confo-
cal microscope .(25x objective). Scale bar = 50µm. *p < 0.05; n = 5).
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macrophages on myoblasts was however maintained even in the 
presence of fibroblasts, suggesting less of an influence of fibroblasts 
on macrophage–myoblast communication. 

Previous studies using more than two cell types in co-culture 
are limited (31); in fact, no previous studies have been performed 
to determine the combined effect of macrophages and fibroblasts 
on myoblast proliferation and migration. 

A crucial advantage of the current protocol is that it can be 
expanded to include additional relevant cell types, such as endothelial 
cells. In addition, the format allows the user to a) determine the 
phenotype of the participating cells (e.g., M1 vs M2 macrophages 
or fibroblasts vs myofibroblasts) using immunocytochemistry and b) 
polarize the co-cultured cells in order to determine whether distinct 
populations have differential effects on myoblast proliferation and 
migration. Our results underscore the importance of including cellular 
complexity in in vitro co-culture systems in order to gain a better 
understanding of how cellular communication regulates regenerative 
outcomes in skeletal muscle. 

In previous in vitro studies, the conditioned media of pro-inflam-
matory M1 macrophages was found to increase the proliferation 
of myoblasts, while inhibiting migration (32–35). In our study, we 
used unmanipulated macrophages. This may account for some of 
the differences seen in our results compared with these previously 
published studies. 

It would be valuable to determine whether any change in macro-
phage phenotype is observed in response to myoblast injury. In 
vivo studies suggest that ablation of fibroblasts leads to depletion 
of satellite cells, premature satellite cell differentiation, and results in 
smaller regenerated myofibers (36). In vitro studies have shown that 
increasing fibroblasts in co-culture also promotes the migration of 
myoblasts (18) and that fibroblasts protect myoblasts from apoptosis 
during differentiation, promoting myotube formation (37). This agrees 
with our current studies showing that the presence of fibroblasts 
increases myoblast cell numbers and migration.

In summary, our optimized triple co-culture assay has numerous 
advantages: it is easier, simpler, and cheaper to establish than 
conventional techniques; it allows for both direct and indirect cellular 
communication; and it can be expanded in its complexity to include 
additional cell types such as endothelial cells. Using this model, we 
confirm that macrophages and fibroblasts are important regulators of 
myoblast proliferation and migration. We also show for the first time 
that macrophages can negatively influence the ability of fibroblasts 
to promote myoblast migration in an in vitro wound healing setting. 
Knowledge generated from this method will further our under-
standing of the role of cellular interplay in regenerative processes.
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A B S T R A C T

Successful skeletal muscle wound repair requires the alignment and fusion of myoblasts to generate multi-
nucleated myofibers. In vitro, the accurate quantification of cellular alignment remains a challenge. Here we
present the application of ImageJ and ct-FIRE to quantify muscle cell orientation by means of an alignment index
(AI). Our optimised method, which does not require programming skills, allows the alignment of myoblasts in
vitro to be determined independently of a predefined reference point. Using this method, we demonstrate that
co-culture of myoblasts with macrophages, but not fibroblasts, promotes myoblast alignment in a cell density-
dependent manner. Interestingly, myoblast fusion was significantly decreased in response to co-culture with
macrophages, while the effect of fibroblasts on fusion was density-dependent. At lower numbers, fibroblasts
significantly increased myoblast fusion, whereas at higher numbers a significant decrease was observed. Finally,
triple co-culture revealed that the effect of macrophages on myoblast alignment and fusion is unaltered by the
additional presence of fibroblasts. Application of our optimised method has therefore revealed quantitative
differences in the roles of macrophages versus fibroblasts during alignment and fusion: while successful myoblast
alignment is promoted by increasing macrophage numbers, regenerative fusion coincides with a decreasing
macrophage population and initial rise in fibroblast numbers.

1. Introduction

Skeletal muscle represents a heterogenous tissue with multiple cell
types that each play distinct and important roles in wound repair [1].
Damage to skeletal muscle results in the disruption of myofibres and the
extracellular matrix (ECM) that surrounds them [2]. Myogenesis, the
differentiation and fusion of mono-nucleated myoblasts into multi-nu-
cleated myofibers, is a critically important stage of muscle regeneration
and serves to restore muscle structure and function [3]. Non-myogenic
cell types, such as macrophages and fibroblasts, mediate the behaviour
of muscle cells during wound repair by secreting an array of signalling
molecules and matrix factors [4,5]. We have previously investigated the
regulatory role of these non-myogenic cells on myoblast proliferation
and migration. We demonstrated that macrophages promote the pro-
liferation of myoblasts in co-culture, while fibroblasts promote migra-
tion, during in vitro wound repair; the latter pro-migratory effect was
reduced when myoblasts were co-cultured in the presence of both fi-
broblasts and macrophages under triple co-culture conditions [6,7].

During the terminal phase of myogenesis, myoblasts align to orga-
nize themselves relative to each other and to existing myofibres [8].
This process brings the lipid bilayers in close contact with one another

in order for the cells to fuse together to form functional muscle with
myotubes orientated in the same direction [8]. Several strategies can be
used to promote myotube alignment, including topographical patterning
(e.g. grooved culture plates [9]), mechanical stimulation (e.g. stretch
[10]) or application of magnetic/electrical fields [11,12]. In order to
quantify the exact effect of these strategies on alignment, one has to
identify the cell/nuclear outline or actin cytoskeleton, then determine
the orientation of these elements and finally calculate a value that re-
presents the extent of alignment [13]. To achieve this, cells are visually
identified in images, their outlines manually selected, and their or-
ientation ascertained by determining the angle of deviation of the
longitudinal axis of the cell (in degrees) from the x-axis (set to 0°). This
manual process is accurate, but arduous and time-consuming with low
throughput [13]. Automated image processing techniques (e.g. Fast
Fourier Transform (FFT) and local intensity gradient [14,15]) have
previously been used to determine cellular orientation; however, these
approaches were designed for determining the orientation of a type of
pattern rather than determining the orientation of cells and therefore
yield low alignment scores [13].

Xu et al. addressed the challenges of these techniques by developing
the Binarization-based Extraction of Alignment Score (BEAS) method to
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rapidly and accurately quantify the alignment of cells [13]. However, a
major challenge with BEAS (and other previous methods) is that the
information required to determine cellular orientation is presented as a
complex image-processing algorithm, which needs to be computed in
MATLAB (a costly computer programming language and computing
environment). This implementation is problematic for researchers who
have neither programming experience nor access to MATLAB. An easily
accessible, automated method to quantify cellular orientation was
therefore required.

ct-FIRE is a freely available, standalone and fully developed fra-
mework designed to determine the orientation of collagen fibres; it has
not been tested for its ability to determine cellular orientation [16]. In
order to adapt ct-FIRE to measure cellular orientation, a number of
approaches can be used. Data can be organized into 10° bins and either
represented as a histogram of frequency distribution (however, this
gives no indication of the extent of alignment and makes significance
testing problematic) or used to calculate the degree of alignment. In the
latter method, cells within less than 10° of the preferred orientation are
considered aligned and the percentage of cells in that particular fre-
quency is then calculated [17,18]. Alternatively, an alignment index
(AI), which determines how well cells align in a specified direction can
be calculated [18–20]. An AI is generally easier to calculate if there is a
set direction to which orientation can be compared (e.g. directional
angle of the grooves on a plate or the average direction of the cells in a
culture dish). However, under standard myoblast culture conditions,
there is often no set direction to which alignment can be compared as
the cells align independently of physical properties of culture plate and
subsequently self-organize in response to elongating myoblasts during
fusion [21].

In the current study, we present a method for determining cellular
alignment; this method does not require a pre-defined reference di-
rection. ct-FIRE is first tested for its ability to determine the alignment
of elliptical shapes (representing hypothetical cells) compared to linear
collagen shapes (for which the programme was developed); the or-
ientation determined by ct-FIRE is compared to actual orientation using
the AI (Fig. 1A). We then generate an alignment model, creating data
sets with defined standard deviations, which represent hypothetical
images of cells aligned to different extents (Fig. 1B). These hypothetical
images are then rotated, and an AI calculated using either the average
(i.e. the mean direction of cell alignment) or preferred (i.e. direction in
which most cells are aligned) orientation (Fig. 1B). Lastly, we test our
method using images of cultured myoblasts, where the image proces-
sing capability of ImageJ is first applied to automatically mark the
boundaries of cells and ct-FIRE is subsequently used to analyse cellular
orientation and calculate an AI (Fig. 1C) [13,16]. Once established, we
then apply this protocol to assess the effect of macrophages and fibro-
blasts on the alignment of myoblasts during fusion. This accessible,
optimised method for the analysis of cellular orientation presents a tool
for analysis of alignment in vitro. Our results highlight the distinct
regulatory role of non-myogenic cells on alignment and fusion during
terminal skeletal muscle differentiation.

2. Materials and methods

2.1. Testing ct-FIRE on images of hypothetical cells

The programme ct-FIRE was initially developed to determine the
alignment of collagen fibres; these fibres have linear shapes as opposed
to elliptical shapes that are classically associated with elongated
spindle-shaped cells. Linear and elliptical shapes were therefore created
using Microsoft PowerPoint (2016) and orientated at 0°, 30°, 60°, 90°,
120° and 150° (Fig. 2); these orientations represent x in the equation
below, where N is the total number of orientations [20,22]:
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⎠
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N

cos x y1 (2 [ ( )] 1)
i

N
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ct-FIRE was then tested to determine whether it would be able to
measure the orientation of both shapes, generating the value y in the
above equation. An AI value of 0 represents no agreement between x
and y, while a value of 1 represents a perfect agreement (i.e. x equals y).
This evaluated how well the orientation determined by ct-FIRE agrees
with the actual orientation.

2.2. Alignment modelling

A set of normally distributed random data (N=98) around a mean
(set to 90) with a specified standard deviation (0, 4, 16, 64)
(Supplementary Table 1) was created using the Microsoft Excel (2016)
=NORM.INV (probability; mean; standard deviation) function with =
RAND() as the probability (which creates a random factional value: 0≤
α≤ 1). The values in this data set represent theoretical directions in
which an “image” containing 98 cells are likely to be orientated (the
smaller the standard deviation, the greater the extent of alignment, and
vice versa). Using this model, a cell orientated at 180° has the same
alignment as a cell orientated at 0°. Similarly, 225° equals 45°, 270°
equals 90° and so on. Therefore, 180° was subtracted from values
≥ 180° and added to values< 0° in order to represent cell direction
exclusively between 0° and 180°. In order to rotate hypothetical images
of these cells, every theoretical cell in a data set was shifted by −90° or
+37.1° and values≥ 180° or< 0° adjusted accordingly. For every data
set, the average orientation (an average of all orientations) and preferred
orientation (an average of cell orientations in the frequency bin with the
largest value) was calculated and used in the same alignment index
equation stated earlier, where N is now the total number of cells, x is
the average OR preferred orientation used as a reference point of the data
set and y is the orientation of an individual cell within that data set.
This equation determines how well a cell aligns along a particular di-
rection (e.g. a fixed point of reference) or along the average/preferred
direction of cells within each individual cell in a data set. The alignment
index of every cell in a data set was used to calculate an average
alignment index (of all the cells in that data set) between 0 and 1, where
0 represents a group of cells that are randomly orientated and 1 re-
presents a population that is perfectly aligned [22]. The AI was first
calculated using the average orientation (often associated with a defined
reference point [17,18,20]) and this was repeated using the preferred
orientation of the data set, in order to compare the two.

2.3. Cell culture

Mouse C2C12 myoblasts (ATCC, USA, cat. CRL-1772™; passage
10–20), LMTK fibroblasts (ATCC, USA, cat. CCL-1.3™; passage 6–25)
and J774A.1 macrophages (ATCC, USA, cat. TIB-67™; passage 70–90)
were cultured at 37 °C and 5% CO2 and maintained in growth media
(GM) containing Dulbecco's Modified Eagle's Medium (DMEM, Sigma,
St Louis, MO, USA, cat. D5648) supplemented with 10% (v/v) Fetal
Bovine Serum (FBS, Gibco, USA, cat. 10500) and 2% (v/v) Penicillin-
Streptomycin (PenStrep, LONZA, Switzerland, cat. DE17-602E). Media
was changed every 48 h.

Co-culture of macrophages and/or fibroblasts with myoblasts was
established as described in Venter and Niesler [6]. Briefly, for double
co-culture, macrophages or fibroblasts (0, 5, 10, 20, 40 and 80×103)
were plated on the outer edge of the well of a 24-well culture plate in
GM for an hour to promote adherence; C2C12 myoblasts (50× 103

cells) were then plated and left to adhere in the centre of the same well
for 24 h in GM. For triple co-culture, both macrophages (40×103) and
fibroblasts (40× 103) were plated on the outer edge and myoblasts
plated in the centre as described above. Myoblasts were differentiated
for 5 days in differentiation media (DM; 2% FBS in DMEM) with media
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changed every 2–3 days. After differentiation, the cells were stained
with 1% Fuchsin (Sigma, St Louis, MO, USA, cat. 47860) in methanol
(15min), washed three times with distilled water, left to air dry

overnight, and evaluated for alignment and fusion.

2.4. Evaluating alignment

Images (5 fields of view; 2 replicates per experiment) of differ-
entiated myoblasts, absent of macrophage or fibroblast clusters, were
taken with an Olympus CKX41 microscope and a Motic 3.0 megapixel
camera (10× objective lens) (Supplementary Fig. 1A) and processed
with ImageJ, using an adaptation of the binarization method described
by Xu et al. [13] (Supplementary Fig. 1B). The image was converted to
grayscale (Image → Type → 8-bit), image noise removed (Process →
Noise → Despeckle) and a mean threshold applied (Image → Adjust →
Auto Local Threshold: Mean; Uncheck “White objects on black back-
ground”) and further processed with ct-FIRE (Supplementary Fig. 1C).
The AI was then calculated using the preferred orientation of cells (as
described earlier).

Fig. 1. Overview of methodology development. A) ct-FIRE was tested for its ability to determine the orientation of linear versus elliptical shapes, representing either
collagen or cells, respectively. B) A model for alignment was created using Microsoft Excel to represent hypothetical cells that were then rotated at−90° and +37.1°;
their alignment was calculated and compared using the average orientation versus preferred orientation. C) Images of differentiating myoblasts were then acquired, and
the AI calculated using the preferred orientation.

Fig. 2. Representative images of collagen fibres (linear) and cells (elliptical).
Hypothetical shapes representing collagen fibres and cells were created using
Microsoft PowerPoint orientated at 0°, 30°, 60°, 90°, 120° and 150°.
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2.5. Fusion index

Images (5 fields of view; 2 replicates per experiment) of differ-
entiated C2C12 myoblasts (day 5) were taken with an Olympus CKX41
microscope and a Motic 3.0 megapixel camera (20x objective lens) and
the fusion index calculated as follows:

= ≥Fusion Index(%) (No. of myotube nuclei( 3 nuclei)/Total no.

nuclei) x100

2.6. Statistical analysis

Data was determined to be normally distributed; all results were
analysed using a parametric paired, two-tailed Student's T-test and
values of p < 0.05 were considered to be statistically significant
compared to the control. All data was represented as mean ± SEM.
Experiments were repeated 3–5 times.

3. Results

3.1. ct-FIRE can determine the orientation of cell-like shapes

ct-FIRE was originally developed to determine the orientation of
linear collagen fibres, but its ability to determine the orientation of
elliptical cell-like shapes had not been evaluated. The AI's of linear
versus elliptical shapes were determined to be 0.9992 versus 0.9999
respectively (Table 1), demonstrating that ct-FIRE is able to determine
the orientation of both shapes with a very high degree of accuracy
(maximum AI = 1). No significant difference in AI calculation between
linear and elliptical shapes were observed. This demonstrates that ct-
FIRE can be used to accurately determine the orientation of elliptical
shaped objects, such as cells.

3.2. Calculation of cellular alignment should use preferred rather than
average orientation

The rotation a hypothetical image of aligned cells (orientated at 90°)
by −90° or +37.1° (Fig. 3) does not change how they are aligned, but
merely shifts the direction in which they are aligned (0° or 127.1°, re-
spectively). The data set in Supplementary Table 1 represents either a
population of hypothetical cells that are perfectly aligned (SD = 0),
somewhat aligned (SD = 4 or 16) or unaligned and randomly or-
ientated (SD = 64).

The alignment index (AI), for each data set representing a hy-
pothetical image of cells (Table 2) with different degrees of alignment
(SD = 0, 4, 16 and 64) was then compared, following calculation, using
the average orientation and preferred orientation; the significance within
SD's was subsequently tested between 90° and either 0° or 127.71° or-
ientations. When comparing the AI generated for cells orientated at 90°
and 127.71° using the average orientation, there was no significant dif-
ference irrespective of the SD (Table 2). When comparing cells or-
ientated at 90° with those oriented 0°, there was significant difference
for SD's 4, 16 and 64. For instance, for SD =4, the AI was 0.98 at 90°
when using the average orientation which was significantly different
when compared with −0.94 at 0° (Table 2). There was no significant

difference between 90° versus 0° and 90° versus 127.1° for any of the
standard deviations when using the preferred orientation. This suggests
that using the average orientation as a point of reference to calculate the
AI of cells will yield inaccurate results when an image is orthogonally
rotated; using the preferred orientation yields the same AI regardless of
which direction an image may be rotated.

3.3. Macrophages inhibit fusion, but promote alignment of myoblasts in a
density-dependent manner

Once we had determined that the preferred orientation was more
appropriate in determining cellular AI's, we went on to evaluate the
effect of macrophages on myoblast alignment. Visual analysis of co-
culture of macrophages with myoblasts (Fig. 4) suggested that macro-
phages had differing effects on alignment versus fusion (Fig. 4A). Fol-
lowing calculation, it was evident that the myoblast AI was significantly
increased in response to 5×103 macrophages (0.21 ± 0.02;
p < 0.05) and continued to increase in a cell density-dependent
manner reaching a maximum effect at 80× 103 cells (0.46 ± 0.03;
p < 0.05), compared to the control (0.14 ± 0.02) (Fig. 4B). Co-cul-
ture with macrophages, however, was observed to negatively impact
fusion (Fig. 4C), with 20×103 macrophages causing a significant de-
crease in the fusion at day 5 (14.88 ± 0.75%; p < 0.05) compared to
the control (19.55 ± 0.15%). Macrophages continued to negatively
affect myoblast fusion in a density-dependent manner with 80× 103

macrophages having the greatest significant effect (6.08 ± 0.49%;
p < 0.05) compared to the control.

3.4. Fibroblasts do not significantly alter myoblast alignment, but have
differential effects on fusion

Co-culturing fibroblasts with myoblasts resulted in no observable
difference in alignment; it appears though that lower fibroblast num-
bers were associated with larger myotubes, while co-cultures with
higher fibroblast numbers displayed smaller myotubes (Fig. 5A).

Table 1
Comparison of the alignment index for hypothetical linear and elliptical
shapes. An alignment index (AI) was calculated to determine how well the
orientation of the linear and elliptical shapes, as determined by ct-FIRE,
agrees with the actual known orientation.

Shape Linear Elliptical

Mean 0,9992 0,9999
SD 0,0005 0,0002

Fig. 3. Model of Alignment. A) Schematic to show that a group of cells can be
orientated in any direction (90°, 0° or 127.1°) and still have the same degree of
alignment. B) Graph representing the frequency distribution of hypothetical
cells, where data sets were created between 0° and 180° with different standard
deviations (SD = 0, 4, 16 and 64) using Microsoft Excel to represent cells or-
ientated between 0° and 180° with different degrees of alignment.

Table 2
Comparison of the alignment index of data sets with different standard devia-
tions, calculated using the average vs. the preferred orientation. Data sets with
increasing standard deviations (and orientated about 90°) were created using
Microsoft Excel. These data sets represent hypothetical cells aligned to different
extents. Hypothetical cells were shifted to 0° and 127.1° and the alignment
index calculated compared to the average and the preferred orientation. *=
p < 0.05 compared to the alignment index (AI) at 90°.

Alignment index (AI)

Average orientation Preferred orientation
SD 90° 0° 127.1° 90° 0° 127.1°

0 1 1 1 1 1 1
4 0,98 −0,94* 0,98 0,98 0,98 0,98
16 0,87 −0,85* 0,88 0,85 0,85 0,86
64 0,16 −0,15* 0,02 0,14 0,14 0,15
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Quantification of AI revealed no significant increase in myoblast
alignment in response to these non-myogenic cells; indeed, AI values
did not exceed 0.27 under any conditions (Fig. 5B). However, a sig-
nificant increase in the fusion index was observed in response to
5× 103 fibroblasts (42.28 ± 3.47%; p < 0.05) in comparison with
the control (24.23 ± 1.93%) (Fig. 5C). When further increasing the
number of fibroblasts, this positive effect was slowly lost until in fact, at
80×103 fibroblasts, a significant decrease in fusion is observed
(12.62 ± 0.75%; p < 0.05) compared to control (Fig. 5C).

3.5. Macrophages continue to promote myoblast alignment and inhibit
fusion in the presence of fibroblasts

In order to determine the effect of an inflammatory and fibrotic
environment on myoblast differentiation, triple co-cultures of macro-
phages and fibroblasts with myoblasts were carried out (Fig. 6).

Analysis of myoblast alignment showed that macrophages (40×103)
on their own continued to significantly promote the alignment of
myoblasts (0.45 ± 0.03) compared to the control (0.05 ± 0.01;
p < 0.05), while fibroblasts (40×103) had no significant effect
(Fig. 6A). Co-culture of macrophages (40× 103) with myoblasts con-
tinued to have a negative effect on myoblast fusion (6.37 ± 0.87%;
p < 0.5) compared to the control (12.90 ± 1.00%), while fibroblasts
(40×103) continued to have no significant effect on myoblast fusion
(Fig. 6B). When macrophages and fibroblasts were co-cultured together
with myoblasts, macrophages maintained both their positive effect on
myoblast alignment (0.38 ± 0.03; p < 0.05; Fig. 6A) and their ne-
gative effect on myoblast fusion (7.51 ± 0.51; p < 0.05; Fig. 6B)
compared to the control.

Fig. 4. The effect of macrophages on the alignment and fusion of myoblasts. Macrophages (0 (control), 5, 10, 20, 40 and 80×103) were co-cultured with differ-
entiating myoblasts for 5 days, stained with Fuchsin and viewed using an Olympus CKX41 microscope A) Images of myoblasts co-cultured with increasing numbers of
macrophages (0, 5 and 80× 103) captured with a Motic 3.0 megapixel camera; arrows indicate differentiated myotubes. B) Cell orientation and alignment index (AI)
evaluated using ct-FIRE. C: Fusion index (%). *= p < 0.05; Alignment: N= 4; Fusion: N= 3.

C. Venter, C.U. Niesler Experimental Cell Research xxx (xxxx) xxx–xxx

5



4. Discussion

Skeletal muscle has the remarkable ability to repair itself post-in-
jury. In order for this process to occur, satellite cells become activated,
migrate into the wound, align with one another as well as existing
muscle, and differentiate to form multi-nucleated myotubes [23].
Alignment is an important step during myogenesis, because it orientates
the muscle cells in a similar direction and brings lipid membranes to-
gether; this allows the cells to fuse and form multinucleated myofibres
with parallel longitudinal axes [8,24]. Muscle cells that are cultured in
vitro maintain their ability to align and can do so without a predefined
template [21].

A number of previous studies have used physical templates, such as
grooves in a culture well, to improve myoblast alignment in vitro and
promote fusion [9,19,21,25,26]. The alignment of these cells was
quantified by determining their orientation relative to these grooves,

which were set as the reference. Cells orientated in the direction of
these grooves were classified as perfectly aligned (AI = 1), whereas
those that were randomly orientated around the reference point were
deemed unaligned (AI = 0) [13,22]. A problem however arises when
cells are able to align in the absence of a template; under these cir-
cumstances there is no point of reference for assessment of AI. We
therefore sought to develop a method to address this shortcoming.

Random data sets with a range of standard deviations were created
in order to represent cells aligned to different degrees. The smaller the
standard deviation within this set, the better the alignment; conversely,
the higher the standard deviation, the greater the random orientation.
The overall alignment of all the “cells” in the image can be determined
by either calculating the mean (referred to as the “average orientation”)
or the mode (referred to as the “preferred orientation”) of the data set.
Rotating this image (irrespective of the standard deviation) should not
change the AI, because it merely shifts the direction in which all the

Fig. 5. The effect of fibroblasts on the alignment and fusion of myoblasts. Fibroblasts (0, 5, 10, 20, 40 and 80× 103) were co-cultured with differentiating myoblasts
for 5 days, stained with Fuchsin and viewed using an Olympus CKX41 microscope. A) Images of myoblasts co-cultured with increasing numbers of fibroblasts (0, 5
and 80×103) captured with a Motic 3.0 megapixel camera; arrows indicate differentiated myotubes. B) Cell orientation and alignment index (AI) evaluated using ct-
FIRE. C) Fusion index (%). *= p < 0.05; Alignment: N= 3; Fusion: N= 3.
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“cells” are all distributed. When the AI was calculated using the average
orientation, it did not however remain the same when the data set was
shifted; on the other hand, when the preferred orientation was used, the
AI remained the same no matter what direction the data set was shifted.
For this reason, we subsequently used the preferred orientation in all
subsequent calculations.

The orientation of each individual cell can be manually determined
by measuring the angle at which it lies relative to another cell [13].
However, this becomes unfeasible when dealing with high numbers of
cells. There are few available programs that can perform automated
alignment assessment without the need for programming skills. ct-FIRE,
software originally designed to determine the orientation of collagen
fibres (in essence, straight lines) is one such program [16]. In order to
test and compare its ability to determine the orientation of elliptical
cell-like shapes, images of straight lines (akin to “collagen”) and ellipsis
(akin to “cells”) were created, orientated in known directions. ct-FIRE
was then employed to determine the orientation of these shapes; the
measured orientation was then evaluated to determine how well it
matched the actual alignment. It was determined that ct-FIRE could not
only precisely determine the orientation of straight lines as it was in-
tended, but could also be used to measure alignment of elliptical cell-like
shapes. A limitation of ct-FIRE is that it was not specifically designed to
determine cellular orientation; future cellular studies could possibly
reveal areas requiring optimization in its application. It is important to
note that other automated techniques, such as the Fast Fourier Trans-
form (FFT), the gradient orientation method and the Binarization-based
Extraction of Alignment Score (BEAS) method, also have limited abil-
ities when determining cellular orientations [13]. ct-FIRE is therefore
an appropriate tool for the calculation of cellular AI in vitro.

Next, we sought to use our established method to determine the
effect of macrophages and fibroblasts on myoblast alignment during
fusion. Pro-inflammatory macrophages are prevalent in the early stages
of wound repair and are important for clearing necrotic debris and
apoptotic cells [27,28]. These macrophages are also known to secrete a
host of pro-inflammatory signalling molecules that stimulate myoblast
proliferation, but delay differentiation [29–33]. Anti-inflammatory
macrophages, on the other hand, are typically present in the later, re-
generative stages of myogenesis and have been shown to promote
myoblast differentiation and fusion [29–31]. In our study, macrophages
were not activated prior to co-culture; however, given their in vitro
environment, they would most likely display an anti-inflammatory
profile. We demonstrate, for the first time, that macrophages sig-
nificantly improve the alignment of myoblasts during differentiation.
Co-culture with as few as 5× 103 macrophages and up to 80×103

macrophages resulted in significantly increased myoblast alignment.
Subsequent analysis of fusion suggests that, while the lower macro-
phage number has no effect on fusion, higher numbers significantly
decrease it. Myoblast elongation and alignment have previously been
shown to assist in facilitating end-to-end cellular contact, enabling
subsequent fusion [34]. Interestingly, while myoblasts cultured on ul-
trafine grooved surfaces aligned and fused in the direction of the
grooves, early differentiating cells were observed to form aggregates
not aligned with the groove axis [34]. In other studies, impairment of
elongation and alignment has been associated with a decrease in fusion,
further supporting a direct correlation between these processes [35,36].
The opposing effect of macrophages on myoblast alignment versus fu-
sion seen in our study is therefore highly intriguing as it suggests an
inverse correlation under these conditions; this requires further in-
vestigation. Finally, additional triple co-culture studies showed that this
effect of macrophages on myoblasts differentiation was not altered by
the presence of fibroblasts. This suggests that, whether in the presence
or absence of fibroblasts, macrophages are important in the early stages
of myogenesis in order to correctly orientate and align the cells while
their resolution may be crucial during terminal differentiation.

Fibroblasts are important in muscle regeneration because they are
known secretors of ECM scaffold components, such as collagen I and III
[37,38]. Fibroblasts, upon in vivo muscle injury, differentiate to form
the ECM-secreting “myofibroblasts” [37,39]; in vitro, the myofibroblast
phenotype is commonly generated in response to serum [40]. As with
macrophages, an extended presence of myofibroblasts may lead to
aberrant muscle regeneration [5]. In our study, fibroblasts co-cultured
with myoblasts, had no significant effect on alignment. Evaluating the
effect of myofibroblasts on myoblast fusion, revealed that low numbers
of myofibroblasts (5× 103) significantly promoted fusion. However, as
the number of myofibroblasts increased, fusion decreased in a cell
density-dependent manner to the point where at the highest numbers,
fibroblasts significantly lowered myoblast fusion in comparison to
control. Our data suggests that while fibroblasts may not be central
regulators of myoblast alignment, their effect on fusion is significant,
but highly dependent on their density. Previously published studies
investigating the role of fibroblasts on myoblast alignment and fusion in
vitro are few. Some suggest that fibroblasts promote myoblast fusion,
however these have not investigated alignment [41,42]. One study
showed qualitatively that fibroblasts promote alignment, but inhibit
fusion, when in direct contact with myoblasts [43]. This contradictory
data emphasizes the need for greater understanding of the regulation of
myoblast alignment and fusion by non-myogenic cells.

In summary, we have optimised a protocol for the quantification of

Fig. 6. The effect of macrophages and fibroblasts on the alignment and fusion of myoblasts. Macrophages (40J; 40× 103 cells), fibroblasts (40L; 40×103 cells) or
both macrophages and fibroblasts (40J40L; 40×103 cells, each) were co-cultured with differentiating myoblasts for 5 days. A) Alignment index (AI). B) Fusion index
(%). *= p < 0.05; Alignment: N= 5; Fusion: N= 5.
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cellular alignment, which can calculate the alignment index of a po-
pulation of cells in the absence of a predefined reference template.
Evaluating the effect of macrophages and fibroblasts on myoblast
alignment during differentiation, we showed that macrophages had
opposing effects on myoblast alignment versus fusion, promoting and
inhibiting these processes, respectively. Furthermore, while fibroblasts
had no significant effect on myoblast alignment, they could either
promote or inhibit fusion depending on their density. Finally, the pre-
sence of fibroblasts did not alter the effect of macrophages on myoblast
differentiation. This accessible alignment analysis tool can now be used
to provide further insight into the regulation of cellular orientation
during myogenesis and other processes.
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